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Introduction to Legacy HawkSoft 
Help Documentation
Version 5 of the HawkSoft Management System has reached its end of support. The following doc-

uments are an offline copy of the legacy Version 5 online help portal, provided as a courtesy to your 

agency, which has elected to remain on HawkSoft version 5.

Please keep the following in mind as you navigate this help documentation:

 l To prevent issues with size, portability, and navigability, the Version 5 help documentation has 

been split into nine PDF files (including this one). If a help topic contains a link to a different topic 

which does not seem to function properly, it most likely links to a topic contained in a different 

PDF file. In that case, try searching the other PDF files for the topic named in the link.

 l While some topics may mention contacting Product Support for assistance, please note that 
HawkSoft Product Support assistance of any kind is no longer available for this version 
of HawkSoft.

 l While we have done our best to remove any topics relating to online features that are no longer 

functional, this help documentation may still contain references to features which are no longer 

functional due to HawkSoft 5's end of support.

 l Help and training videos are not available in this help documentation. However, you may still 

occasionally see references to help or training videos in this documentation.

Setup
Initial setup will ensure that your agency gets the most out of  HawkSoft CMS. Most of this setup is com-

pleted as a part of your implementation and training; however, as your business grows and you add 

new users and new carriers, additional setup will be required.

Set up your agency network and keep HawkSoft up-to-date with the latest releases
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Complete your agency Information 

Configure agency wide settings

Set up your policies and carriers

Customize HawkSoft for your agency

Set up optional tools and integrate with third party applications

Configure and manage agency  users

Users can configure their own profiles

Workstation Setup Overview
HawkSoft CMS enables you to easily configure each workstation  to access and use HawkSoft CMS. 

Some settings are required, such as  mapping to the network drive and setting folder locations. Others, 

like setting up external tools, and some computer-specific settings, are optional. This section of 

CMS Help describes how to set up workstations and modify computer specific settings for your work-

station.

See General Agency Configuration  for information about settings that affect all users and work-

stations.

System Information

HawkSoft CMS System Information is located under the   Help on the HawkSoft CMS menu bar.

The System Information dialog provides  details about your computer, network, and CMS settings.

System Information

Installing HawkSoft on Microsoft Windows

After CMS is installed on the server or networked workstation, each additional workstation at your 

agency needs to be configured 

Installing HawkSoft  CMS Using Microsoft Windows

Manage Agency Users.htm
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 Folder Locations

CMS folder locations define where program settings and data are stored and accessed. Folder loc-

ations are computer specific and are configured  on each workstation when running Workstation Setup.

 Folder Locations

Computer Specific Settings

Computer specific settings apply to the Windows user profile   logged in.  These settings include options 

for several CMS features, such as what programs to use when viewing images and PDFs, installing the 

Virtual Printer, and printer settings.

Computer Specific Settings [+Video]

Setting Up External Tools

Setting up an External Tool enables you to configure a shortcut that links to a website or program 

(application) of your choice. You can set these links to appear on the Tools menu, the Quick Launch 

panel, and/or the main CMS toolbar.

Shortcuts to  External Tools [+ Video]

Agency Setup Overview
Getting your agency set up to use HawkSoft CMS requires entering basic information and configuring 

CMS.  The following articles will help you set up CMS to successfully meet your agency’s needs.

Agency Information Setup

This procedure explains how to configure your agency's contact and license information in HawkSoft 

CMS. Your agency's information can be entered for a single location or for multiple offices.

Agency Information Setup
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Multi-office Configuration

This topic will help you configure additional offices for your agency.  If your agency has more than one 

location, you can  configure your agency  for multiple offices.   These options also determine how policies 

will be assigned if multiple locations exist.

Multi-office Configuration [+Video]

Configure Agency Users

Configure Agency Users

General Agency Configuration

The General Configuration dialog enables you to configure settings for a wide range of CMS functions 

that your agency performs daily. Taking the time to make sure these settings support your workflow 

can increase efficiency, accuracy, and usability.

General Agency Configuration

Carrier Download Setup

HawkSoft CMS can be configured  to accept electronic downloads from participating carriers. CMS 

attaches these downloads to existing policies and can automatically update policy information accord-

ing to your Download Rules. 

Carrier Download Setup 

Policy and Carrier Setup

Policy/Company  Setup  is an important step  in the  implementation of your HawkSoft Client Man-

agement System.  Information for each of your carriers is  entered in Policy/Company Setup to enable 

you to accurately insert policies and integrate policy information with company websites. Setup  also 

ensures the accuracy of both Trust and Commission accounting transactions, and the detail available 

when reporting.

Policy and Carrier Setup
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Sales Pipeline Configuration

HawkSoft supports your agency's Sales Pipeline to help you track and report on your prospects to 

make sure your new policies move through the process from discovery to sold. It is important to con-

figure HawkSoft to use the Sales Pipeline correctly, for accurate reporting.

Sales Pipeline Configuration

Customization Settings

HawkSoft provides a variety of customization settings to meet your agency’s needs.  For example, you 

might want to create customized Agency Announcements on the Start Page.

This article provides the steps to customize CMS.

Customization Settings

Correspondence Templates

HawkSoft CMS provides a variety of ways in which users can correspond with customers, prospects, 

and other contacts entered into the CMS database.

Emails, letters, memos, proposals, the Policy Overview,  and text messages can be conveniently cre-

ated, and then printed and/or sent from the client files using the Action menu. Data from client files can 

be inserted into correspondence using merge fields.

Correspondence Templates

HawkSoft Data Sync

HawkSoft Data Sync  - formerly called Data Sharing - is the next step in the evolution of HawkSoft’s 

agency management system. The service mirrors your agency’s database (client and policy data) to 

HawkSoft’s secure and encrypted cloud servers. 

You can enable  HawkSoft Data Sync to leverage the power of your HawkSoft data  and integrate with 

third-party services as they become available in HawkSoft Marketplace. Drip marketing, consumer 

information portals, and mobile applications are examples of some of the services that will be available. 

This article provides steps to enable HawkSoft Data Sync. Once these steps are complete, your 

agency's data migrates to the HawkSoft Cloud servers. Moving forward, changes to your agency's cli-

ent files are automatically mirrored to HawkSoft's Cloud servers.

HawkSoft Data Sync
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HawkSoft Integrations and Product Add-Ons

HawkSoft CMS offers additional features and integrations with a variety of third-party software applic-

ations.

This article includes a variety of features and integrations for your agency.

HawkSoft Integrations and Product Add-Ons

Agency Information Setup

This procedure explains how to configure your agency's contact and license information in HawkSoft 

CMS. Your agency's information can be entered for a single location or for multiple offices.

The configuration settings on this screen only need to be configured one time on one computer, unless 

you choose to configure each computer to a specific agency name and/or address.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Agency Information

See User Permissions for more information.

This task is typically performed by an Owner/Administrator or Manager.

An Owner/Manager usually enables their own permissions to include Change Client/Policy Office, Cli-

ent Producer/CSR, and Agents 1-3. 

Agency Information

It is important to insert agency information exactly as you want it to appear on any correspondence gen-

erated from CMS. Items such as ACORD forms, CMS form letters, receipts, invoices, email, text, and 

proposal templates use this information to prefill your agency's contact and license information. 

If multiple offices are entered on the Offices tab, correspondence will print the 
information entered for the relevant office.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 1.  Click the   Settings icon, and then select  Agency Information. 

The Agency Information Setup dialog opens.

 2.  Enter information in the fields exactly the way you want it to appear on correspondence gen-

erated from CMS. 

 3.  Optional: Enter the agency License Number.

Some states require that agencies include their       Agency License Number on 
printed materials. Once entered, this number will be available to easily insert 
as a merge field in correspondence. See Modifying Correspondence Tem-
plates (Letters, Memos,  Proposals, and Policy Overview) for more inform-
ation on adding the License Number to correspondence.

 4.  Optional: Set Default Agent Information.

If your agency has more than one office to configure, the following fields are located on the 

Offices > Edit Agency dialog. See Agency Information Setup for details.

Client Producer and Client CSR

You can set defaults for the Client Producer and Client CSR fields. Select a name from the avail-
able drop-downs or  select "Current User". 

The Producer and CSR fields are located on the Client Name and Address screen. If defaults are 

set, the selection is applied at the time  a user inserts a new client file.

Users can select any available option from the drop-down fields when insert-
ing a new client. Once the client is saved, the user will need the following per-
mission to change the default Producer or CSR:

Change Client Producer/CSR

See User Permissions for more information.

Agent 1, 2, 3

You can set defaults for the Policy Agent 1, 2, and 3 fields. Select a name from the available 
drop-downs or  select "Current User".

The Agent fields  are located on the General Policy Information screen. If defaults are set, the 

selection is applied at the time  a user inserts a new policy.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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Users can select any available option from the drop-down fields when insert-
ing a new policy. Once the policy is saved, the user will need the following 
permissions to change the default Agent:

Change Agent 1, 2, or 3

See User Permissions for more information.

 

When setup is complete, click OK to save your changes and close the Agency Information Setup dia-
log.

Multi-office Configuration [+Video]

This topic will help you configure additional offices for your agency.  If your agency has more than one 

location, you can  configure your agency  for multiple offices.   These options also determine how policies 

will be assigned if multiple locations exist.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Agency Information

See Setting User Permissions for more information.

This task is typically performed by an Owner/Administrator or Manager.

An Owner/Manager usually enables their own permissions to include Change Client/Policy Office, Cli-

ent Producer/CSR, and Agents 1-3. 

In this topic:

Multi-Office Settings Offices

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
#Agency_Type
#Offices
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Agency Codes Users

Advanced Configuration

To configure your agency for more than one office
See Agency Information Setup to enter your main office details before configuring multiple offices.

 1.   Click the   Settings icon, and then select  Agency Information. 

The Agency Information Setup dialog opens.

 2.  Select the Multi-Office Settings tab.

 3.  Select the agency type  that best fits your agency needs.

Your selection applies to all offices. 

Description of each setting
Single Agency (No Multi-Agency Settings Apply)

 This is the default setting for agencies with only one location.

Each Office Maps to an Office Name and Address

Select this option if each office is associated with a unique office name and address, and each of 

your locations has  a unique agent (agency) code assigned with each carrier. 

In the General Policy Information screen, the Agent Code drop-down will display each agent 

code along with its corresponding office assigned on the Agency Codes screen.

See Policy/Company Setup: Agent Codes for instructions on mapping agent codes to an 

agency.

Each Computer Maps to an Office Name and Address

Select this option if your agency has a shared database used by all locations, and the secondary 

offices are connected via Wide Area Network (WAN). 

#AgencyCodes
#Users
#Advanced_Configuration
../../../../../Content/Policy-Company Setup/Policy-Company Setup Screens/Agent Codes.htm
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 l This option assigns each computer to an office. See Local Computer: Office setting below.

 l The computer the user is logged into determines the agency address printed on doc-

umentation. 

If the agency is using a Citrix or Terminal Services environment, do not 
select this option.

Each Office Maps to an Office Name
Each Computer Maps to an Address

 l CMS uses the agent (agency) code to determine the agency name. 

 l The computer the user is logged into determines the agency address printed on doc-

umentation. 

See Local Computer: Office setting below.

If the agency is using a Citrix or Terminal Services environment, do not 
select this option.

Each User Maps to an Office Name and Address

Select this option to  assign each user to a specific location or agency.

The user's office assignment will determine the name and address printed on documentation 

generated by that user.

If this option is selected, the Users side-tab becomes available.

See Multi-office Configuration [+Video] below to designate an office for each user. 

Roaming Users can select the correct office when logging into HawkSoft 
CMS and can easily switch offices by clicking on their Username on the CMS 

toolbar.

Each Office Maps to an Office Name
Each User Maps to an Address

#Local_Computer
#Local_Computer
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Select this option to map each office to an office name that might be different than the address 

each user maps to.

 l  CMS looks to the agent code to determine the agency name. 

 l The logged in user determines the agency address. 

 See Multi-office Configuration [+Video], below for more information.

This option is typically used by large agencies with many  independent sales agents and one data 

processing center.

 4.  Select the office the workstation is assigned to. 

This option applies only when the third or fourth  agency type is selected 
above.

Office  – The drop-down menu includes the list of available locations for this agency once they 
are entered on the Offices screen. 

Choose which location this computer should be assigned to.

To add offices
The Offices tab enables you to enter multiple office locations.

Your first office listed on this tab defaults from the main office information  entered 
on the Agency Information tab. 

Agency name and information fields are used on printed materials, such as ACORD forms, memos, 

and letters.

Use the available buttons to manage your agency information.

Add – Click  to add  an agency name, location, and default information.

Edit – Select an agency from the list, and then click Edit to modify or remove agency information. 

Office Details
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 1.  Enter information in the fields exactly the way you want it to appear on correspondence gen-

erated from CMS. 

 2.  Optional: Set 

Client Producer and Client CSR

You can set defaults for the Client Producer and Client CSR fields. Select a name from the avail-
able drop-downs or  select "Current User". 

The Producer and CSR fields are located on the Client Name and Address screen. If defaults are 

set, the selection is applied at the time  a user inserts a new client file. 

Users can select any available option from the drop-down fields when insert-
ing a new client. Once the client is saved, the user will need the following per-
missions to change the default Producer or CSR:

Change Client Producer/CSR

See Setting User Permissions for more information.

Agent 1, 2, and 3

You can set defaults for the policy Agent 1, 2, and 3 fields. You can select a name from the avail-
able drop-downs or  select "Current User".

The Agent fields  are located on the General Policy Information screen. If defaults are set, the 

selection is applied at the time  a user inserts a new policy.

Users can select any available option from the drop-down fields when insert-
ing a new policy. Once the policy is saved, the user will need the following 
permissions to change the default Agent:

Change Agent 1, 2, or 3

See Setting User Permissions for more information.

Archive – Select an agency from the list, and then click Archive to archive the agency.

The archived location will continue to display in the office field, followed by "
(Archived)",  for any clients or policies associated with it.

See Data Replace Using Advanced Reports to replace the archived office with a 

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
../../../../../Content/Reports/List of Reports/Data Replace Using Advanced Reports.htm
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new office. Be sure to add the following report fields when creating your report:

Client Information: Client Office

 General Policy Information: Office 

Show All – Check this box to include archived locations in the list.

To unarchive a location, select the location name, and then click Un-Archive.
 

To assign Agency (Agent) Codes
Agency (Agent) codes are set up in Policy/Company Setup for each carrier. A code can be assigned for 

each agency.

An agency code must be assigned on this screen if you selected to map agency codes on the Multi-

office Configuration [+Video] screen.

 1.  Highlight the agency location from the upper section of the screen to apply an agency code to 

that office.

 2.  Assign agency codes, and/or manage the Agency Codes list using the available buttons.

To select multiple codes, hold the Ctrl key down and highlight the codes.

Add selected code(s) to   the selected location.

Remove selected code(s) from the selected location.

Add all  codes to  the selected location.

Remove all selected codes from the selected location.

 3.  Continue assigning codes as needed.

 4.   Click Apply to save your changes before proceeding to the next tab.

To assign users to a specific location
The Users screen enables you to assign users to a specific agency location. 

Agent Codes.htm
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This side-tab is available only when Agency Type  has been set to map to a user name (see Multi-office 

Configuration [+Video] above). 

User profiles must be added to the User List before they can be assigned to a spe-
cific agency location. See  for detailed instructions.

 1.  Select a user to assign to a location, and then click Assign Office.

To select multiple users, hold the Ctrl key down and highlight the users.

Once a user has been assigned to an office, you may need to activate their 
User Permissions for that office as well. See User Permissions by Office for 
detailed steps.

The Office Assignment by User dialog opens.

 2.  Select the  Roaming User option from the Assigned Office drop-down, and then click OK.

Roaming users are not assigned to any specific office and are prompted to select an office when 

logging into CMS.

 3.  Click Apply to save your changes before proceeding to the next tab.

User Permissions by Office
HawkSoft CMS enables  Multi-Office agencies to set user permissions based on the office associated 

with each client file. This allows an agency principal to completely block a user from viewing, editing, 

and reporting on client files that don't belong to that user's office.

User Permissions by Office

Advanced Configuration
This   side-tab is available if you selected one of the following Multi-Office Settings:

Each User Maps to an Office Name and Address

Each Office Maps to an Office Name/Each User Maps to an Address

../../../../../Content/Agency Setup/Multi-Agency Setup/User Permissions by Office.htm
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Advanced configuration is used in conjunction with some Multi-Office settings to separate agency doc-

uments and settings on a per office basis. For example, letter templates and accounting setup,  can be 

designated to each agency office.

See Multi Office: Advanced Configuration for more information.

When setup is complete, click OK to save your changes and close the Agency Information Setup dia-
log.

Related Topics

Policy/Company Setup: Agent Codes
 Folder Locations
User Permissions by Office
User Setup Overview

Configure Agency Users

 

 

Manage Agency Profiles and Permissions

Each CMS user  must have a user profile that includes permissions set to accommodate his or her job 

functions. Creating a user profile for each CMS user is essential to the management of the HawkSoft 

CMS database.

This article is intended to help agency administrators and managers add new user profiles, manage 

user permissions, and de-activate user profiles when needed.

Manage User Profiles and Permissions

User Licensing
The Seat Management portal enables you to send a request  to HawkSoft Billing to change the number 

of seats on your agency's HawkSoft subscription. Once the request is processed, the number of seats 

licensed to your agency updates. Changes to the number of seats licensed to your agency will impact 

the cost of your agency's HawkSoft subscription.

../../../../../Content/Agency Setup/Multi-Agency Setup/Advanced Configuration.htm
../../../../../Content/Policy-Company Setup/Policy-Company Setup Screens/Agent Codes.htm
../../../../../Content/Agency Setup/Multi-Agency Setup/User Permissions by Office.htm
../../../../../Content/Agency Setup/Manage Agency Users/Manage Agency Users.htm


3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 16

One seat represents one concurrent user accessing HawkSoft CMS at a time. Seats are not assigned 

to specific users. The number of seats licensed to your agency should be the maximum number of 

users who need to access HawkSoft at the same time.

Seat Management [+ Video]

Assign Users to a Specific Office

This topic is intended for agencies with multiple offices and includes instructions for assigning users to 

a specific office. 

 Assign Users to a Specific Office

General Agency Configuration 

The General Configuration dialog enables you to configure settings for a wide range of CMS functions 

that your agency performs daily. Taking the time to make sure these settings support your workflow 

can increase efficiency, accuracy, and usability.

General Settings

The General Settings screen enables you to  determine default behavior for your agency preferences 

and workflows. These settings apply to all users in your agency.

General Settings

Required Fields

As an agency administrator, there are specific client and policy fields that you will want to make certain 

your CSRs complete when inserting a new client and/or a new policy.  Within your General Con-

figuration settings, you have the option to configure  a select group of  fields   to either present the user 

with a reminder to complete  the information, or force the user to complete the information before sav-

ing.  

Configuring Required Fields for your agency

../../../../../Content/HawkSoft Integrations and Product Add Ons/Seat Management.htm
#Users
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Default Suspenses

HawkSoft CMS enables you to set default Suspenses for specific types of transactions. A suspense 

will automatically be created when the selected actions are performed, but can be modified or removed 

if needed.  

Default Suspenses

Phone Dial-Out Integration

 HawkSoft enables you to configure your phone system to integrate with CMS. This integration enables 

you to place outbound calls from within a client file with the click of a mouse, and to open an inbound 

caller's client file as soon as you receive a call.

Depending on your provider, different configuration options are available. Most providers enable you to 

configure both outbound dialing and inbound call screen pops with CMS. 

 If your provider has configured  inbound calls,  CMS either opens the client file automatically, or dis-

plays a dialog with the option to open the client file.

Phone System Integration

Agency Announcements

HawkSoft CMS enables you to create customized announcements on your Agency's Start Page. You 

might want to use the Announcement section to display agency news, company goals, and events for 

your staff. 

In addition to text, you can embed images and tables in the Announcement section.

CMS provides a template to help you get started  customizing your announcements. 

Agency Announcements

HawkSoft Data Sync

HawkSoft Data Sync  - formerly called Data Sharing - is the next step in the evolution of HawkSoft’s 

agency management system. The service mirrors your agency’s database (client and policy data) to 

HawkSoft’s secure and encrypted cloud servers. 

You can enable  HawkSoft Data Sync to leverage the power of your HawkSoft data  and integrate with 

third-party services as they become available in HawkSoft Marketplace. Drip marketing, consumer 

information portals, and mobile applications are examples of some of the services that will be available. 
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This article provides steps to enable HawkSoft Data Sync. Once these steps are complete, your 

agency's data migrates to the HawkSoft Cloud servers. Moving forward, changes to your agency's cli-

ent files are automatically mirrored to HawkSoft's Cloud servers.

General Settings

The General Settings screen enables you to  determine default behavior for your agency preferences 

and workflows. These settings apply to all users in your agency.

Your initial CMS installation comes with some General Settings already configured.  

This article  describes each of the settings available  and the impact each setting has on the agency. 

Review the options described below and select settings according to your preferences.

This task is typically performed by an Owner/Administrator, Manager, or Bookkeeper.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > General Configuration

See Setting User Permissions for more information.

General Settings

 1.  Click the   Settings icon, and then select  General Configuration.

All the general configuration settings are located on the General Settings tab.

 2.  Configure the Global Settings for your agency.

The following list describes the available Global Settings, and the effect each setting has if selec-

ted.

 Accounting

Commission Tracking –  Enables an agency to reconcile commission transactions 
and create Commission Paid reports for the producers, and/or for the agency.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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Search

Use Agency ID Field  – Activates the Agency ID field on the Client Name and 
Address Information screen, as well as the Search dialog.

An Agency ID number can be entered  in this field when an agency converts from a 

different management system. 

 For Nationwide customers receiving company downloads, this 
field contains the ICAR number.

This field can also be used by an Agency as a customizable field, for instance, to 

keep track of specific types of customers. 

CMS View

Launch PDF file with viewer associated with Windows –  Launches the PDF 
viewer associated with Windows when opening or viewing a PDF from CMS.

When left unchecked, PDFs open in the CMS Viewer. The CMS Viewer launches 

Tracker XChange Viewer software when you open a PDF. 

Mask Personally Identifiable Info in Personal/Driver Screens - If selected, the 

 Masked button is available at the top of the Client file to provide an extra level 

of security. You can use this option to mask or unmask the  Personally Identifiable 

Information (PII)  on the Personal/Driver screens. 

See  Masking Personally Identifiable Information (PII) for more information.

Action Menu

Internal Log – Creates documentation when a change is made using the Internal 
option in the Action menu.

Regardless of this setting, a log note is always created when any 
of the following three tasks are performed in CMS:  Archiv-
ing/Unarchiving a Client File, Archiving/Unarchiving a Policy
[+video], and Duplicate/Remarket a Policy.

#Client%20Name%20and%20Address%20Information
#Client%20Name%20and%20Address%20Information
../../../../../Content/Clients and Policies/Masking Personally Indentifiable Information.htm
#Archiving/Unarchiving%20a%20Client%20File
#Archiving/Unarchiving%20a%20Client%20File
#Archiving/Unarchiving%20a%20Policy[+video]
#Archiving/Unarchiving%20a%20Policy[+video]
Rewriting Policies.htm
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See Action Menu for more information about the Internal menu options and Creating 

a Log Note for more information about log notes.

Force Log on Close of Suspense  – Requires users to create a log entry to doc-
ument closing a Suspense.

Launch Action Menu when launching Website – Launches the Action menu for 

documentation purposes when a user clicks on the website button   on the 

main CMS toolbar.

Auto Attach Sent Emails – Attaches email messages to log notes and to the 
Attachments List in the client file when an email is sent through CMS. 

See Email for more information. 

Insert

Default Status & Company to Prospect on New Policy – Sets the Policy Status 
and Company on the General Policy Information screen to Prospect when inserting 

a new policy.

This setting should be set to encourage the use of the Sales Pipeline.

Show Actions to Perform Box on New Policy  – Activates the Actions to Perform 
menu when inserting a new client or policy. The Actions to Perform menu allows 

users to print a Receipt and ID Card and prompts the user to add or edit Client Misc 

Info, Cross-Sell/XDates, and Claims  during the insertion process.

Force Edit Cross–Sell/XDates Tool to On – Prompts users to add or edit Cross-
Sell/XDates information when inserting a client or policy. The Edit Cross-

Sell/XDates Tool option is selected by default on the Actions to Perform dialog.

Edit

Uppercase the Name and Address Fields (Client Level Only) – Sets the inform-
ation entered for a new client in the Name and Address fields to uppercase. It does 

not affect existing information on existing client files.

../../../../../Content/Getting Started/Action Menu.htm
../../../../../Content/Log Notes/Creating a Log Note.htm
../../../../../Content/Log Notes/Creating a Log Note.htm
Accessing and Working with Suspenses.htm
#Email
Change Policy Status.htm
#General%20Policy%20Information
Change Policy Status.htm
#Cross-Sell/XDates
#Cross-Sell/XDates
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Show country list on mailing/physical address fields – Allows users to select a 
country on mailing and physical address fields available on the Name and Address 

and General Policy Information dialogs.

Create Change Form on policy changes – Launches the Change Form dialog 
after any changes are made to a client/policy. 

Print

Print disclaimer on policy summaries  – Prints a disclaimer on Policy Coverage 
Summaries. (Recommended)

Print disclaimer on summaries  – Prints a disclaimer on client summaries.  
(Recommended)

Always use State Specific ID-Card if available  – Defaults ID cards to print state 
specific ID cards, if available.

Reports

Reports Use Index – Sets CMS Data Reports  to use the client and policy index 
rather than searching each  client file for report data. This speeds up the reporting 

process, however, if indexes are not up to date, report results  may not be accurate. 

Please see  Freshen Indexes [+Video]*  for information on how to keep your indexes 

up to date.

Report filter options included in the index are listed with an * 
asterisk on the Report Generator Filters dialog.  The speed of 
your report results is improved only when all selected filters are 
included in the index.

Database Configuration

Terminal Services/Citrix Client   – This setting optimizes CMS for agencies with a 
Terminal Services (TS) or Citrix configuration.

#Business%20Agency%20Reports%20Overview
#Freshen%20Indexes%20[+Video]*
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This setting is automatically selected if installation was optim-
ized for Terminal Services with Remote Users.

For networking options for your agency, see HawkSoft  
CMS Installation and Network Options . 

This setting has the following impact on users:

 l Users will not have a copy of CMS installed on their local workstation, unless  

the Install HawkSoft CMS program files locally for this Windows user 
setting is selected in Computer Specific Settings [+Video].

 l Users can only archive, not delete, attachments

 l Restricts ability to edit folder location settings

 l Some multi-office setup options are disabled

Archive Attachments (Does not delete attachments) – Attachments to a cli-
ent/policy file are archived instead of deleted. (Recommended)

User Permissions by Office  – Gives multi–office agencies the ability to set dif-
ferent user permissions for each  office. See User Permissions by Office for more 

information.

Hide Unauthorized Client Files  – Does not allow users to see client 
files in the Search Box if not authorized.

See Setting User Permissions for more information.

Microsoft Word Integration  – Uncheck this option if you do not have  Microsoft 
Word installed on all workstations.

Additional Settings

ID Card Days

Controls the number of days until the ID card expires when creating a temporary ID 

card in CMS. If the expiration date of the policy term is prior to the default ID card 

date, CMS prompts the user to use the expiration date of the policy term.

Enter 0 to use Policy Effective Date and Expiration Date.

../../../../../Content/User Setup/User Permissions by Office.htm
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Auto Logout

Automatically logs users out of CMS if the program is inactive for a specified amount 

of time. The default is set to 30 minutes. Any amount of time can be set by using 

either the drop-down menu or typing a number into the field.

This option cannot be disabled and is used to help keep client 
information confidential.

Primary Rater

The primary rater is used to store and retrieve the correct Motor Vehicle Record 

(MVR) tables. The rater listed in this field must match the rater the agency uses.

Scan Output

Sets the default scan type to PDF or TIF when using the  Scan Utility.

PDF Security

 Requires a password  to modify PDFs created using the Scan Utility or HawkSoft Vir-

tual Printer.

Password – Enter a password to allow PDF modifications only when 
the correct password is entered. 

If the password field is left blank,  PDFs will not be editable. 

If the password is left blank, protection cannot be 
removed from PDF documents created while this 
setting is in place.

Agency Logo

You can import your agency logo to be included on invoices generated by HawkSoft 

CMS, ACORD ID cards (other than state specific), and on your agency's CMS Start 

Page. 

For agencies with multiple offices, only one logo can be impor-
ted. 

#Scanning%20Documents
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The Agency Logo Importer supports the following graphic formats: PNG, JPEG, 

GIF, BMP, ICO, WMF and EMF.

For best results, use an image with a resolution of 1150 x 280 pixels.

To add your agency's logo 

 1.  Click the Import button next to the Agency Logo field.

File Explorer opens.

 2.  Navigate to your agency logo file, and click Open.

The ID Card Logo Import dialog opens with your logo dis-
played.

 3.  If the logo looks correct, click Finish.

To import logos into your correspondence see: Agency Logo

Show Logo on Start Page

Check this box to include your imported logo on your HawkSoft CMS Start Page.

Contact Information Alerts

Check this box to alert users when client contact information has not been reviewed 

in "X" number of days.

For more information, see Contact Information Alerts.

Policy Snapshot

Check this box to enable the Policy Snapshot feature and to configure how Policy 

Snapshots are created for policy changes. If left unchecked, Policy Snapshots will 

not be created when changes are made to a policy.

A Policy Snapshot can be created from the Internal Action menu  
without any configuration. See Internal Action menu options for 
more information.

Select one of the following options from the available drop-down to determine how 

Policy Snapshots are created for your agency. This setting can be overridden for 

specific carriers in Policy Company Setup.

#Contact%20Information%20Alerts_..28
../../../../../Content/Getting Started/Action Menu.htm#Internal_Action_menu_options
Policy Information.htm
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Automatically create Policy Snapshot – Each time changes are made to a policy, 
a Policy Snapshot will automatically be  created and attached to the policy.

Do not create Policy Snapshot (unless overridden) – You might want to select 
this option rather than leaving the main Policy Snapshot option unchecked, if you 

don't want to create a Policy Snapshot for most policy changes. This option enables 

you to set an override for specific carriers that you do want to create a Policy Snap-

shot for. For example, you might want to create a Policy Snapshot only for carriers 

that don't download policy changes.

Prompt users before creating Policy Snapshot   – Each time changes are made 
to a policy, the user will be prompted with the option to create a Policy Snapshot.

Prior to v4.9, Policy Snapshot was called Policy History. The 
Attachments list might contain Policy History documents saved 
prior to v4.9.

See Policy Snapshot for more information about creating and reviewing  Policy  Snap-

shots.

Related Topics
Commission Tracking Overview
Contact Information Alerts
Freshen Indexes [+Video]*
General Policy Information
 Log Notes Overview
The HawkSoft Virtual Printer
Scanning Documents 
User Permissions by Office

Configuring Required Fields for your agency

As an agency administrator, there are specific client and policy fields that you will want to make certain 

your CSRs complete when inserting a new client and/or a new policy.  Within your General Con-

figuration settings, you have the option to configure  a select group of  fields   to either present the user 

with a reminder to complete  the information, or force the user to complete the information before sav-

ing.  

#Policy%20Snapshot
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#Contact%20Information%20Alerts_..28
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Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > General Configuration

See Setting User Permissions for more information.

To configure Required Fields

 1.  Click the   Settings icon, and then select  General Configuration  from the menu.

 2.  Select the Required Fields side-tab.

Each field can be configured to trigger a warning if left blank, or can be configured for required 

entry. 

As noted next to certain fields, some fields are always required by HawkSoft.

 3.  Use the check boxes next to each field to determine if the fields should be required or if the user 

should be presented with a warning when the fields are left blank.

Exceptions to Required Field settings:
 l Download: When a client or policy is created automatically from a download, these 

settings do not apply.

 l Data Importer: When a client or policy is created from the Data Importer, these set-

tings do not apply.

 l Carrier or Vendor client file: These settings do not apply when inserting a Carrier 
or Vendor client type.

 l Sales Pipeline: When a policy is in the  Sales Pipeline, most of the policy details are 

not yet determined. If your agency has Required General Policy Information fields 

configured, these settings do not apply. 

The State, Application Type, and Line of Business are 
required.

 4.  Click OK to save changes and close the General Configuration dialog.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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Related Topics
Default Suspenses
General Settings
Policy Data Auditing

Default Suspenses

HawkSoft CMS enables you to set default Suspenses for specific types of transactions. A suspense 

will automatically be created when the selected actions are performed, but can be modified or removed 

if needed.  

You can set default Suspenses for the following tasks:

 l Inserting a policy

 l Editing client information that generates a Change Form

 l Inserting a claim

 l Changing policy status to Prospect or New

Only one Suspense is  created per action. When multiple actions are performed during one transaction,  

the Suspense is assigned using the first applicable suspense trigger, in the order listed above.

Example: If you enter a claim for a client and also update the client's address,  the Suspense settings 
for the Change Form will be used in the log note for this action. 

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > General Configuration

See Setting User Permissions for more information.

Configuring Default Suspenses

 1.  Click the   Settings icon, and then select  General Configuration.

 2.  Select the Default Suspenses side-tab.

#Policy%20Data%20Auditing
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 3.  Use the drop-down list in the Suspend To column to  assign the Suspense to a specific user, a 
CMS role (Agent of Record, Client Producer, etc.), or "Current User".

 4.  Enter the number of Days to delay before the Suspense becomes active. For example, if you 
want the Suspense to trigger one week after it's created, enter the number 7.

Set the number of days to zero (0) to create a Suspense that becomes active 
immediately.

 5.  Optional: Use the drop-down list to set a Priority for each item.

By default, all Actions are set to the lowest priority.

 6.  Optional: Select a Category to be assigned for the selected action. 

Categorizing your Suspenses makes it easier to work your Suspenses. Suspenses are organ-

ized by Category on the CMS Start Page, and can be filtered by Category on the Suspense List. 

The available Categories can be customized for your agency. See Cus-
tomizing Lists for detailed instructions.

 7.  Click OK to save your changes and exit the General Configuration Settings.

Related Topics
General Settings
Configuring Required Fields for your agency
Suspending a Log Note

Contact Information Alerts

HawkSoft includes the ability to set Contact Information Alerts for client files, enabling you to make 

sure your clients' contact information stays up-to-date. Contact Information Alerts pop up when a cli-

ent's contact information has not been changed, or marked as up-to-date, since the number of days 

specified in General Configuration.

Tour of the CMS Start Page 5.1.htm
#Suspense%20Report
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In this topic:

To enable Contact Information Alerts To mark contact information as up-to-date

To enable Contact Information Alerts

Required Permissions:

To complete this task, user permissions must be set to include:

Setup > General Configuration

See Setting User Permissions for more information.

 1.  Open the   Setup menu.

 2.  Select General Configuration.

 3.  Check Contact Information Alerts on the General Settings tab.

 4.  Set the number of days in the "Alert User if Contact Information is older than [...] days" field.

The alert pops up when the client file is opened, if the contact information has not been marked 

up-to-date within the set number of days.

 5.  Click OK.

To mark contact information as up-to-date

Required Permissions:

To complete this task, user permissions must be set to include:

Client File > Action Menu

See Setting User Permissions for more information.

#Enable
#Mark_UTD
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A client can be marked as up-to-date any time a user opens the Edit Client window.

 1.  Retrieve the client file.

 2.  Open the Action menu, and select what prompted this action from the first three lists.

 3.  Click Change Client (or Change Client/Policy if you have a policy selected).

 4.  Select Mark Contact Information as Up to Date from the Contact Information drop-down.

The value in the drop-down changes to the current date.

 5.  Optional: Make any other changes to the client/policy as needed.

 6.  Click Finish.

 7.  Click Finish again to close the Action Menu.

The Add Log Entry Comments dialog appears.

 8.  Add comments as needed, and then click OK.

Related Topics
General Settings

Carrier Download Setup Overview

HawkSoft CMS can be configured  to accept electronic downloads from participating carriers. CMS 

attaches these downloads to existing policies and can automatically update policy information accord-

ing to your Download Rules. 

../../../../../../CMSHelpTN/Content/Log Notes/Add Log Entry Comments CSH.htm
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Depending on the carrier, you may need to install download software to take advantage of these fea-

tures. You will also need to configure CMS to process downloads according to your agency’s pref-

erences.

Carriers that Download to CMS

To determine which carriers offer downloads, which lines of business are offered, and the types of 

downloads available,  please see the Carrier Downloads list on our website.

Carriers that Download

Download Managers

All carriers that download use  a third-party vendor or their own proprietary download management soft-

ware  to send information to CMS.

 l IVANS – Most carriers send downloads through the third-party vendor, IVANS Transfer Manager 
(ITM)™. This software is typically configured during your initial setup with  CMS.

 l Other third-party vendors – Some carriers use one of several other third-party vendors, such 
as TEAM-UP® or Symbience Clear Path®. Contact the individual vendor to install, configure, 

and obtain instructions for running the software.

 l Proprietary software – Some carriers, such as Progressive®, use their own software to down-
load policy transaction files to HawkSoft CMS. Contact the individual carriers to install, configure, 

and obtain instructions for running the software.

Setting Up a New Carrier for Downloads

HawkSoft CMS contains NAIC and coverage codes. As carriers notify HawkSoft, Inc. with changes to 

NAIC and coverage codes used in policy downloads, HawkSoft, Inc. automatically updates the 

CMS database.

Setting Up a New Carrier for Downloads

Carrier Integration

Many carriers permit direct integration with policyholder data, either through IVANS’s Transformation 

Station or similar software. Direct integration allows you to view information, and in some cases, trans-

fer information, without navigating through the carrier's website. These articles provide information on 

how to set up these integrations.

https://carriers.hawksoft.com/
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Carrier Integration Overview

Download Configuration Settings

HawkSoft CMS enables you to configure download rules to determine how carrier downloads are pro-

cessed and how they are assigned for follow up at your agency. Different rules can be applied to per-

sonal and commercial lines downloads, or your agency can apply the same rules to all lines of 

business.

Download Configuration Settings

Download Rules

HawkSoft CMS enables you to configure download rules  to determine how carrier down-

loads are processed, and how they are  assigned for follow-up at your agency.

Download Rules

IVANS Transfer Manager 

IVANS Transfer Manager (ITM)  can be installed at your agency to enable HawkSoft CMS to receive 

electronic downloads from a variety of insurance carriers. 

IVANS Transfer Manager

Generic Attachment Importer

The Generic Attachment Importer is used to automatically attach files to a HawkSoft CMS client file. 

The imported files are attached to the correct policy/client file when the policy number is used as the file 

name.

Generic Attachment Importer

Scheduling Automatic IVANS Transfers

IVANS Transfer Manager™ downloads can be scheduled to run automatically.  The computer sched-

uled for an automatic download must be turned on and logged into the network at the time the task is 

scheduled to run. 

Scheduling Automatic  IVANS Transfer Manager Downloads 

Create Clients from an Initial Download

As a new agency with  HawkSoft CMS, initial downloads can be the primary method for creating the first 

clients and policies in your CMS database. If your agency doesn't have  a prior management system or 

#Carrier%20Integration%20Overview_..44
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has chosen not to have  HawkSoft convert your prior data, you might want to take advantage of an initial 

download.   

An Initial download, also called initial load, or synchronization (sync) download, is a download sent by a 

carrier containing all active clients and policies written by your agency under that carrier.

You can configure HawkSoft CMS to automatically create clients and policies from the initial download.  

However,  some manual clean-up is required once initial downloads are processed to ensure that cli-

ents and policies contain accurate information, and to correct any erroneous or duplicate clients or 

policies.

This article covers setting up and processing initial downloads, as well as instructions and tips on clean-

ing up your database once initial downloads are processed.

Create Clients and Policies from an Initial Download

Carriers that Download

A list of carriers that offer downloads and Real Time integration with HawkSoft CMS is available from 

the Resources menu on the HawkSoft website. Use this list to quickly find  carriers that download into 

CMS.

Once you find the carrier you are looking for, you can view the following information for each carrier, 

and create a custom list of instructions for setting up downloads with the carrier as well as any related 

forms required for the setup:

 l  Subcarriers and NAIC codes

 l Lines of business  available for download 

 l  "Other" types of downloads available  (e.g. eDocs, Claims, and Memos)

 l Real Time Integrations  available  for each carrier

In this topic:

Access the List of Carriers Search for a Carrier Create a Custom List of Car-

rier Download Setup Instruc-

tions

#Create%20Clients%20and%20Policies%20from%20an%20Initial%20Download_..38
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To access the list of carriers

From CMS

Click the   Help icon, and then select Carrier Download List. 

The Carrier Downloads & Real Time Integration page opens in the HawkSoft 

website. 

From the HawkSoft website

 1.  Open the  HawkSoft website in your browser.

 2.  Click the Resources drop-down menu, and then select Carrier Down-
loads. 

The Download Center Carrier Downloads & Real Time Integration page 

opens with a list of carriers.

To Search for a carrier
Select a  category from the available Search By drop-down, and then enter  or select an 
item from the second Search field to quickly find the carrier information you need. 

 Search categories

Carriers/Subcarriers Name – Enter the name of a carrier or subcarrier in the 
available Search field.

Commercial Lines – Select a line of business from the available drop-down 
to view a list of carriers that download that line of business. 

Personal Lines – Select a line of business from the available drop-down to 
view a list of carriers that download that line of business. 

Other Downloads – Select a type of download, other than personal or com-
mercial, such as Memos, eDocs, or Claims. Your search results will include 

carriers that offer this type of download.  

https://carriers.hawksoft.com/
https://www.hawksoft.com/
https://carriers.hawksoft.com/
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Real Time Integrations – Select a type of Real Time Integration in the 
Search field, such as Billing Inquiry or Policy View. Your search results will 

include carriers that offer this type of integration. 

NAIC –    Enter a specific NAIC code to find a matching subcarrier. 

  Alphabetical Filter
The letters on the right-side of the screen are available to limit the list of carriers to include 
only carrier names that begin with the selected letter. 

To create a custom list of carrier download setup instructions 

Download instructions are available for each carrier in the list. These instructions will  help 

you configure your agency to receive downloads.

 1.  Click on the carrier name to open the Carrier Information drop-down.

Carrier Information

The Carrier Information  displays: 

 l  Subcarriers and NAIC codes

 l Lines of business  available for download (personal and com-

mercial)

 l  "Other" types of downloads available  (e.g. eDocs, Claims, and 

Memos)

 l Real Time Integrations  available  for each carrier

 l Instructions and forms available for downloading

Lines of Business, Other Down-

loads,  and Real Time Integrations 

list

Each line of business that this carrier down-

loads is listed in the  Commercial Lines or 
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Personal Lines  sections. Additional types of 
available downloads, such as Direct Bill, or 

eDocs, is listed below Other Downloads.  The 
types of Real Time Integrations availabe 
with the carrier are listed in the far right-hand 

column. 

The current status of the specific type of down-

load is indicated with an icon. Hover over the 

icon for the status definition. 

Download Setup Instructions 

The download instructions are included in this 

section to help you take the appropriate steps 

to begin receiving downloads for that carrier. 

These are the instructions that will be included 

when you add them to your Download Instruc-

tions. 

 2.  Click the Add to My Download Setup Instructions link to select the download 
instructions and any related forms required for setting up the carrier.

 You will see the number increase next to the  My Download Setup Instructions 

in the top right-hand corner of the page.

The link becomes Remove from My Download Setup Instructions. If needed, 
click the link to remove this carrier's instructions from your list.

 3.  Continue selecting and adding carriers as needed.

 4.   Click My Download Setup Instructions in the upper right corner to review and 
download your saved download setup instructions.  

Optional: You can easily remove a selected carrier from the list if needed. 

 a.  Click the Remove Items in the lower left-hand corner.                                      

A list of your selected carriers  opens.

 b.  Click Remove next to any item(s) as needed, and then click OK.
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 5.  Click the Download button to download the instructions for each selected carrier as 
a PDF document, as well as any associated download setup forms  to your com-

puter. 

See Setting Up a New Carrier for Downloads for additional information.

Related Topics

Carrier Downloads Overview

Carrier Download Setup Overview

Setting Up a New Carrier for Downloads

HawkSoft CMS enables you to configure downloads from any carriers that download policy inform-

ation.

This article describes the process  for setting up a new carrier to download to CMS for your agency. 

In this topic:

Determine How the Carrier Downloads Notify the Carrier You are Ready for Down-

loads

Determine how the carrier downloads
Contact the carrier to determine how they will send downloads to your agency. Carriers can send down-

loads to your agency through one or more of the following download methods:

 l IVANS – Most companies download through the third party vendor, IVANS Transfer Manager 
(ITM)™. This software is typically configured during your initial setup with  CMS.

See IVANS Transfer Manager for instructions on configuring ITM.

#Carrier%20Downloads%20Overview_..114
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 l Other third-party vendors –  Some carriers use one of several third-party vendors other than 
IVANS, such as TEAM-UP® or Symbience Clear Path®. Contact the individual vendor to install, 

configure, and obtain instructions for running the software.

 l Proprietary software –  Some carriers, such as Progressive®, use their own software to down-
load policy transaction files to CMS. Contact the individual carriers to install, configure, and 

obtain instructions for running the software.

For carriers who download through IVANS

Depending on the carrier you are setting up, you may be asked to provide any or all of the 

following information:

 l IVANS Y-Account number and User ID

These are located in Download Configuration Settings on the IVANS Mailbox Set-
tings tab on the workstation/server that has IVANS Transfer Manager installed.

 l IBM Machine Address

Inform the carrier that this information does not apply to IVANS (CMS) downloads.

 l The IVANS mailbox destination

The IVANS mailbox destination is ECS.

 l The download destination path

This will vary, depending upon your network configuration. The destination path for 

downloads is the Download folder in the shared network HAW directory. It must end 

with \haw\download.

Example: Z:\haw\download.

 l The Policy Number format

HawkSoft recommends [PolicyNumber]-[2 digit iteration]. Example: 1234567-01

Configure carrier or third party download software

Some carriers, such as Progressive®, use software they develop and maintain for down-

loading policy transactions to HawkSoft CMS. Other carriers use a third-party vendor, 

such as Symbience Clear Path®. 
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HawkSoft, Inc. recommends all third-party applications be installed and run from one local 

computer only.

This task is typically performed by an Owner/Administrator or Manager.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Download Configuration

See Setting User Permissions for more information.

CMS requirements for installing download software

Contact the individual carriers to install, configure, and obtain instructions for 

running the software.

Install and configure the software on the same workstation that you  run down-

loads from. 

All carrier download software must be configured to download policy trans-

action  AL3 files to the “(network drive):\haw\download” directory. 

Notify the carrier  you are ready for downloads
After you have installed the appropriate software, contact the carrier to let them know you are ready to 

receive downloads. 

Determine types of downloads your agency will receive
When you request a carrier download, the carrier might ask whether you want to receive 

an initial download, and/or a Direct Bill Commission Statement download. 

NAIC coverages and codes
The carrier may send a multi-page document of NAIC and coverage codes to install  in 

CMS. 
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These NAIC and other carrier specific coverage codes are already installed in CMS.  As 

carriers notify HawkSoft, Inc. with changes to NAIC and coverage codes used in policy 

downloads, HawkSoft, Inc. updates the CMS database.

If your agency receives a request to add coverage codes to your management system, 

reply to the carrier to let them know the code installation is complete, or use the following 

message: 

“HawkSoft, Inc. has installed all NAIC and Coverage codes into the Client 

Management System for all carriers that have certified them for downloads.”

Related Topics
Process Carrier Downloads
Carrier Downloads Overview
Carrier Download Setup Overview

Carrier Integration Overview

Many carriers permit direct integration with policyholder data, either through IVANS’s Transformation 

Station or similar software. Direct integration allows you to view information, and in some cases, trans-

fer information, without navigating through the carrier's website. These articles provide information on 

how to set up these integrations.

Arrowhead Direct Integration

Arrowhead direct integration provides users with the tools to directly transfer information from CMS to 

the Arrowhead website through the Action menu.

Arrowhead Direct Integration

ClassicPlan Premium Finance Integration

The ClassicPlan Premium Finance integration bridges client and policy premium information from CMS 

to the ClassicPlan Premium Finance Website.

ClassicPlan Premium Finance Integration

#Process%20Carrier%20Downloads_..106
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Progressive Insurance Direct Integration

Progressive direct integration enables users to directly transfer information from CMS to the Pro-

gressive website through the Action menu.

Progressive Insurance Direct Integration

IVANS Transformation Station Integration

Transformation Station© Integration provides users with a tool to perform policy inquiries, billing 

inquiries, claims inquiries, and quoting directly with participating carriers. 

Transformation Station Integration

Download Configuration Settings

HawkSoft CMS enables you to configure download rules to determine how carrier downloads are pro-

cessed and how they are assigned for follow up at your agency. Different rules can be applied to per-

sonal and commercial lines downloads, or your agency can apply the same rules to all lines of 

business.

This article explains how to  determine if the download rules  apply to both personal and commercial 

lines of business, or if your agency applies different rules for each. By default, CMS applies one set of 

rules to both personal and commercial. Your agency may want to set different rules if some agents spe-

cialize in commercial lines and others only do personal lines.

This task is typically performed by an Owner/Administrator or Manager.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Download Configuration

See Setting User Permissions for more information.

../../../../../Content/Carrier Integration/Progressive Insurance Direct Integration.htm
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To configure download settings

 1.  Click the   Settings icon, and then select Download Configuration.

 2.  Select the Settings side-tab to determine the way CMS handles documents down-
loaded from carriers.

Use Separate Rules for Personal and Commercial Lines  

By default this check box is unchecked, and only one Download Rules 
tab appears on the left of the dialog.

 l To configure download rules for Personal and Commercial lines 

separately, check this box.

A confirmation message appears. Saving this setting will also 

save any changes you may have made on other tabs in this dia-

log.

The Download Rules side-tab is replaced by two side-tabs: Per-
sonal Download Rules and Commercial Download Rules. 
The available options are the same for each, but you can now 

configure those rules specifically for the way your agency pro-

cesses these different lines of business.

 l Uncheck to reset CMS so that it uses the same download rules 

for both lines of business.

The Download Configuration Options task menu opens.

Choose whether to Use Personal Download Rules or Use 
Commercial Download Rules.

The rule set you do not select will be deleted 
from CMS.

See Download Rules for a description of the settings on the Personal 

and Commercial Download Rules screens.



3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 43

Auto Create Unfound Policies  

Select this option to create new policies in CMS when an initial load 

includes policies not found. 

This setting is usually unchecked unless an initial load is expected. It 

should be  turned off after the initial load has been received.

Initial load

An initial load is the first download from a carrier. 

When a carrier sends an initial load, they typically send  the 

last transaction on the policy for every policy you have with 

them (varies per carrier). 

When processing downloads from an initial load, CMS 

looks for a matching policy number or a client file con-

taining all of the following information:
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lClient Name

lAddress

lCity

 l State 

 l Zip Code

Some carriers may send an initial load as a Syn-
chronization, in which case the  rules set under Syn-
chronization apply.

For Nationwide downloads, if policies don't match 
based on the criteria listed above, the ICAR number 
stored in the Agency ID field is used to match 
policies. 

Download Rules

HawkSoft CMS enables you to configure download rules  to determine how carrier downloads are pro-

cessed, and how they are  assigned for follow-up at your agency.

Download Rules are set through the Download Rules side-tab in the Download Configuration menu. 
You can also configure CMS to use two separate sets of Download Rules: one for personal lines down-

loads, and one for commercial downloads. If you have this setting enabled, you will see the Personal 
Download Rules and Commercial Download Rules side-tabs . 

See Download Configuration Settings for more information on enabling separate rules for personal and 

commercial lines.

This article describes Download Rules which are applicable to all downloads, as well as specific rules 

for certain policy download transaction types.

See Process Carrier Downloads and Download Reports for a description of types of downloads and 

details for reviewing your downloads.

Why configure Download Rules?
By setting specific rules for specific types of downloads, you can automate how the downloads are pro-

cessed when your agency's downloads are run each day. For example, you might want all can-

cellations to be reviewed by a specific user before the policy is changed in HawkSoft. You might want 

#Process%20Carrier%20Downloads_..106
#Download%20Report_..136
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all New Business downloads to automatically update the policy in HawkSoft, while also creating a Sus-

pense for a specific user to take additional action on those new business downloads. You can save 

your agency time by automating how each download type is processed.

This task is typically performed by an Owner/Administrator or Manager.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Download Configuration

See Setting User Permissions for more information.

How do I get here?

 1.  Click the   Settings icon, and then select Download Configuration.

 2.  Select the Download Rules tab.

Depending on previous configuration settings, you may see two Download 
Rules tabs, one for Personal lines and one for Commercial lines. The 
options described below apply to both. See Download Configuration Settings 
for more information   on using separate rules for personal and commercial 
lines.

General rules that apply to all downloads
The following rules apply to all download types in conjunction with specific rules for specific types of 

downloads.

Settings

When checked, CMS applies the download rules, described below, when users manually 

process documents in the Unmatched Documents Inbox.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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There is an option in the Unmatched Documents Inbox to unapply this 
setting, if needed.

Learn more about the Unmatched Documents Inbox.

Download Compare

As downloads are processed, a log note is created.  

With the Download Compare setting selected, the log note will include a summary of dif-

ferences between the new download and the previous download. 

Learn more about Comparing Downloads and Policy Snapshots.

Change of Address

When a download comes in with a client address that doesn't match the address on the cli-

ent's file, one of the following rules can apply:

Send to Unmatched Documents – When  checked, and the address in the downloaded 

item does not exactly match the address found on the client file, the download is sent to 

the Unmatched Documents Inbox for manual processing.

Update Address Information – When  checked, the address information in the client file 

is updated to match the address information in the download and the file is not sent to  Pro-

cessing Unmatched Documents.

If no  change of address rule has been set, CMS matches incoming 
downloads by policy number only, and downloads will not update cli-
ents' addresses.

#Processing%20Unmatched%20Documents_..118
#Comparing%20Downloads%20and%20Policy%20Snapshots
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Prior Term Updates

This rule is applied in conjunction with specific rules assigned to specific download types, 

listed below (e.g. Renewals, Endorsements, Claims, etc). 

 Download types such as billing notices or policy change quotes  follow 
the All other transaction types setting.

The Prior Term Updates rule overrides specific download type rules when the download 

impacts the prior term of the policy instead of the current term. 

When a download comes in for the prior term,  one or both of the following rules can over-

ride the specific download type rule:

Assign Document for Review – When checked, CMS sends the downloaded file to the 

Documents for Review list of the selected user. The user can then review the download 

and the updated policy.

Suspend Log to (Agent of Record) for 30 days – When checked, logs created because 

of an updated policy during the download process are automatically suspended to the 

selected user. 

How to suspend 

 1.  Select a CMS user from the Assign To 
drop-down list.

 2.  Select Suspend or Open Transaction.

 This is the date the item is due. If the 

date is left blank, it is classified as an 

Open Transaction, meaning the item 

appears on the Suspense list imme-

diately.

#Documents%20for%20Review
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 3.  Optional: Select a Priority from the drop-down list.

Users can sort Suspenses by Priority on the  Suspense list. 

 4.  Optional: Select a Category from the drop-down list. 

Suspenses are sorted by Category on the Start Page and users can also filter their 

Suspense list by Category. 

The available Categories can be customized for your agency. 
See Customizing Lists for detailed instructions.

Suspense on a package download

When a package download is processed, CMS creates a separate download for the lines 

of business that belong in a Home or Auto policy type.  In these cases, the Suspense will 

be applied to only one line of business in the download file, so that the same suspense 

isn't created for multiple policies. 

For example: A downloaded package policy contains a General Liability, Commercial 
Property, and a Business Auto line of business.  CMS will create a separate download file 

for the Business Auto and the Suspense will be created for the policy that contains the 

General Liability and Commercial property lines of business.       

Specific rules for specific download types

Cancellations

Any of the following rules can apply to a downloaded policy cancellation:

Update Policy – When checked, CMS updates the matching policy found in CMS with the 

information from the download and creates a log note on the policy with download inform-

ation.

If this setting is left unchecked, CMS auto-attaches the download to the matching policy, 

without updating the policy.



3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 49

If the policy is not updated, It is important to assign the download to be 
reviewed from a user's Documents for Review or Suspense list.

Assign Document for Review – When checked, CMS sends the downloaded can-

cellation file to the Documents for Review list of the selected user. 

Suspend Log – When checked, logs created during the download process are auto-

matically suspended to the selected user. 

How to suspend 

 1.  Select a CMS user from the Assign To 
drop-down list.

 2.  Select Suspend or Open Transaction.

 This is the date the item is due. If the date 

is left blank, it is classified as an Open 

Transaction, meaning the item appears 

on the Suspense list immediately.

 3.  Optional: Select a Priority from the drop-
down list.

Users can sort Suspenses by Priority on 

the  Suspense list. 

 4.  Optional: Select a Category from the drop-down list. 

Suspenses are sorted by Category on the Start Page and users can also filter their 

Suspense list by Category. 

The available Categories can be customized for your agency. 
See Customizing Lists for detailed instructions.

Suspense on a package download

When a package download is processed, CMS creates a separate download for the lines 

of business that belong in a Home or Auto policy type.  In these cases, the Suspense will 
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be applied to only one line of business in the download file, so that the same suspense 

isn't created for multiple policies. 

For example: A downloaded package policy contains a General Liability, Commercial 
Property, and a Business Auto line of business.  CMS will create a separate download file 

for the Business Auto and the Suspense will be created for the policy that contains the 

General Liability and Commercial property lines of business.       

Reinstatements/Reversal of Non-Renewals/Re-Issues

Any of the following rules can apply to a downloaded reinstatement or reversal:

Update Policy – When checked, CMS updates the matching policy found in CMS with the 

information from the download and creates a log note on the policy with download inform-

ation.

If this setting is left unchecked, CMS auto-attaches the download to the matching policy, 

without updating the policy.

If the policy is not updated, It is important to assign the download to be 
reviewed from a user's Documents for Review or Suspense list.

Assign Document for Review – When checked, CMS sends the downloaded file to the 

Documents for Review list of the selected user. 

Suspend Log – When checked, logs created during the download process are auto-

matically suspended to the selected user. 

How to suspend 
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 1.  Select a CMS user from the Assign To 
drop-down list.

 2.  Select Suspend or Open Transaction.

 This is the date the item is due. If the 

date is left blank, it is classified as an 

Open Transaction, meaning the item 

appears on the Suspense list imme-

diately.

 3.  Optional: Select a Priority from the drop-
down list.

Users can sort Suspenses by Priority on the  Suspense list. 

 4.  Optional: Select a Category from the drop-down list. 

Suspenses are sorted by Category on the Start Page and users can also filter their 

Suspense list by Category. 

The available Categories can be customized for your agency. 
See Customizing Lists for detailed instructions.

Suspense on a package download

When a package download is processed, CMS creates a separate download for the lines 

of business that belong in a Home or Auto policy type.  In these cases, the Suspense will 

be applied to only one line of business in the download file, so that the same suspense 

isn't created for multiple policies. 

For example: A downloaded package policy contains a General Liability, Commercial 
Property, and a Business Auto line of business.  CMS will create a separate download file 

for the Business Auto and the Suspense will be created for the policy that contains the 

General Liability and Commercial property lines of business.       

Rewrites
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Any of the following rules can apply to a downloaded rewritten policy:

Update Policy – When checked, CMS updates the matching policy found in CMS with the 

information from the download and creates a log note on the policy with download inform-

ation.

If this setting is left unchecked, CMS auto-attaches the download to the matching policy, 

without updating the policy.

If the policy is not updated, It is important to assign the download to be 
reviewed from a user's Documents for Review or Suspense list.

Assign Document for Review – When checked, CMS sends the downloaded rewritten 

file to the Documents for Review list of the selected user. 

Suspend Log – When checked, logs created during the download process are auto-

matically suspended to the selected user. 

How to suspend 

 1.  Select a CMS user from the Assign To 
drop-down list.

 2.  Select Suspend or Open Transaction.

 This is the date the item is due. If the date 

is left blank, it is classified as an Open 

Transaction, meaning the item appears 

on the Suspense list immediately.

 3.  Optional: Select a Priority from the drop-
down list.

Users can sort Suspenses by Priority on 

the  Suspense list. 

 4.  Optional: Select a Category from the drop-down list. 
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Suspenses are sorted by Category on the Start Page and users can also filter their 

Suspense list by Category. 

The available Categories can be customized for your agency. 
See Customizing Lists for detailed instructions.

Suspense on a package download

When a package download is processed, CMS creates a separate download for the lines 

of business that belong in a Home or Auto policy type.  In these cases, the Suspense will 

be applied to only one line of business in the download file, so that the same suspense 

isn't created for multiple policies. 

For example: A downloaded package policy contains a General Liability, Commercial 
Property, and a Business Auto line of business.  CMS will create a separate download file 

for the Business Auto and the Suspense will be created for the policy that contains the 

General Liability and Commercial property lines of business.       

Non-Renewals

Any of the following rules can apply to a downloaded non-renewal policy:

Update Policy – When checked, CMS updates the matching policy found in CMS with the 

information from the download and creates a log note on the policy with download inform-

ation.

If this setting is left unchecked, CMS auto-attaches the download to the matching policy, 

without updating the policy.

If the policy is not updated, It is important to assign the download to be 
reviewed from a user's Documents for Review or Suspense list.

Assign Document for Review – When checked, CMS sends the downloaded non-

renewal file to the Documents for Review list of the selected user. 
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Suspend Log – When checked, logs created during the download process are auto-

matically suspended to the selected user. 

How to suspend 

 1.  Select a CMS user from the Assign To 
drop-down list.

 2.  Select Suspend or Open Transaction.

 This is the date the item is due. If the 

date is left blank, it is classified as an 

Open Transaction, meaning the item 

appears on the Suspense list imme-

diately.

 3.  Optional: Select a Priority from the drop-
down list.

Users can sort Suspenses by Priority on the  Suspense list. 

 4.  Optional: Select a Category from the drop-down list. 

Suspenses are sorted by Category on the Start Page and users can also filter their 

Suspense list by Category. 

The available Categories can be customized for your agency. 
See Customizing Lists for detailed instructions.

Suspense on a package download

When a package download is processed, CMS creates a separate download for the lines 

of business that belong in a Home or Auto policy type.  In these cases, the Suspense will 

be applied to only one line of business in the download file, so that the same suspense 

isn't created for multiple policies. 

For example: A downloaded package policy contains a General Liability, Commercial 
Property, and a Business Auto line of business.  CMS will create a separate download file 

for the Business Auto and the Suspense will be created for the policy that contains the 

General Liability and Commercial property lines of business.       
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Uprate Alerts for Renewals

The Uprate Alert calculates the difference between the policy's Current Rate, which is 

found on the GPI screen in the client file, and the renewal premium referenced in the down-

load. If the difference is greater than the agency-determined threshold, the Renewal or 

Renewal Quote download will create a Suspense, and/or send a copy to Documents for 

Review, depending on your settings.

If there are no previous downloads to compare to,  the alert is not triggered and a Sus-

pense or Document for Review item is not created.

Uprate Alerts only apply to Renewal or Renewal Quote downloads. For 
instance, an Endorsement download which raises the premium will not 
trigger your Uprate Alert download rules (but will still trigger your 
Endorsement download rules).

Configuring Uprate Alert

Any of the following rules can apply to a downloaded uprate alert:

To  Assign Documents for Review

 1.  Enter the percentage of increase in the Premium Uprate Of field that will trigger the 
uprate alert.

 2.  Select a user from the Assign To drop-down list.

 3.  Click OK.

To  Suspend Log.
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 1.  Enter the percentage of increase in the Premium Uprate Of field that will trigger the 
uprate alert.

 2.  Select a CMS user from the Assign To drop-down list.

 3.  Select Suspend or Open Transaction.

 This is the date the item is due. If the date is left blank, it is classified as an Open 

Transaction, meaning the item appears on the Suspense list immediately.

 4.  Select a Priority from the drop-down list.

Renewals

Any of the following rules can apply to a downloaded policy renewal:

Update Policy – When checked, CMS updates the matching policy found in CMS with the 

information from the download and creates a log note on the policy with download inform-

ation.

If this setting is left unchecked, CMS auto-attaches the download to the matching policy, 

without updating the policy.
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If the policy is not updated, It is important to assign the download to be 
reviewed from a user's Documents for Review or Suspense list.

Do not update renewals/endorsements until their effective date – Applies to Rene-

wals only. Select to postpone the policy update until the effective renewal date. On the 

effective date of the Renewal, the Renewal download will be processed with other down-

loads processed by the agency.

If this setting is enabled, Renewals will download and attach to the 
policy, and the policy Status will be changed to Renewal (Pending). 
However, the policy will not be updated until the effective date of the 
renewal. When the Renewal processes, an additional log note is cre-
ated and a line item appears on the Download Report with "Policy 
Updated" as the Transaction Type.

  If a policy is canceled and the Pending Renewal is not processed, a 
log note is added: "Pending Renewal was not processed because 
policy is currently canceled."

Assign Document for Review – When checked, CMS sends the downloaded renewal 

file to the Documents for Review list of the selected user. 

Suspend Log – When checked, logs created during the download process are auto-

matically suspended to the selected user. 

How to suspend 

 1.  Select a CMS user from the Assign To 
drop-down list.

 2.  Select Suspend or Open Transaction.

 This is the date the item is due. If the 

date is left blank, it is classified as an 

Open Transaction, meaning the item 

appears on the Suspense list imme-

diately.
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 3.  Optional: Select a Priority from the drop-down list.

Users can sort Suspenses by Priority on the  Suspense list. 

 4.  Optional: Select a Category from the drop-down list. 

Suspenses are sorted by Category on the Start Page and users can also filter their 

Suspense list by Category. 

The available Categories can be customized for your agency. 
See Customizing Lists for detailed instructions.

Suspense on a package download

When a package download is processed, CMS creates a separate download for the lines 

of business that belong in a Home or Auto policy type.  In these cases, the Suspense will 

be applied to only one line of business in the download file, so that the same suspense 

isn't created for multiple policies. 

For example: A downloaded package policy contains a General Liability, Commercial 
Property, and a Business Auto line of business.  CMS will create a separate download file 

for the Business Auto and the Suspense will be created for the policy that contains the 

General Liability and Commercial property lines of business.       

Renewal Quotes

Any of the following rules can apply to a downloaded renewal quote:

Assign Document for Review – When checked, CMS sends the downloaded renewal 

quote to the Documents for Review list of the selected user. 

Suspend Log – When checked, logs created during the download process are auto-

matically suspended to the selected user. 

How to suspend 
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 1.  Select a CMS user from the Assign To 
drop-down list.

 2.  Select Suspend or Open Transaction.

 This is the date the item is due. If the 

date is left blank, it is classified as an 

Open Transaction, meaning the item 

appears on the Suspense list imme-

diately.

 3.  Optional: Select a Priority from the drop-
down list.

Users can sort Suspenses by Priority on the  Suspense list. 

 4.  Optional: Select a Category from the drop-down list. 

Suspenses are sorted by Category on the Start Page and users can also filter their 

Suspense list by Category. 

The available Categories can be customized for your agency. 
See Customizing Lists for detailed instructions.

Suspense on a package download

When a package download is processed, CMS creates a separate download for the lines 

of business that belong in a Home or Auto policy type.  In these cases, the Suspense will 

be applied to only one line of business in the download file, so that the same suspense 

isn't created for multiple policies. 

For example: A downloaded package policy contains a General Liability, Commercial 
Property, and a Business Auto line of business.  CMS will create a separate download file 

for the Business Auto and the Suspense will be created for the policy that contains the 

General Liability and Commercial property lines of business.       

Endorsements
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Any of the following rules can apply to a downloaded policy endorsement:

Update Policy – When checked, CMS updates the matching policy found in CMS with the 

information from the download and creates a log note on the policy with download inform-

ation.

If this setting is left unchecked, CMS auto-attaches the download to the matching policy, 

without updating the policy.

If the policy is not updated, It is important to assign the download to be 
reviewed from a user's Documents for Review or Suspense list.

Assign Document for Review – When checked, CMS sends the downloaded can-

cellation file to the Documents for Review list of the selected user. 

Suspend Log – When checked, logs created during the download process are auto-

matically suspended to the selected user. 

How to suspend 

 1.  Select a CMS user from the Assign To 
drop-down list.

 2.  Select Suspend or Open Transaction.

 This is the date the item is due. If the 

date is left blank, it is classified as an 

Open Transaction, meaning the item 

appears on the Suspense list imme-

diately.

 3.  Optional: Select a Priority from the drop-
down list.

Users can sort Suspenses by Priority on the  Suspense list. 

 4.  Optional: Select a Category from the drop-down list. 
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Suspenses are sorted by Category on the Start Page and users can also filter their 

Suspense list by Category. 

The available Categories can be customized for your agency. 
See Customizing Lists for detailed instructions.

Suspense on a package download

When a package download is processed, CMS creates a separate download for the lines 

of business that belong in a Home or Auto policy type.  In these cases, the Suspense will 

be applied to only one line of business in the download file, so that the same suspense 

isn't created for multiple policies. 

For example: A downloaded package policy contains a General Liability, Commercial 
Property, and a Business Auto line of business.  CMS will create a separate download file 

for the Business Auto and the Suspense will be created for the policy that contains the 

General Liability and Commercial property lines of business.       

New Business

Any of the following rules can apply to a new business download:

Update Policy – When checked, CMS  updates the matching policy found in CMS with the 

information from the download and creates a log note on the policy with download inform-

ation.

If this setting is left unchecked, CMS auto-attaches the download to the matching policy, 

without updating the policy.

If the new client/policy is not createdupdated, It is important to assign 
the download to be reviewed from a user's Documents for Review or 
Suspense list.

Assign Document for Review – When checked, CMS sends the downloaded new busi-

ness cancellation file to the Documents for Review list of the selected user. 
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Suspend Log – When checked, logs created during the download process are auto-

matically suspended to the selected user. 

How to suspend 

 1.  Select a CMS user from the Assign To 
drop-down list.

 2.  Select Suspend or Open Transaction.

 This is the date the item is due. If the 

date is left blank, it is classified as an 

Open Transaction, meaning the item 

appears on the Suspense list imme-

diately.

 3.  Optional: Select a Priority from the drop-
down list.

Users can sort Suspenses by Priority on the  Suspense list. 

 4.  Optional: Select a Category from the drop-down list. 

Suspenses are sorted by Category on the Start Page and users can also filter their 

Suspense list by Category. 

The available Categories can be customized for your agency. 
See Customizing Lists for detailed instructions.

Suspense on a package download

When a package download is processed, CMS creates a separate download for the lines 

of business that belong in a Home or Auto policy type.  In these cases, the Suspense will 

be applied to only one line of business in the download file, so that the same suspense 

isn't created for multiple policies. 

For example: A downloaded package policy contains a General Liability, Commercial 
Property, and a Business Auto line of business.  CMS will create a separate download file 

for the Business Auto and the Suspense will be created for the policy that contains the 

General Liability and Commercial property lines of business.       
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Memos

Most memos are sent to the Unmatched Document Inbox, however, if the memo contains 

a policy number that CMS can match, the memos are attached to the policy and follow the 

selected rules.  

Choose from the following settings to apply when a matching policy is found:  

Assign Document for Review – When checked, CMS sends the downloaded file to the 

Documents for Review list of the selected user. Download types not specifically listed in 

Download Configuration follow the All other transaction types setting.

Suspend Log – When checked, logs created during the download process are auto-

matically suspended to the selected user. See below for instructions.

How to suspend 

 1.  Select a CMS user from the Assign To 
drop-down list.

 2.  Select Suspend or Open Transaction.

 This is the date the item is due. If the 

date is left blank, it is classified as an 

Open Transaction, meaning the item 

appears on the Suspense list imme-

diately.

 3.  Optional: Select a Priority from the drop-
down list.

Users can sort Suspenses by Priority on the  Suspense list. 

 4.  Optional: Select a Category from the drop-down list. 

Suspenses are sorted by Category on the Start Page and users can also filter their 

Suspense list by Category. 

#Processing%20Unmatched%20Documents_..118
#To_configure_Suspend_Log
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The available Categories can be customized for your agency. 
See Customizing Lists for detailed instructions.

Suspense on a package download

When a package download is processed, CMS creates a separate download for the lines 

of business that belong in a Home or Auto policy type.  In these cases, the Suspense will 

be applied to only one line of business in the download file, so that the same suspense 

isn't created for multiple policies. 

For example: A downloaded package policy contains a General Liability, Commercial 
Property, and a Business Auto line of business.  CMS will create a separate download file 

for the Business Auto and the Suspense will be created for the policy that contains the 

General Liability and Commercial property lines of business.       

Synchronizations

Synchronization files are sent from the insurance carrier upon request and when starting 

downloads with each carrier. When the download is a synchronization and not a specific 

download type, client and policy information are updated.  An agency may request a syn-

chronization from a carrier to ensure the book of business in CMS is up to date with  the car-

rier.

Choose from the following settings to apply when synchronized files are received:

Enhanced Policies (Remove coverages without LOBs) –   If checked, any coverages lis-
ted on the policy without a line of business will be removed.

Auto Create Unfound Policies – Select to create a new client/policy from the download 
file when a policy is not found in CMS during a synchronization download.  When pro-

cessing downloads, CMS looks for a matching policy number or a client file containing all 

of the following information:
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HawkSoft strongly recommends leaving Auto Create Unfound Policies 
disabled unless your agency is performing an "initial load", or down-
loading your book of business into HawkSoft for the first time. For more 
information, see the Initial Downloads Overview video.

 l Client Name (First and Last 

Name)

(Suffix is excluded from match)

 l Address

 l City

 l State 

 l Zip 

Code

Update Policy – When checked, CMS updates the matching policy found in CMS with the 

information from the download and creates a log note on the policy with download inform-

ation. 

When not checked, CMS auto-attaches the download to the matching policy, without 

updating the policy.

Assign Document for Review – When checked, CMS sends the downloaded file to the 

Documents for Review list of the selected user. Download types not specifically listed in 

the Download Configuration will follow the All other transaction types setting.

Suspend Log – When checked, logs created during the download process are auto-

matically suspended to the user specified or the agent of record on the policy. 

How to suspend 

 1.  Select a CMS user from the Assign To 
drop-down list.

 2.  Select Suspend or Open Transaction.

 This is the date the item is due. If the 

date is left blank, it is classified as an 

Open Transaction, meaning the item 

appears on the Suspense list imme-

diately.
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 3.  Optional: Select a Priority from the drop-down list.

Users can sort Suspenses by Priority on the  Suspense list. 

 4.  Optional: Select a Category from the drop-down list. 

Suspenses are sorted by Category on the Start Page and users can also filter their 

Suspense list by Category. 

The available Categories can be customized for your agency. 
See Customizing Lists for detailed instructions.

Suspense on a package download

When a package download is processed, CMS creates a separate download for the lines 

of business that belong in a Home or Auto policy type.  In these cases, the Suspense will 

be applied to only one line of business in the download file, so that the same suspense 

isn't created for multiple policies. 

For example: A downloaded package policy contains a General Liability, Commercial 
Property, and a Business Auto line of business.  CMS will create a separate download file 

for the Business Auto and the Suspense will be created for the policy that contains the 

General Liability and Commercial property lines of business.       

eDocs and Messages

Assign to Document for Review – When checked, CMS sends the downloaded file to 

the Documents for Review list of the selected user.

Sending EDocs to the Documents for Review list allows you to prioritize and take action on 

important carrier notifications such as late payments or underwriting questions. 

Suspend Log – When checked, logs created during the download process are auto-

matically suspended to the user specified. 

How to suspend 
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 1.  Select a CMS user from the Assign To 
drop-down list.

 2.  Select Suspend or Open Transaction.

 This is the date the item is due. If the 

date is left blank, it is classified as an 

Open Transaction, meaning the item 

appears on the Suspense list imme-

diately.

 3.  Optional: Select a Priority from the drop-
down list.

Users can sort Suspenses by Priority on the  Suspense list. 

 4.  Optional: Select a Category from the drop-down list. 

Suspenses are sorted by Category on the Start Page and users can also filter their 

Suspense list by Category. 

The available Categories can be customized for your agency. 
See Customizing Lists for detailed instructions.

Suspense on a package download

When a package download is processed, CMS creates a separate download for the lines 

of business that belong in a Home or Auto policy type.  In these cases, the Suspense will 

be applied to only one line of business in the download file, so that the same suspense 

isn't created for multiple policies. 

For example: A downloaded package policy contains a General Liability, Commercial 
Property, and a Business Auto line of business.  CMS will create a separate download file 

for the Business Auto and the Suspense will be created for the policy that contains the 

General Liability and Commercial property lines of business.       

Claims Downloads
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Assign to Document for Review – When checked, CMS sends the downloaded file to 

the Documents for Review list of the selected user.

Sending  Claims to the Documents for Review list allows you to prioritize and take action 

on important carrier notifications such as adjuster information or  claim payments. 

Suspend Log – When checked, logs created during the download process are auto-

matically suspended to the user specified. 

How to suspend 

 1.  Select a CMS user from the 

Assign To drop-down list.

 2.  Select Suspend or Open 
Transaction.

 This is the date the item is 

due. If the date is left blank, it 

is classified as an Open 

Transaction, meaning the 

item appears on the Sus-

pense list immediately.

 3.  Optional: Select a Priority from the drop-down list.

Users can sort Suspenses by Priority on the  Suspense list. 

 4.  Optional: Select a Category from the drop-down list. 

Suspenses are sorted by Category on the Start Page and users can 

also filter their Suspense list by Category. 

The available Categories can be customized for 
your agency. See Customizing Lists for detailed 
instructions.
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Suspense on a package download

When a package download is processed, CMS creates a separate download 

for the lines of business that belong in a Home or Auto policy type.  In these 

cases, the Suspense will be applied to only one line of business in the down-

load file, so that the same suspense isn't created for multiple policies. 

For example: A downloaded package policy contains a General Liability, 
Commercial Property, and a Business Auto line of business.  CMS will create 

a separate download file for the Business Auto and the Suspense will be cre-

ated for the policy that contains the General Liability and Commercial property 

lines of business.       

Auto Create Unmatched Claims – When checked, CMS creates a new claim on the 

matching policy with the information from the Claim download when the download does 

not match to an existing claim on the policy. A log note is created on the policy with down-

load information.

All other Transaction Types

If a download arrives that doesn't fall into any of the other transaction types listed above, it 

will fall into this category. Choose how you would like to be notified that the download has 

arrived. Items that fall into this category might be Billing Notices, Policy Change Quotes,  

etc.

Assign to Document for Review – Assign a user to receive Document for Review items 
when a user is invalid and is assigned to receive these items from downloads.

Suspend Log – Assign a user to receive Suspenses when a user is invalid and is 
assigned to receive Suspenses from downloads. See below for instructions.

How to suspend 

#To_configure_Suspend_Log
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 1.  Select a CMS user from the 

Assign To drop-down list.

 2.  Select Suspend or Open 
Transaction.

 This is the date the item is 

due. If the date is left blank, it 

is classified as an Open 

Transaction, meaning the 

item appears on the Sus-

pense list immediately.

 3.  Optional: Select a Priority from the drop-down list.

Users can sort Suspenses by Priority on the  Suspense list. 

 4.  Optional: Select a Category from the drop-down list. 

Suspenses are sorted by Category on the Start Page and users can 

also filter their Suspense list by Category. 

The available Categories can be customized for 
your agency. See Customizing Lists for detailed 
instructions.

Suspense on a package download

When a package download is processed, CMS creates a separate download 

for the lines of business that belong in a Home or Auto policy type.  In these 

cases, the Suspense will be applied to only one line of business in the down-

load file, so that the same suspense isn't created for multiple policies. 

For example: A downloaded package policy contains a General Liability, 
Commercial Property, and a Business Auto line of business.  CMS will create 

a separate download file for the Business Auto and the Suspense will be cre-

ated for the policy that contains the General Liability and Commercial property 

lines of business.       
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Default User for Invalid Suspense/Document for Review 

Assignment

Use this setting to determine who should receive notifications when an invalid user (a user 

no longer on the User List) is assigned to receive download notifications via a Suspense or 

when an item will be added to their Documents for Review.

An agency may want to set a default user in case an agent leaves the agency and the 

agent is removed or made inactive in the User List.

Assign to Document for Review – Assign a user to receive Documents for Review items 
when the user currently assigned to receive  the download is invalid.

Suspend Log – Assign a user to receive Suspenses when the user currently assigned to 
receive the Suspense for a download is invalid. 

How to suspend 

 1.  Select a CMS user from 

the Assign To drop-
down list.

 2.  Select Suspend or 
Open Transaction.

 This is the date the item 

is due. If the date is left blank, it is classified as an Open Transaction, 

meaning the item appears on the Suspense list immediately.

 3.  Optional: Select a Priority from the drop-down list.

Users can sort Suspenses by Priority on the  Suspense list. 

 4.  Optional: Select a Category from the drop-down list. 

Suspenses are sorted by Category on the Start Page and users can 

also filter their Suspense list by Category. 
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The available Categories can be customized for 
your agency. See Customizing Lists for detailed 
instructions.

Suspense on a package download

When a package download is processed, CMS creates a separate download 

for the lines of business that belong in a Home or Auto policy type.  In these 

cases, the Suspense will be applied to only one line of business in the down-

load file, so that the same suspense isn't created for multiple policies. 

For example: A downloaded package policy contains a General Liability, 
Commercial Property, and a Business Auto line of business.  CMS will create 

a separate download file for the Business Auto and the Suspense will be cre-

ated for the policy that contains the General Liability and Commercial property 

lines of business.       

IVANS Transfer Manager

IVANS Transfer Manager (ITM)  can be installed at your agency to enable HawkSoft CMS to receive 

electronic downloads from a variety of insurance carriers. 

Before installing IVANS Transfer Manager, your agency will need an IVANS mailbox.   The  mailbox 

enables  you to receive multiple carrier downloads through a single portal. This eliminates the need to 

use a separate portal for every carrier you do business with. SeeIVANS Transfer Manager below.

When launched, ITM retrieves carrier downloads   from your agency's IVANS mailbox  so that CMS can 

process the downloaded files.
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 ITM is designed to run from one workstation only. Attempting to 

run IVANS from multiple workstations will cause a disruption in service.

If you need to install IVANS on a different computer, you must uninstall it 

from its current workstation. 

 1.  Open Programs and Features from the Windows Control Panel.

 2.  Right-click on IVANS Transfer Manager, and then select Uninstall.

Once installation is complete, contact HawkSoft Support to reset the 

IVANS Transfer Manager security authorization.

In this topic:

IVANS Transfer Manager IVANS Transfer Manager IVANS Transfer Manager

IVANS Transfer Manager Scheduling Automatic  

IVANS Transfer Manager 

Downloads 

This task is typically performed by an Owner/Administrator or Manager.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Download Configuration

See Setting User Permissions for more information.

 IVANS Mailbox
In order to get a mailbox set up with IVANS, you must get a carrier to initially "sponsor" a 

mailbox for you. Agencies typically contact the carrier with whom they do the most busi-

ness, and ask them to sponsor an IVANS mailbox.

The carrier contacts IVANS and requests the mailbox.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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IVANS or the carrier will then email an invitation to you to  register for IVANS Exchange 

and create a mailbox password.

You must click the link in the invitation email and complete the account 
registration process within 7 days.  If the link expires after 7 days, 
HawkSoft or IVANS will need to resend the invitation.

Once you complete registration and create a mailbox password for IVANS, it is then up to 

you to provide all of your other downloading carriers with your IVANS mailbox address.

Internal: In the HawkSoft Live Database, next to Account #, The 
IVANS Y Account number is listed to the left of the User ID number.

Example: YAccount/UserID

Downloading and installing IVANS Transfer Manager

 1.  Click: https://-

download.hawksoft.com/download/ivans/IVANSTMNET4.1.0.exe

Once the download is finished, the View Downloads - Internet 
Explorer window opens.

 2.  Click Run to open the installer..

The IVANS Transfer Manager install wizard opens.

 3.  Click Next on the installer.

 4.  Click Yes to agree on the IVANS License Agreement.

 IVANS Transfer Manager begins installing, and displays a message 

that IVANS has been installed once complete.

 5.  Click Yes to close the installer.

IVANS Transfer Manager is now installed to your computer.

Configuring IVANS Mailbox settings

https://download.hawksoft.com/download/ivans/IVANSTMNET4.1.0.exe
https://download.hawksoft.com/download/ivans/IVANSTMNET4.1.0.exe
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 1.  Open CMS, and then click the   Settings icon.  

 2.  Select Download Configuration. 

 3.  Click the IVANS Mailbox Settings tab.

The  Path is prefilled with the path where ITM was installed, and shows the currently 
installed Version. 

 If your Transfer Manager is out of date, a message appears 
informing you that your version is unsupported. Click the mes-
sage to update the Transfer Manager.

The IVANS tab is available  only  if IVANS has been correctly 
installed.

If your agency needs to set up more than one Y-Account, con-
tact HawkSoft Product Support for assistance. 

 4.  Click Add to add your IVANS mailbox.

 5.  Enter your Y-Account, User ID, and Password you received from IVANS.

 6.  If you have made changes to this screen, click the Update IVANS Mailboxes but-
ton  to update your local installation of Transfer Manager.

If successful, a "Transfer Manager Updated!" message appears.

 7.  Click OK to dismiss the confirmation message.

 8.  Optional: Click the Support button to view the most recent log report.

The log report includes the date and time your company downloads were last run, 

the number of records processed, and other information that might be helpful for 

troubleshooting.

 a.  Optional: Click Send to HawkSoft Support to send the log to the Support 
team, if you are having issues with your download.

For troubleshooting,  HawkSoft Support may need to use 
the Launch IVANS Transfer Manager button to review 
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the settings in IVANS Transfer Manager.

 b.  Close the Support window when done.

 9.  Click OK to close the IVANS Mailbox Settings dialog.

Change existing IVANS mailbox password
To change your IVANS password, you will need to change it on the IVANS website, and in 

your CMS Download Configuration Setup as well. 

IVANS website

 1.  Log into IVANS Exchange.

 2.  Click the menu   in the upper  right-hand corner, and then select 

Agency Profile. 

 3.  Select the Mailbox Setup tab, and then click on Password below the 
Actions header. 

 4.  Click Accept to agree to take the necessary steps of updating Transfer 
Manager in HawkSoft CMS with the new password.

 5.  Enter your New Password, and then enter it again to Confirm.

 6.  Follow the steps below to update this password for  IVANS Transfer 

Manager in CMS.

CMS Download Configuration
The IVANS password must be updated from the computer that runs the 

IVANS downloads.

 1.  Open CMS, and then click the   Settings icon. 

 2.  Select Download Configuration.

 3.  Select the IVANS Mailbox Settings side-tab.

https://exchange.ivansinsurance.com/
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 4.  Select the relevant mailbox, and then click Edit.

 5.  Update the Password that you entered on the IVANS Exchange, and 
then click OK.

 6.   Click the Update IVANS Mailboxes button.

A confirmation appears.

 7.  Click OK.

IVANS Transfer Manager is now installed and your computer is ready to receive down-

loads. 

See Scheduling Automatic  IVANS Transfer Manager Downloads  for instructions to set up 

IVANS to run automatically.

Related Topics
Download Troubleshooting
Process Carrier Downloads
Scheduling Automatic  IVANS Transfer Manager Downloads 

#Download%20Troubleshooting_..112
#Process%20Carrier%20Downloads_..106
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Scheduling Automatic  IVANS Transfer Man-
ager Downloads 
IVANS Transfer Manager downloads can be scheduled to run automatically.  The computer with IVANS 

Transfer Manager installed must be turned on and logged into the network at the time the task is sched-

uled to run.   

If you use any third-party download software for companies such as Progressive™, 
Mercury™, etc., ITM must be run after running the third-party software.

See IVANS Transfer Manager for IVANS installation instructions. 

In this topic:

Schedule Automatic Downloads in Win-

dows XP

Schedule Automatic Downloads in Windows 

Vista, Windows 7, Windows 8, or Windows 10

Required Permissions:
To perform this task, no specific CMS user permissions are required, however, your 
local Windows® security settings may need to be set by your network administrator 
prior to scheduling automatic downloads.

See Setting User Permissions for more information.

For additonal information and additional options for the Windows Task Scheduler 
for XP, Win7, and Win8,  please reference Microsoft Online Support.

To schedule automatic downloads in Windows Vista, 

Windows 7,  Windows 8, or Windows 10
 1.  Open the Windows® Control Panel, and then click Administrative Tools > Task Scheduler. 

 2.  Click Create Task. 

#Schedule_Automatic_Downloads_in_Windows_XP_Local
#Schedule_Automatic_Downloads_in_Windows_XP_Local
#Schedule_Automatic_Downloads_in_Windows_Vista_Windows_7_Windows_8_or_Windows_10
#Schedule_Automatic_Downloads_in_Windows_Vista_Windows_7_Windows_8_or_Windows_10
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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The Create Task dialog opens with the General tab open.

 3.  Type Ivans in the Name field on the General tab.

 4.  Select Run only when the user is logged on.

 5.  Select the Triggers tab, and then click New. 

 6.  The Begin the task drop-down defaults to On a schedule.

 7.  Select Weekly, and then set the time when you want the download to run.

 8.   Select all weekdays (business days), and then click OK. 

 9.  Select the Actions tab, and then click New. 

 10.  For the Program Script, click Browse, and then open the Transman.exe file. 

This file is typically found in C:\IVANS\TM.NET folder path of the workstation with IVANS Trans-

fer Manager installed.

 11.  Add /A in the Add arguments (optional) field. 

 12.  Enter the folder path in the Start in (optional) field.

 The       path is the same text listed in Program/script up to, but not including the      program name, 
Transman.exe.

 13.  Click OK. 

 14.  Click the Settings tab. 

 15.  Set the Stop the task if it runs longer than field to 4 hours. 

 16.  Click OK. 

Related Topics
Carrier Downloads Overview
Download Configuration Settings
Download Report
Process Carrier Downloads

Generic Attachment Importer

The Generic Attachment Importer is used to automatically attach files to a HawkSoft CMS client file. An 

agency may want to use the Generic Attachment Importer to automatically attach files, such as photos 

#Carrier%20Downloads%20Overview_..114
#Download%20Report_..136
#Process%20Carrier%20Downloads_..106
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of a home or business, directly to the correct policy.

 l Imported files are attached to the correct policy/client file when the policy number is used for the 

file name. 

 l When the policy number is not used as the file name, CMS sends the file to the Unmatched Docu-

ments Inbox for manual processing.

In this topic:

Enabling the Generic Attachment Importer Importing Files

This task is typically performed by an Owner/Administrator or Manager.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Download Configuration

See Setting User Permissions for more information.

Enabling the Generic Attachment Importer

 1.  Click the   Settings icon, and then select Download Configuration. 

 2.  Click the Generic Attachment Importer tab.

 3.  Check the Enable Generic Attachment Importer box. 

 4.  Click Browse to select the Import Path. 

This is the location of the files to be imported.

File names must be the same as the policy number of the file they are 
attached to, with the addition of a unique identifier. The file name format 
should be: (policy #)=(unique identifier). 

Example, 1234567890=1, and 1234567890=2. 

#Enabling_the_Generic_Attachment_Importer
#Importing_Files
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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There are two files that both need to be attached to the same policy 
(#1234567890).

 5.  Enter a Description, or select from the drop-down list.

The description is displayed in the attachment screen when it is attached to the policy during the 

download/import process. 

 6.  Optional: Select a user name from the Assign To drop-down to forward all downloaded items to 
the selected user for follow-up.

 7.  Optional: Select Import files as part of the normal download.

 l When checked, CMS imports files from the path selected in step 4 when you run a normal 

download.

 l When unchecked, you must run the Generic Attachment Importer in the Download Utility 

separately.

Importing files

Required Permissions

To complete this task, user permissions must be set to include:

 Utilities:

   Perform Downloads

See  User Permissions for more information.

Follow the steps below when  the Generic Attachment Importer is not part of the normal 

download process.

 1.  Click Taks from the main CMS menu bar, and then select  Downloads.

 2.  Select Generic Attachment Importer from the  Choose which downloads to per-
form drop-down list, and then click Finish.

Related Topics
Process Carrier Downloads

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
#Process%20Carrier%20Downloads_..106
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Documents for Review
 Processing Unmatched Documents

Create Clients and Policies from an Initial Download

As a new agency with  HawkSoft CMS, initial downloads can be the primary method for creating the first 

clients and policies in your CMS database. If your agency doesn't have  a prior management system or 

has chosen not to have  HawkSoft convert your prior data, you might want to take advantage of an initial 

download.   

An Initial download, also called initial load, or synchronization (sync) download, is a download sent by a 

carrier containing all active clients and policies written by your agency under that carrier.

You can configure HawkSoft CMS to automatically create clients and policies from the initial download.  

However,  some manual clean-up is required once initial downloads are processed to ensure that cli-

ents and policies contain accurate information, and to correct any erroneous or duplicate clients or 

policies.

This article covers setting up and processing initial downloads, as well as instructions and tips on clean-

ing up your database once initial downloads are processed.

Not all carriers offer initial downloads, and the information contained in the initial 
downloads varies by carrier. To see which carriers offer initial downloads, see our 
Carrier Downloads and Real-time Integration webpage.

In this topic:

Before You Begin Configure Hawksoft to Automatically Create Cli-

ents and Policies

Process Initial Downloads Clean Up Policy Data

Before you begin 
Before you configure HawkSoft to automatically create your clients and policies, and before you begin 

processing your initial loads, it's important to understand how the process works in HawkSoft. 

#Documents%20for%20Review
#Processing%20Unmatched%20Documents_..118
https://carriers.hawksoft.com/
#Before_You_Begin
#Configure_Hawksoft_to_Automatically_Create_Clients_and_Policies
#Configure_Hawksoft_to_Automatically_Create_Clients_and_Policies
#To_clean_up_policy_data
#To_clean_up_policy_data
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How are clients and policies created?

Your initial download automatically creates clients and policies in your HawkSoft data-

base. If this is your first initial download from the carriers, your clients and policies are not 

in the database yet.  Once the clients and policies exist in your database, HawkSoft com-

pares the downloaded client/policy information with any existing files in the database and 

creates/updates the files. 

To prevent creating duplicate files, HawkSoft uses the following matching criteria to 

update existing clients and policies before creating new files: 

Matching Criteria Match No Match 

Policy Number AND Line of Busi-
ness

Update Cli-

ent/Policy

Continue to 

Search for cli-

ent last name 

and mailing 

address

Exact match  to the last name (or 

business name for commercial 

clients) AND mailing address in 
the download

Create Policy on 

the Client

Create a new 

client file with a 

new policy

Client and policy information not downloaded correctly

Data type Description To modify

Company/Program 

Name

Company doesn't match 

Policy/Company Setup

Clean up invalid 

companies

Agent Codes

Prefixes, hyphens, or 

spaces don't match Poli-

cy/Company Setup

Clean up Agent 

Codes

Duplicate client files Incorrect address Clean up duplicate 

Example Company Doesn't Match.htm
Example Company Doesn't Match.htm
#Clean_up_invalid_companies
#Clean_up_invalid_companies
#Clean_up_Agent_Codes
#Clean_up_Agent_Codes
Duplicate Client Files Example.htm
#Clean_up_duplicate_client_files
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Data type Description To modify

client files

Policies added to the 

wrong client files
Two similar client files

Create Clients and 

Policies from an Ini-

tial Download

Client and policy information not downloaded 

Data type Description To modify

Customer 

Type

Personal Lines or Com-

mercial Lines
Assign Customer Types

Client Pro-

ducer

Agent writing client's 

policies
Assign Client Producers

Policy 

Agents

The writing or com-

missioned agent(s)

Create Clients and Policies from 

an Initial Download

To configure HawkSoft to automatically create clients and 

policies
Prior to processing your initial download, configure HawkSoft to automatically create clients and 

policies.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Download Configuration

See Setting User Permissions for more information.

#Clean_up_duplicate_client_files
Example Incorrect Client File.htm
#AssignCustome_Types
#Assign_Producers
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 1.  Click the   Settings icon, and then select Download Configuration.

 2.  From the Settings tab, check Auto Create Unfound Policies.

 3.  Click OK.

Auto Create Unfound Policies is now enabled. Any unmatched download will automatically cre-

ate a new client and/or policy rather than be sent to the Unmatched Documents Inbox.

To prevent further duplicate clients and policies, you must turn off Auto 
Create Unfound Policies from Download Configuration once you finish pro-
cessing  initial downloads from all your carriers.

To process initial downloads
Once Auto Create Unfound Policies is enabled, you can process your initial downloads the same as 

any other carrier downloads. See Process Carrier Downloads for detailed instructions.

Turn off the Auto Create settings as soon as initial 

loads are processed
Because of the issues that using Auto-Create Unfound Policies can cause, it is critical that 

you only use Auto-Create when creating your initial CMS database, and turn it off once 

you finish processing initial downloads from all your carriers.

To clean up policy data
The fastest way to clean up most invalid policy data  is to run reports through Agency Intelligence, and 

then use Data Replace to fix data on multiple policies all at once. 

This section covers how to use  Data Replace to fix invalid companies, invalid Agent Codes, and assign 

Customer Types.

Required Permissions:
In order to complete this task, user permissions must be set to include:

#Processing%20Unmatched%20Documents_..118
#Process%20Carrier%20Downloads_..106
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Reports > Advanced Reports > Agency Intelligence
Utilities > Search and Replace/Data Replace

See Setting User Permissions for more information.

Run a backup

You should always run a backup before performing a Data Replace. Once a Data Replace 

is complete, it cannot be undone. 

A new backup is critical if an error is made during the Data Replace pro-
cess; without one, your agency is at serious risk of major and irre-
versible data loss.

See Creating Backups for detailed steps.

Clean up invalid companies

Because of the possibility of making unintended changes to your client 
database, HawkSoft recommends running a CMS backup, and then 
contacting Product Support for assistance before running Data 
Replace. Product Support requires written permission from an agency 
administrator listed on the HawkSoft License Agreement before assist-
ing with a Data Replace.

 1.  Click Reports > Agency Intelligence from the CMS Menu Bar.

Agency Intelligence opens.

 2.  Select Policies in Force under Policy KPIs on the left.

 3.  Change the Group By drop-down to Company.

 4.  Click the Company column to sort the report by company name, ascending alpha-
betically.

To see which companies are invalid, open Policy/Company Setup and compare the 

companies on the report with the companies in Policy/Company Setup. If a 

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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company appears in the report but does not appear in Policy/Company Setup, the 

company is invalid.

 5.  Double-click the value in the Policies column next to a company that you need to 
change. 

The Total Active Policies by Company report for the company opens.

 6.  Click File > Data Replace.

The Data Replace dialog opens.

 7.  On the Auto tab, open the Company drop-down and choose the valid company 
name.

Example: For policies with a Company of Nationwide Mutual Ins. Co., choose 
Nationwide as the valid company name.

 8.  Open the Program drop-down and choose a valid program or writing company, if 

applicable.

Example: For policies with a Company of Nationwide Mutual Ins. Co, choose 
Nationwide Mutual Ins. Co. as the valid program name.

 9.  Repeat steps 7-8 on the Boat, Home, and Commercial / All Other side tabs.

 10.  Click OK to initiate the Data Replace.

 11.  Click Yes to confirm.

Once complete, a confirmation dialog opens.

 12.  Click OK.

 13.  Double-click any row on the report.

 14.  Verify that the policy's Company and Program are now correct and valid.

 15.  Close the Total Active Policies by Company report.

 16.  Return to the Policies in Force report.

 17.  Repeat steps 5-16 until all invalid companies are replaced.

 18.  Be sure to run Freshen Indexes when you are done replacing data.

Clean up Agent Codes

#Freshen%20Indexes%20[+Video]*
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Because of the possibility of making unintended changes to your client 
database, HawkSoft recommends running a CMS backup, and then 
contacting Product Support for assistance before running Data 
Replace. Product Support requires written permission from an agency 
administrator listed on the HawkSoft License Agreement before assist-
ing with a Data Replace.

 1.  Return to the Policies in Force report in Agency Intelligence.

 2.  Change the Group By drop-down to None.

 3.  Double-click the number under the Policies column.

A report of all active policies opens in a new tab.

 4.  From the Reports toolbar, click  .

The Report Layout window opens.

 5.  Click Add/Edit.

 6.  Check Agent Code under General Policy Information.

You can add a Policy Base Type column to the report from the 
Layout menu to see the base type of each policy. The Enhanced 
Base Type is for Commercial / All Other policies.

 7.  Optional: Uncheck any unnecessary Report Fields such as Annual Premium, 

Source, Zip, etc.

 8.  Click OK.

 9.  Click Finish.

The report refreshes with the columns selected.

 10.  From the Reports toolbar, click  .

The Create Summary dialog opens.

 11.  Select AgentCode, and then click OK.
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The AgentCode Summary of Total Active Policies by None report opens in a 
new tab.

Click the AgentCode header in the report to sort the list by 
Agent Code.

 12.  Double-click on an Agent Code to be updated.

A sub-report of all policies with that Agent Code opens.

 13.  Click File > Data Replace in the sub-report.

The Data Replace dialog opens.

 14.  On the Auto tab, open the Agent Code drop-down and choose the valid  code.

 15.  Continue to select the valid code on the Boat, Home, and  Commercial / All Other 
tabs.

 16.  Click OK to initiate the Data Replace.

 17.  Click Yes to confirm.

Once complete, a confirmation dialog opens.

 18.  Click OK.

 19.  Double-click any row on the report.

 20.  Verify that the policy's Agent Code is now correct and valid.

 21.  Close the sub-report of all policies with that agent code.

 22.  Return to the AgentCode Summary of Total Active Policies by None report.

 23.  Repeat steps 12-22 until all invalid Agent Codes have been replaced.

 24.  Be sure to run Freshen Indexes when you are done replacing data.

Clean up duplicate client files

After processing initial downloads, you might search for a client and notice two clients with 

the same name, but different Customer IDs. This is most likely due to a policy from the ini-

tial load that did not exactly match the client file.

#Freshen%20Indexes%20[+Video]*
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HawkSoft Inc. recommends that personal policies and commercial 
polices for the same client be kept in separate client files.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Client File > Action Menu > Change/Correction (Action Menu) > 
Internal Menu > Internal Correction > Duplicate Policies

See Setting User Permissions for more information.

 1.  Open both client files in separate tabs.

 2.  Compare the client files and determine which file to keep. 

Keeping the client file with the most information, specifically cor-
rect address and most complete contact information, prevents 
having to re-enter some data.

 3.  Navigate to the client file you are keeping.

 4.  Click Cust ID in the upper left-hand corner of the selected client file, and then select 
the ID number to copy to your clipboard. 

 5.  Navigate to the client file you are not keeping.

This is the client file you will archive after the merge. 

 6.  Click Action.

 7.  Select Internal > Merge Clients.

The Transfer Policy to Client dialog opens.
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 8.  Paste in the Customer ID, and then click Search.

The clients are merged, and a confirmation message appears.

 9.  Click Yes to archive the open client.

The Add Log Entry Comments dialog opens.

 10.  Add comments to document the merge, such as "Merged into Client # 2", and then 

click OK.

Repeat these steps if more duplicates are discovered while searching for a client.

See Merging Client Files for more information.

Clean up policies that have been added to the incorrect client 

files

After processing initial downloads, you might open a client file and notice an extra policy 

added to the client file that does not belong there. This can happen if there are family mem-

bers sharing the same last name and living in the same household, or a client's com-

mercial policies are added to their personal client file (or vice versa).

Creating a Log Note.htm
#Merging%20Client%20Files


3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 92

For example: Larry Lastname has a son named Lucas Lastname living with him. Lucas 
has his own auto policy in which he is the named insured, but because he shares his 

father's last name and address, CMS assumes the policy is a new policy for Larry. The 

reverse could also happen, where Larry's policy ends up on Lucas' client file, depending 

on which download is processed first.

As another example, Eddie Example has a personal homeowner's policy, but also has a 

commercial general liability policy because he is a contractor. In this case, Eddie should 

have two client files, one for his personal policies and one for his commercial policies, but 

because CMS sees a matching name and address, it assumes the policies belong on the 

same file.

The following steps can be used to move a policy from one client file to the correct client 

file. If a second client file doesn't already exist, you can create a new client file, and then 

move the policy.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Client File > Action Menu > Internal Menu > Archive/Move Policies

See Setting User Permissions for more information.

If a new client file is needed

Required Permissions:
In order to complete this task, user permissions must be set to include:

File > Insert Client

See Setting User Permissions for more information.

 1.  Click Client from the CMS Menu Bar, and then select Insert > New Customer.

The Action menu opens.

 2.  Select  (No Policy).

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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The Insert Client Only dialog opens, with Name and Address selected.

 3.  Click Add under Named Insureds and Personal Profiles, and then fill in the client 
name and any additional information, as needed.

You must add a name, but you can return and add additional 
information to the Personal Profile at a later date.

 4.  Click OK to return to save your information and return to the Insert Client Only dia-
log.

 5.  Click Finish.

The Add Log Entry Comments dialog opens.

 6.  Click OK.

The new client file is created.

 7.  Click Cust ID in the upper left-hand corner of the new client file, and then select the 
ID number to copy to your clipboard. 

You are now ready to move the policy to the new client file.

Move the policy to the correct client file

 1.  Open the client file that contains the erroneously placed policy.

 2.  Select the policy to move.

 3.  Click Action > Internal > Move Policy.

The Transfer Policy to Client dialog opens.

 4.  Paste in the Customer ID, and then click Search.
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The policy is transferred, and a confirmation message appears.

 5.  Click Yes.

Another confirmation message appears.

 6.  Click Yes to archive the policy and corresponding log notes.

The Add Log Entry Comments dialog opens, with the moved policy documented.

 7.  Click OK.

The policy along with any log notes and attachments is moved to the correct client 

file, and the old policy is archived.

You might need to click  Refresh Client on the 
new client file to show the policy.

Assign Customer Types

Customer Type is not included in the downloads from the carriers. These steps are inten-

ded to help you assign Customer Types to your client files based on the lines of business 

on the client's policies.
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Because of the possibility of making unintended changes to your client 
database, HawkSoft recommends running a CMS backup, and then 
contacting Product Support for assistance before running Data 
Replace. Product Support requires written permission from an agency 
administrator listed on the HawkSoft License Agreement before assist-
ing with a Data Replace.

 1.  Return to Agency Intelligence  > Policies in Force.

 2.  Change the Group By drop-down to None.

 3.  Double-click the number under the Policies column.

A report of all active policies opens in a new tab.

 4.  From the Reports toolbar, click  .

The Create Summary dialog opens.

 5.  Select LOBs, and then click OK.

The LOBs Summary of Total Policies report opens in a new tab.

 6.   Select all LOBs you want to assign one specific Customer Type,  such as 'Personal' 

or 'Commercial'.

 a.  Press and hold the Ctrl key and select specific entries.

OR

To select a range of line items, select the first item, and then press the Shift 

key to select the last item to be included in the section.

 b.  Right-click any of the selected entries and choose New Report from Selec-
ted Entries.

Your selected entries open in a new LOBs report.

 7.   In the new report, click File > Data Replace.

The Data Replace window opens.

 8.  Select the Client tab.

 9.  Change the Customer Type drop-down to <Replace>.
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 10.  Check the box next to the Customer Type you need to assign, such as Personal or 
Commercial.

 11.  Click OK to initiate the Data Replace.

 12.  Click Yes to confirm.

Once complete, a confirmation dialog opens.

 13.  Click OK.

After running the Data Replace, double-click on a line-item in the 
finished report to view the client file and policy. Verify that the 
Customer Type is now correct.

 14.  Close the LOBs report and return to the LOBs Summary of Total Active Policies 
report.

 15.  Repeat steps 6-14 for all LOBS until all clients are assigned a Customer Type.

 16.  Be sure to run Freshen Indexes when you are done replacing data.

Assign Client Producers

Client Producers are not included in downloads from the carriers. These steps are inten-

ded to help you assign Client Producers to your client files.

 1.  Return to Agency Intelligence  > Policies in Force.

 2.  Change the Group By drop-down to the desired grouping, depending on how your 
agency assigns producers to clients.

For example, if your agency assigns producers to clients by LOBs, choose Line of 
Business, or if your agency assigns producers to clients insured by certain carriers, 
choose Company.

 3.  Double-click the Policies count next to the group you want to assign a certain Pro-
ducer to, such as a certain Company or LOB.

A report of all policies within that group opens.

 4.   In the new report, click File > Data Replace.

The Data Replace window opens.

#Freshen%20Indexes%20[+Video]*
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 5.  Select the Client tab.

 6.  Select the desired Producer from the Producer drop-down.

 7.  Click OK to initiate the Data Replace.

 8.  Click Yes to confirm.

Once complete, a confirmation dialog opens.

 9.  Click OK.

After running the Data Replace, double-click on a line-item in the 
finished report to view the client file and policy. Verify that the 
Producer is now correct.

 10.  Repeat steps 1-9 until all active clients are assigned a Producer.

Assign Policy Agents

Policy Agents are not included in downloads from the carriers. These steps are intended to 

help you assign Agents to your client files.

 1.  Return to Agency Intelligence  > Policies in Force.

 2.  Change the Group By drop-down to the desired grouping, depending on how your 
agency assigns agents to policies.

For example, if your agency assigns agents to policies by LOBs, choose Line of 
Business, or if your agency assigns agents to policies insured by certain carriers, 
choose Company.

 3.  Double-click the Policies count next to the group you want to assign a certain Agent 
to, such as a certain Company or LOB.

A report of all policies within that group opens.

 4.   In the new report, click File > Data Replace.

The Data Replace window opens.

 5.  Select the Auto tab.

 6.  Select the desired Agent from the Agent 1 drop-down.
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 7.  Optional: Assign additional agents to these policies from the Agents 2 and 3 drop-
downs.

 8.  Repeat steps 6-7 on the Boat, Home, and Commercial / All Other tabs.

 9.  Click OK to initiate the Data Replace.

 10.  Click Yes to confirm.

Once complete, a confirmation dialog opens.

 11.  Click OK.

After running the Data Replace, double-click on a line-item in the 
finished report to view the client file and policy. Verify that the 
Agent fields are now correct.

 12.  Repeat steps 1-11 until all active clients are assigned an Agent.

Related Topics
Backup and Restore Overview
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Policy/Company Setup Overview
Process Carrier Downloads
 Processing Unmatched Documents

Policy/Company Setup Overview

Policy/Company  Setup  is an important step  in the  implementation of your HawkSoft Client Man-

agement System.  Information for each of your carriers is  entered in Policy/Company Setup to enable 

you to accurately insert policies and integrate policy information with company websites. Setup  also 

ensures the accuracy of both Trust and Commission accounting transactions, and the detail available 

when reporting.
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The information entered in Policy/Company Setup determines the default options available to users 

when inserting  policies in CMS.

 l Depending on the number of carriers your agency works with, you will need to set 

aside adequate time for completing Policy/Company Setup.

 l Make sure you have all company information including underwriting guides and 

commission schedules.

You will need the following  information: Company name and address, email 

address of underwriter and/or marketing representative, phone numbers, (cus-

tomer service, underwriting, claims, fax), website information (address of the com-

pany's log in page or home page, user names, and passwords for each staff 

member to log  into the carrier's website). 

 l To save time, use Copy/Paste and Copy/Paste Special when possible.

How Carrier Setup works

Policy/Company Setup is structured around the lines of business the carrier offers.

When you first set up a carrier profile in CMS, you must identify the types of policies the carrier offers 

and enter carrier information on the corresponding policy type tab(s).

When a carrier offers these LOBs: Add the carrier to these policy type tabs:

 Personal or Commercial Auto,  Motorcycle, ATV/Snow-

mobile, Travel Trailer, RV, and any motorized vehicle 

with wheels.

Auto

Homeowners, Condo, Renters, Dwelling/Fire

(Some carriers include Earthquake and/or Flood in this 

group)

Home

Boat, Jet Ski, and any other watercraft Boat

Stand-alone Towing, Rental, and Lockout plans. MoPro

All commercial policy types as well as miscellaneous 

policy types, such as Flood, Earthquake, Personal 
Commercial/All Other
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When a carrier offers these LOBs: Add the carrier to these policy type tabs:

Umbrella, Inland Marine are set up on the Com-

mercial/All Other tab.

Detailed information for the following LOBs: 

Employee Benefits Setup

Umbrella Policies

Workers Compensation Classification Codes

Adding a Carrier

Completing carrier setup should be one of the first steps taken to successfully  implement your 

HawkSoft Client Management System. The information entered in Policy/Company Setup determines 

the default options available for each carrier when users insert  policies  in CMS.

Adding a Carrier

Inserting a Carrier Client File

Creating a carrier file in HawkSoft CMS enables you to store carrier information in addition 

to what is typically stored in Policy/Company Setup, such as additional contacts, phone 

numbers, e-mail addresses, commission statements, and underwriting guidelines. 

Inserting a New Carrier Client File

Policy/Company Setup Shortcuts

HawkSoft CMS provides two shortcut methods for entering a new carrier or updating a car-

rier based on existing information in Policy/Company Setup. 

Policy/Company Setup Shortcuts

Carrier Setup Templates

HawkSoft CMS enables you to create carrier templates for each type of policy. You can 

use these templates to simplify the process of adding new carriers to CMS when setting up 

multiple carriers with identical policy information and coverages. The template is then 

copied and modified to add information that is unique to each carrier.

Carrier Setup Templates

#Employee%20Benefits%20Setup%20[+%20Video]
#Umbrella%20Policies


3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 101

Setting Up a General Agency with Multiple Issuing Carriers

HawkSoft CMS  enables you to easily configure carriers, general agencies, or brokerages 

with multiple issuing carriers. In these instances, it's important to know which parent com-

pany or brokerage the policy is written through, as well as the actual carrier that is under-

writing the risk.

Configuring  Multiple Issuing Carriers

Printing a Carrier Contact Information List

From Policy/Company Setup, you can print a list of your agency's carriers by policy type, 

including addresses and phone numbers. This can be helpful when maintaining your com-

pany setup, such as searching for duplicate companies, checking for name format con-

sistency, etc.

Printing a Carrier Contact Information List

Editing Carrier Information

Changes to carrier contact information, coverages, limits and deductibles,  agent codes, and com-

mission information need to be updated in Policy/Company Setup to keep client and policy files up-to-

date. This article explains how to make changes to existing carriers in Policy/Company Setup.

Editing Carrier Information

Policy/Company Setup Screens Overview

Policy/Company  Setup  is an important step  in the  implementation of your HawkSoft Client Man-

agement System.  Information for each of your carriers is  entered in Policy/Company Setup to enable 

you to accurately insert policies and integrate policy information with company websites. Setup  also 

ensures the accuracy of both Trust and Commission accounting transactions, and the detail available 

when reporting.

The information entered in Policy/Company Setup determines the default options available to users 

when inserting  policies in CMS.

This overview provides a list of help topics for each  of the screens available when setting up or modi-

fying a carrier.

Policy-Company Setup Screens Overview
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Deleting a Carrier

HawkSoft CMS enables you to delete a carrier from Policy/Company Setup. Deleting a carrier will per-

manently delete the selected carrier profile.

Deleting a Carrier

Adding a Carrier

Completing carrier setup should be one of the first steps taken to successfully  implement your 

HawkSoft Client Management System. The information entered in Policy/Company Setup determines 

the default options available for each carrier when users insert  policies  in CMS.

This article describes how to set up a profile for each of your carriers in CMS. A carrier profile includes:

 l Contact information

 l Web address (and options that affect how CMS interfaces with the carrier website)

 l Agent Codes

 l Policy information

 l Commission information (for agencies that use CMS to track commissions)

 l Coverage details

In this topic:

Keys to a Clean Company List Add a Carrier

This task is typically performed by an Owner/Administrator, Manager, or Bookkeeper.

 

Required Permissions:
In order to complete this task, user permissions must be set to include:

Accounting > Edit Carrier Commission Settings (for agencies using Commission 
Tracking)
Setup > Policy/Company Setup

See Setting User Permissions for more information.

#Keys_to_a_Clean_Company_List
#Add_a_Carrier
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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  Keys to a clean company list

In order to glean accurate information from reports, it is important that your companies are set up prop-

erly in Policy/Company Setup. For example, you may have the same company listed as Smith and 

Jones, Smith/Jones, and Smith & Jones in Policy/Company setup, and would like all the names to be 

consistent. Watch this video to learn how to use carrier reports in HawkSoft to determine which carriers 

need to be cleaned up, and how to correct the inconsistencies.

To add a  carrier

 1.  Click the   Settings icon, and then select Policy/Company Setup.

The Policy/Company Setup dialog opens.

 2.  Select one of the available tabs to set up information for each type of policy written with the car-

rier.

To add the same carrier information to more than one type of policy, see Policy/Company Setup 

Shortcuts.

How do I know where to add a carrier?

When a carrier offers these LOBs:
Add the carrier to these policy type 

tabs:

 Personal or Commercial Auto,  Motorcycle, 

ATV/Snowmobile, Travel Trailer, RV, and any 

motorized vehicle with wheels.

Auto

Homeowners, Condo, Renters, Dwelling/Fire

(Some carriers include Earthquake and/or Flood in 

this group)

Home

Boat, Jet Ski, and any other watercraft Boat

Stand-alone Towing, Rental, and Lockout plans. MoPro

All commercial policy types as well as mis-

cellaneous policy types, such as Flood, Earth-
Commercial/All Other
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When a carrier offers these LOBs:
Add the carrier to these policy type 

tabs:

quake, Personal Umbrella, Inland Marine are set up 

on the Commercial/All Other tab.

Detailed information for the following LOBs: 

Employee Benefits Setup

Umbrella Policies

Workers Compensation Classification Codes

 3.  Select the State for which you are adding this carrier.

If the state you need to add a carrier to is not listed, you will need to 

add it.

 1.  Select Add State from the State drop-down.
The Add State dialog opens.

 2.  Select the state you want to add, and then click OK.

 4.  Click New.

The New Carrier dialog opens.

See Carrier Setup Templates to insert a carrier based on a saved template, 
or to create a new carrier template. Carrier templates are helpful when set-
ting up multiple carriers with identical policy information.

 5.  Complete the Policy/Company Setup screens.

Click the   at the top of any screen to access available help.

 6.   After completing all of the Policy/Company Setup screens, click Finish.

 7.  Optional: Repeat this process to set up additional types of policies for this carrier or additional 

carriers.

Use Policy/Company Setup Shortcuts to simplify the process of adding additional policies.

#Employee%20Benefits%20Setup%20[+%20Video]
#Umbrella%20Policies
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 8.  Click Close to exit Policy/Company Setup when setup is complete.

Users can now select this carrier when inserting a new policy or editing an existing policy.  These set-

tings also ensure that accurate options are available for Program, Policy Form, Agent Code, Term, 

Policy Title, Coverage Options, and Limits when this carrier is selected.

Related Topics
Policy/Company Setup Overview
Policy/Company Setup Shortcuts

Inserting a New Carrier Client File

Creating a carrier file in HawkSoft CMS enables you to store carrier information in addition to what is 

typically stored in Policy/Company Setup, such as additional contacts, phone numbers, e-mail 

addresses, commission statements, and underwriting guidelines. 

The Carrier Client file can be linked to from the Contact Information screen in Policy Company Setup 

for the same carrier. When linked, additional contact information entered in the Carrier Client file dis-

plays on the Contact Information screen in Policy Company Setup, as well as  the Company View dia-

log on the Client file. 

See Contact Information for linking instructions.

 Link from Carrier Information

In this topic:

Inserting a Carrier Client File from the Policy 

Company Setup

Inserting a Carrier Client File from the CMS 

Menu Bar

Required Permissions:
In order to complete this task, user permissions must be set to include:

File > Insert Client
Search and Client Access > Access to Client Types > Carrier

../../../../../Content/Policy-Company Setup/Policy-Company Setup Screens/Contact Information.htm
https://www.youtube.com/embed/08bgP-cihu0
#Inserting_a_Carrier_Client_File_from_Policy_Company_Setup
#Inserting_a_Carrier_Client_File_from_Policy_Company_Setup
#Inserting_a_Carrier_Client_File_fron_the_CMS_Menu_Bar
#Inserting_a_Carrier_Client_File_fron_the_CMS_Menu_Bar
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See Setting User Permissions for more information.

Inserting a Carrier Client file from Policy Company 

Setup
During the process of adding a new carrier in Policy Company Setup, you can create a Car-

rier Client file from the Contact Information screen and create a link to the  Carrier Client 

file.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Policy/Company Setup

See Setting User Permissions for more information.

 1.  Click the   Settings icon, and then select Policy/Company Setup.

 2.  Click New to add a new carrier.

See Adding a Carrier for detailed instructions. 

 3.  Complete the Contact Information screen, and then click the Link to Carrier Client 
File button.

The Search dialog opens.

 4.  Click Search, and then click the Insert New button. 

The Insert Policy dialog opens with the Name and Address side-tab selected.

 5.  Complete the relevant Name and Address information.

Certain fields on the Name and Address screen are not relevant to the "Carrier" Cli-

ent file type, such as Customer Type, Producer, CSR, and Source.

 6.  Check the Business check box to activate fields specific to business contacts.

 7.  Enter the Carrier’s Name.

 8.   Optional: Click Add under Contacts and Personal Profiles to open the Personal 
Profile dialog and enter contact information for specific individuals.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
Contact Information.htm
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To enter general contact information in addition to or rather than 
an individual profile, skip to Step 9.

 a.  Enter the Personal Profile information for your first contact with this carrier, 

such as your Underwriter, Marketing Representative, Customer Service 

Department, etc.

 b.  Select the contact's job title from the Occupation drop-down list.

 c.  Click Add under Contact Info to add  phone number, e-mail address, mobile 
phone number, etc. 

 d.  Click OK to save the Contact.

 e.  Click OK  to save and close the Personal Profile dialog.

 9.  Optional: Under Contact Info, you can add additional phone numbers, fax num-
bers, and email addresses without  setting up personal profiles as detailed above. 

Be sure to select < Link To Client (No Profile) > from the Profile drop-down.

Contact information will display on the Policy/GPI view screen 
when you click on the underlined Company link for linked Car-
rier Client files.

 10.  Complete the Mailing Address fields on the Name and Address screen. 

 11.  Enter the carrier's Website information.

 12.  Select the General Policy Information side-tab.

 13.  If your agency has multiple office locations, select the Office location from the avail-
able drop-down.

The Company field defaults to Prospect  and the Application Type field defaults to 
Other. The "other" Application Type creates a policy tab on the client/policy view 
screen to enable your agency to attach documents to the file.

 14.  Click Finish to save and close the Insert Policy dialog.

The Add Log Entry Comments dialog opens.

 15.  Add comments as needed, and then click OK.

Creating a Log Note.htm
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By default, a policy type called "Other" is created for the Carrier Client file. You can attach 

underwriting guides, company specific forms, and commission statements, etc. to the 

policy.

Inserting a Carrier Client file from the CMS menu bar
You can insert a Carrier Client file from the CMS menu bar, and then link to it from the car-

rier file in Policy/Company Setup. 

 1.  In CMS, click Client > Insert > All Other > New Carrier.

The Insert Policy dialog opens with the Name and Address side-tab selected.

Certain fields on the Name and Address screen are not relevant to the "Carrier" Cli-

ent file type, such as Customer Type, Producer, CSR, and Source. 

 2.  Check the Business check box to activate fields specific to business contacts.

 3.  Enter the Carrier’s Name.

 4.   Optional: Click Add under Contacts and Personal Profiles to open the Personal 
Profile dialog  and enter contact information for specific individuals.

To enter general contact information in addition to or rather than 
an individual profile, skip to Step 5.

 a.  Enter the Personal Profile information for your first contact with this carrier, 
such as your Underwriter, Marketing Representative, Customer Service 

Department, etc.

 b.  Select the contact's job title from the Occupation drop-down list.

 c.  Click Add under Contact Info to add the contact information such as phone 
number, e-mail address, mobile phone number, etc. 

 d.  Click OK to save the Contact.

 e.  Click OK  to save and close the Personal Profile dialog. 

 5.  Under Contact Info, you can add additional phone numbers, fax numbers, and 
email addresses without  setting up personal profiles as detailed above. Be sure to 

select < Link To Client (No Profile) > from the Profile drop-down.

#Importing%20and%20Attaching%20Documents%20to%20Clients%20and%20Policies
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Contact information will display on the Policy/GPI view screen 
when you click on the underlined Company link for linked Car-
rier Client files.

 6.  Complete the Mailing Address fields. 

 7.  Enter the carrier's Website information.

 8.  Click Finish to save and close the Insert Client Only dialog .

The Add Log Entry Comments dialog opens.

 9.  Add comments as needed, and then click OK.

By default, a policy type called "Other" is created for the Carrier Client file. You can attach 

underwriting guides, company specific forms, and commission statements, etc.

Related Topics             
Policy/Company Setup: Company Info
Policy/Company Setup Overview

Carrier Setup Templates

HawkSoft CMS enables you to create carrier templates for each type of policy. You can use these tem-

plates to simplify the process of adding new carriers to CMS when setting up multiple carriers with 

identical policy information and coverages. The template is then copied and modified to add inform-

ation that is unique to each carrier.

In this topic:

Creating a Carrier Template Using a Carrier Template

The Commercial/All Other tab contains templates available for you to modify for car-
riers with Commercial lines of business.

See Policy/Company Setup Shortcuts for instructions on copying existing carrier profiles.

Creating a Log Note.htm
#Importing%20and%20Attaching%20Documents%20to%20Clients%20and%20Policies
../../../../../Content/Policy-Company Setup/Policy-Company Setup Screens/Company Info.htm
#Creating_a_Carrier_Template
#Using_a_Carrier_Template
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This task is typically performed by an Owner/Administrator, Manager, or Bookkeeper.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Policy/Company Setup

See Setting User Permissions for more information.

How do I get here?

Click the   Settings icon, and then select Policy/Company Setup.

The Policy/Company Setup dialog opens.

Creating a carrier template
Before creating your first template, add all states you write policies in.

If the state you need to add a carrier to is not listed, you will 

need to add it.

 1.  Select Add State from the State drop-down.
The Add State dialog opens.

 2.  Select the state you want to add, and then click 
OK.

 1.  Select one of the available tabs to set up information for policies your agency writes. 

You will repeat these steps to create a carrier template for each type of policy your 

agency writes.

How do I know where to add a carrier?

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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When a carrier offers these LOBs:
Add the carrier to these policy 

type tabs:

 Personal or Commercial Auto,  Motorcycle, 

ATV/Snowmobile, Travel Trailer, RV, and 

any motorized vehicle with wheels.

Auto

Homeowners, Condo, Renters, 

Dwelling/Fire

(Some carriers include Earthquake and/or 

Flood in this group)

Home

Boat, Jet Ski, and any other watercraft Boat

Stand-alone Towing, Rental, and Lockout 

plans.
MoPro

All commercial policy types as well as mis-

cellaneous policy types, such as Flood, 

Earthquake, Personal Umbrella, Inland Mar-

ine are set up on the Commercial/All Other 

tab.

Detailed information for the following LOBs: 

Employee Benefits Setup

Umbrella Policies

Workers Compensation Classification 

Codes

Commercial/All Other

 2.  Select one of the states to create a template for.

The State can be easily changed each time you select this template to add carriers 

in other states.

 3.  Click New.

The New Carrier dialog opens.

#Employee%20Benefits%20Setup%20[+%20Video]
#Umbrella%20Policies
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 4.  Enter <Template> in the Unique Name field. 

 5.  Leave the remaining fields on this screen blank. 

The information on this screen  varies for each carrier. 

 6.  Skip the Agent Codes and Company Website screens.

The information on these screens are specific for each carrier.

 7.  Select the Policy Info tab.

 8.  Complete the following policy information for your carrier template:

Policy Titles
CMS creates a title for the tabs on the Client/Policy bar in the client file.

CMS automatically determines the policy title when a policy is added 

with one or more LOBs. Leave the Policy Titles field on the Policy Info 

screen blank to always use the CMS titles.

 l CMS creates a policy title for monoline policies according to the 

line of business code provided by ACORD.

 l When multiple LOBs are packaged together, the policy title is set 

according to the package Application Type.

These titles are derived from the line of business 
codes provided by ACORD. To help maintain con-
sistency, use the policy title set by CMS whenever 
possible.

See the ACORD Line of Business List CMS uses to 
determine  policy titles.

../../../../../Content/Policy-Company Setup/Policy-Company Setup Screens/ACORD LOB List.htm
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Create a Custom Policy Title

When the policy title, determined by CMS, does not 

adequately describe the policy, CMS enables you to create 

customized policy tab titles.

Follow on-screen prompts to Edit, Add, or Remove a 
policy title.

 l Policy Titles are limited to 10 char-

acters or less.

 l For reporting purposes, maintaining 

consistency in creating policy titles is 

important.

For example:

"Renters" does not exist as an LOB. Renters insurance is 

written using the LOB "Homeowners" and the Policy Form 

"HO4". Use the Policy Info screen to add "Renters" as an 

available policy title on the General Policy Information 

screen when inserting a renters policy.

The Policy Detail section of the General Policy Information 

screen for the above example looks like this:
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Receipts: Payee  
Select Unique Name, Formal Name, or Program to determine the 

default payee for your agency checks written to this carrier.

Policy Forms  
 CMS provides a default list of policy forms for each type of policy, and 

additional forms are available when you click Add. Use the Edit, Add, 
and Remove buttons to modify the default list.

Terms 
 CMS provides default terms. Use the Edit, Add, and Remove buttons 
to modify the default list.

 9.  Click Next  to skip to the Coverages screen.  

 10.  Complete the Coverages screen if your agency offers the same coverages for mul-
tiple carriers. 

Coverage information is the most helpful to include in your template 

and will save you time when adding carriers for the same type of policy.
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Modify the coverages, as well as  the limits and deductibles to include 

the coverages your agency most often uses.

Click the   at the top of any screen to access available help.

 11.  Click Finish and then Close when your carrier information is set up.

Using a carrier template

 1.  Select the template created for the type of policy you are setting up for your carrier.

 2.  Click Copy To, and then select the Type of policy and the State you are setting up a 
new carrier for.

 3.  Click OK.

 4.  The <Template> is now listed as a carrier for the selected state.

If you have copied the template to the same state that the template was originally 

created for, you will see  <Template>(Copy) in the list of carriers. 

 5.  Select the copied template, and then click Edit. 

The Edit Carrier dialog opens. 

 6.  Replace <Template> in the Unique Name field with the carrier name. 

 7.  Complete the company information for the carrier, and then click Next.

 A warning appears asking you to confirm the Unique Name change from Template 

to the carrier name. 

 8.  Click OK to accept the new Unique Name.

 9.  Continue to complete the policy and company information that was not included in 

the template, or may need to be edited for this carrier.

Click the   at the top of any screen to access available help.

 10.  Click Finish and then Close when your carrier information is set up.

Related Topics
Adding a Carrier
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Configuring  Multiple Issuing Carriers

Policy/Company Setup Shortcuts

 HawkSoft CMS provides two shortcut methods for entering a new carrier or updating a carrier based 

on existing information in Policy/Company Setup. 

 l The Copy To option enables you to copy a carrier profile from one  type of policy and/or state to 

another.  

 l The Copy/Paste Special method enables you to copy  specific carrier details from one carrier to 

another.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Policy/Company Setup

See Setting User Permissions for more information.

In this topic:

Using the Copy-to-Feature to Duplicate Car-

rier Information

Using the Copy/Paste Special to Modify Car-

rier Information

See Carrier Setup Templates to insert a carrier based on a saved template, or to 
create a carrier template. Carrier templates are helpful when setting up multiple car-
riers with identical policy information and coverages.

This task is typically performed by an Owner/Administrator, Manager, or Bookkeeper.

Using the Copy To feature to duplicate carrier inform-

ation
When you need to add a company  to  more than one type of policy, and/or more than one 

state in Policy/Company Setup, you can copy and paste the carrier profile  using the Copy 
To button.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
#CopyTo
#CopyTo
#Using_Copy_Paste_Special_to_Modify_Carrier_Information
#Using_Copy_Paste_Special_to_Modify_Carrier_Information
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Before copying carrier information, verify that the appropriate state is 
available for the  policy type you are copying to. See Adding a Carrier 
for instructions on adding a state to a policy type.

 1.  Cilck the   Settingsicon, and then select Policy/Company Setup.

 2.  Select the tab with the appropriate type of policy, and then select the State.

 3.  Select the company you want to copy.

 4.  Click Copy To.

 5.  Select the type of policy and state, to copy to.

 6.  Click OK.

The company name appears on the selected state and policy tab.

 7.  Highlight the copy, and then click Edit. 

 8.  Modify the Unique Name, and then make additional changes to the carrier inform-
ation on each of the Policy/Company Setup Screens, as needed.

Click the   at the top of any screen to access available help.

When you copy and paste from one type of policy to another, it is 
important to pay special attention to the Company Info, 
Contact Information, Policy Info, and Coverages tabs.

Email addresses, phone numbers, policy titles, programs, terms, 
policy types, and Coverages may vary between each base 
policy type.

 9.  Click Finish when copying and editing carrier information is complete.

 10.  Click Close to exit the Policy/Company Setup dialog. 

Using Copy/Paste Special to modify carrier information
Use the Copy/Paste Special method to copy specific information from one carrier, and 
then paste the information to another carrier profile.
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Example: Once you set up Coverage defaults on one of your carriers, you can use the 
Copy/Paste Special method to copy only the limits from the first carrier  to a different car-

rier.

 1.   Cilck the   Settingsicon, and then select Policy/Company Setup.

 2.  Select the tab with the appropriate type of policy, and then select the State.

 3.  Right-click the carrier name in the Policy/Company Setup dialog, and then select 
Copy.

 4.  Navigate to the carrier you want to copy information to.

 5.  Right-click on the carrier name you want to update, and then select Paste Special.

The Paste Special dialog opens.

 6.  Check the items that you want to copy  to the selected carrier.

 7.   Click OK.

 8.  Repeat steps 2-6 with additional carriers as needed.

 9.  Click Close when edits are complete.

Related Topics
Policy/Company Setup Overview

Policy-Company Setup Screens Overview

Policy/Company  Setup  is an important step  in the  implementation of your HawkSoft Client Man-

agement System.  Information for each of your carriers is  entered in Policy/Company Setup to enable 

you to accurately insert policies and integrate policy information with company websites. Setup  also 

ensures the accuracy of both Trust and Commission accounting transactions, and the detail available 

when reporting.

The information entered in Policy/Company Setup determines the default options available to users 

when inserting  policies in CMS.

The articles listed below, describe each of the screens available when setting up or modifying a carrier.

See Adding a Carrier and Editing Carrier Information for instructions.
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In addition to the help topics listed below, each Policy/Company Setup screen 
provides on screen help information.  Click the   at the top of any screen to access 
available help. 

Company Info
The Company Info screen enables you to enter the carrier names, address, and any notes you want 
to enter for the company. You can also create a link to a website, program, or file saved on your com-

puter, such as a  company rating tool or underwriting document.

Policy/Company Setup: Company Info

Contact Information
The Contact Information screen enables you to enter contact information for the carrier, such as cus-

tomer service, underwriting, and claims phone numbers, as well as the carrier's default email address.

From this screen, you can also  link the carrier to a "Carrier Client file" in CMS.  The purpose of a  Carrier 

Client file is to store carrier information in addition to what is typically stored in Policy/Company Setup, 

such as   additional contacts, phone numbers, e-mail addresses, commission statements, and under-

writing guidelines. 

Policy/Company Setup: Contact Information

Agent Codes
The Agent Codes screen enables you  to enter the Agent  (Agency)/Producer codes that are assigned 

by each carrier.  

Once they are set up, codes are available for selection from the Agent Code drop-down on the General 

Policy Information screen when  inserting  or editing a policy insured with this carrier.

When CMS is configured to map Agent (Agency) Codes for multiple agencies, you 
can choose to associate each code with a specific office.  See .

Policy/Company Setup: Agent Codes

../../../../../Content/Policy-Company Setup/Policy-Company Setup Screens/Company Info.htm
../../../../../Content/Policy-Company Setup/Policy-Company Setup Screens/Contact Information.htm
../../../../../Content/Policy-Company Setup/Policy-Company Setup Screens/Agent Codes.htm
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Company Website
The information entered in the Company Website screen determines how HawkSoft CMS integrates 

with the carrier’s website when the website is launched by clicking the   website button found on 

the main CMS toolbar, or when Inquiry/Website or Quote/Export is selected in the CMS Action Menu.

Policy/Company Setup: Company Website

Policy Info
The  Policy Information screen enables you to customize  some of the options  available on the General 

Policy Information screen, Report Layout options, and how the carrier name appears on several doc-

uments generated through CMS.

Policy/Company Setup:  Policy Info

Commissions
Setting up the Commission screen during Policy/Company Setup is critical for agencies that are using 

HawkSoft CMS to track commissions. The information you enter on this screen determines the basis 

(Agency Bill, Premium Paid, Premium Written, or Flat Fee) and percentage (or dollar amount for Flat 

Fee) for new and renewal business.

This screen is also used to indicate whether commission statements will be received via downloads, in 

which case, CMS is not used to calculate agency commissions.

Policy/Company Setup: Commissions

Lines of Business/Coverages
This screen includes Lines of Business (LOBs) and customizable lists of coverages, limits, and deduct-

ibles for a company. The fields available within this screen vary by the type of policy. 

Auto Coverages

Boat Coverages

Commercial/"All Other" Lines of Business Coverages

Home Coverages 

../../../../../Content/Getting Started/Action Menu.htm
../../../../../Content/Policy-Company Setup/Policy-Company Setup Screens/Company Website.htm
../../../../../Content/Policy-Company Setup/Policy-Company Setup Screens/Policy Information.htm
../../../../../Content/Policy-Company Setup/Policy-Company Setup Screens/PCSUCommissions.htm
Auto Coverages.htm
Boat Coverages.htm
Commercial-All Other Coverages.htm
Home Coverages.htm
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Motorist Protection (MoPro) Plan/Coverages/Fees

Configuring  Multiple Issuing Carriers

HawkSoft CMS  enables you to easily configure carriers, general agencies, or brokerages with multiple 

issuing carriers. In these instances, it's important to know which parent company or brokerage the 

policy is written through, as well as the actual carrier that is underwriting the risk.

This article describes how to set up a brokerage or parent company that writes policies under multiple 

carriers.

This task is typically performed by an Owner/Administrator, Manager, or Bookkeeper.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Policy/Company Setup

See Setting User Permissions for more information.

How do I get here?

 1.  Click the   Settings icon, and then select Policy/Company Setup.

The Policy/Company Setup dialog opens.

 2.  Select the type of policy (Auto, Home, Boat, MoPro, or Commercial/All Other).

 3.  Select the State for the carrier. 

 4.  Click New to add a new carrier

OR

Select the carrier from the list, and then click Edit.

Setting up a General Agency with multiple issuing 

carriers
 Set up each company using the instructions and steps for Adding a Carrier with the fol-

lowing exceptions on the  Policy Info screen:

Mopro Plan, Coverages, and Fees.htm
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 1.  Select the Policy Info side-tab.

 2.  In the Programs section, check the Use Program as Formal Name box. 

 3.  Click Add, and then insert the issuing carrier name that you will access through this 
parent company, general agency, or brokerage.

 4.  In the Receipts section, select Unique Name from the Payee drop-down, if the 
receipted premium is payable to the General Agency instead of the issuing carrier.

 5.  Complete the remaining fields on the Policy Information screen, as well as remain-

ing Policy/Company Setup Screens.

 6.  Click Finish when setup is complete.

 7.  Repeat this procedure for each of the issuing carriers for this parent company, gen-

eral agency, or brokerage.

The issuing carriers have now been added to the list of Programs.  When adding or modi-

fying a policy, the Company field displays the name of the general agency/brokerage and 

the Program field displays the name of the issuing carrier.  The item listed in the Program 

field appears as the issuing carrier on all documentation (ACORD forms, ID cards, etc.).

Related Topics
Adding a Carrier
Editing Carrier Information
Policy/Company Setup Overview

Printing a Carrier Contact Information List

From Policy/Company Setup, you can print a list of your agency's carriers by policy type, including 

addresses and phone numbers. This can be helpful when maintaining your company setup, such as 

searching for duplicate companies, checking for name format consistency, etc. 

This task is typically performed by an Owner/Administrator, Manager, or Bookkeeper.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Policy/Company Setup
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See Setting User Permissions for more information.

To print company contact information list

 1.  Cilck the   Settingsicon, and then select Policy/Company Setup.

 2.  Click on the appropriate policy type tab and select the appropriate State.

 3.  Click Print.

The Print dialog box opens.

 4.  Select a Printer, Page Range, and Number of copies, as needed.

 5.  Click Print to print the company contact information list.

Related Topics
Policy/Company Setup Overview

Additional/Other Interests/Certificate Holder Database

The Additional/Other Interests/Certificate Holder Database is a centralized database of common Loss 

Payees, Mortgagees, Additional Interests, and Certificate Holders that enables users to easily select a 

database item when inserting or editing policies.

In this topic:

Setting Up the Additional 

Interest Database

Modifying an Entry in the 

Database

Deleting an Entry from the 

Database

Printing the Database Accessing the Database  

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Additional/Other Interest/Certificate Holder Database

See Setting User Permissions for more information.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
#Setting_Up_an_Additional_Interest_Database
#Setting_Up_an_Additional_Interest_Database
#Modifying_an_Entry_in_the_Database
#Modifying_an_Entry_in_the_Database
#Deleting_an_Entry_from_the_Database
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#Printing_the_Database
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../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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Setting up the Additional Interest database 
Add  Additional Interests and their contact information to the database on this dialog. Users 

can easily search the database when adding an Additional Interest to the policy.

 1.  Click the   Settings icon, and then select  Additional/Other Interest/Certificate 

Holders Database from the main CMS menu bar.

The Additional/Other Interests - Setup dialog opens.

 2.  Click New to add an Additional Interest to the database.

The Add/Edit Additional Interest List dialog opens.

Modifying the Additional Interest list

Type – Select  the type(s) of additional interest. The type can be used as a filter 
when searching for Additional Interests.

 l Loss Payee

 l Mortgagee

 l Additional Interest

 l Certificate Holder

Name and Address Information – for the Additional Interest.

Complete the Zip field to auto-fill the City, State, and County 
fields.

Contact Information – for the Additional Interest.

Double-click on Email, Fax, or Phone to open the Edit Contact 
Information dialog for the selected Contact Type.

Complete the contact information as needed, and then click OK.

Notes – Include additional information for the Additional Interest in the Notes field, 
as needed.
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Click OK to save the new entry to the database.

 3.  Click Close when Additional Interest setup is complete. 

The new entry is now available from the Additional/Other Interests  database when 
adding a certificate or an Additional Interest to a policy.

Modifying an entry in the database

 1.  Click the   Settings icon, and then select  Additional/Other Interest/Certificate 

Holders Database from the main CMS menu bar.

The Additional/Other Interests - Setup dialog opens.

 2.  Select the Additional Interest to be modified from the list, and then click Edit.

 l Enter the name of the Additional Interest in the Filter field to speed up your 
search. 

OR

 l Scroll through the list to find the Additional Interest you want to modify.

The Add/Edit Additional Interest List dialog opens with the contact inform-
ation for the selected Additional Interest.  

 3.   Modify as needed, and then click OK.

 4.  Click Close when changes are complete. 

Deleting an entry from the database

 1.  Click the   Settings icon, and then select  Additional/Other Interest/Certificate 

Holders Database from the main CMS menu bar.

The Additional/Other Interests - Setup dialog box opens.
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 2.  Select the Additional Interest to be removed from the list, and then click Delete.

 l Enter the name of the Additional Interest in the Filter field to speed up your 
search. 

OR

 l Scroll through the list to find the Additional Interest.

The Additional Interest is removed from the database.

Printing the database

 1.  Select the Additional Interest type from the Filter from the drop-down list.     

 l All

 l Loss Payee

 l Mortgagee

 l Additional Interest

 l Certificate Holder

 2.  Click Print to print the database for the selected Additional Interest type.

Accessing the database
The Additional/Other Interests/Certificate Holder Database can be accessed from the AI 
Lookup button when adding Additional Interests to a policy or certificate. 

Please see Additional Interests for Auto, Boat, and Home Policies and Additional Interest 

on a Commercial Policy for more information on using the database to apply an Additional 

Interest.

Related Topics
Additional Interest on a Commercial Policy
Additional Interests for Auto, Boat, and Home Policies
Certificate of Liability Insurance Overview
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Editing Carrier Information

The information entered in HawkSoft CMS for each carrier determines the default options available for 

each carrier when users edit or insert  policies. 

Changes to carrier contact information, coverages, limits and deductibles,  agent codes, and com-

mission information need to be updated in Policy/Company Setup to keep client and policy files up-to-

date. This article explains how to make changes to existing carriers in Policy/Company Setup.

This task is typically performed by an Owner/Administrator, Manager, or Bookkeeper.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Policy/Company Setup
Accounting > Edit Carrier Commission Settings (for agencies using Commission 
Tracking)

See Setting User Permissions for more information.

In order to glean accurate information from reports, it is important that your companies are set up prop-

erly in Policy/Company Setup. For example, you may have the same company listed as Smith and 

Jones, Smith/Jones, and Smith & Jones in Policy/Company setup, and would like all the names to be 

consistent. Watch this video to learn how to use carrier reports in HawkSoft to determine which carriers 

need to be cleaned up, and how to correct the inconsistencies.

To edit carrier information

 1.  Cilck the   Settingsicon, and then select Policy/Company Setup.

 2.  Click on the appropriate type of policy tab, and then select the appropriate State.

 3.  Select the name of the company, and then click Edit.

The Edit Carrier Information dialog opens.

 4.  Make corrections on the Policy/Company Setup Screens, as needed.

Click the   at the top of any screen to access available help.

 After completing all of the Policy/Company Setup screens, click Finish.

Modify additional carriers, or click Close to exit Policy/Company Setup.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm


3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 128

Related Topics
Adding a Carrier
Policy/Company Setup Overview
Policy-Company Setup Screens Overview

Deleting a Carrier

HawkSoft CMS enables you to delete a carrier from Policy/Company Setup. Deleting a carrier will per-

manently delete the selected carrier profile. This causes invalid company names in any policies asso-

ciated with the deleted carrier. See Search and Replace for information on updating invalid company 

names in the database.

In this topic:

Change an Existing Carrier to Inactive Delete a Carrier

HawkSoft, Inc. recommends that you set carrier status to Inactive, rather than 
delete those carriers. Changing carrier status to inactive prevents users from insert-
ing a new policy with this carrier, but retains the carrier information and con-
figuration settings for existing policies with this carrier. Setting carrier status to 
inactive also makes it easier to re-activate the company in the event you start writ-
ing with the company again in the future.

See Policy/Company Setup: Company Info for more information on setting carrier 
status to inactive or to reactivate a carrier.

This task is typically performed by an Owner/Administrator, Manager, or Bookkeeper.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Policy/Company Setup

See Setting User Permissions for more information.

#Search%20and%20Replace
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To change an existing carrier to inactive

 1.  Cilck the   Settingsicon, and then select Policy/Company Setup.

 2.  Click on the appropriate type of  policy tab, and then select the appropriate State.

 3.  Highlight the name of the company, and then click Edit. 

 4.  With the Company Info side-tab selected, select the Company is inactive check 
box. 

To reactivate a carrier
In the event you start writing with this company again in the future, uncheck 

the Company is inactive check box to re-activate the company. 

 1.  Cilck the   Settingsicon, and then select Policy/Company Setup.

 2.  Click on the appropriate type of  policy tab, and then select the appro-

priate State.

 3.  Select the Show Inactive Items check box.

 4.  Highlight the name of the company, and then click Edit. 

 5.  With the Company Info side-tab selected, uncheck the Company is 
inactive check box. 

 6.  Optional: Select the Company Website side-tab, and then check the 
Quote check box to include the carrier in the Bridge To... dialog when 
Quote/Export is selected from the Action menu. 

This enables you to send quote information to applicable carrier web-

sites.

To delete a carrier

 1.  Cilck the   Settingsicon, and then select Policy/Company Setup.

 2.  Click on the appropriate type of  policy tab, and then select the appropriate State.

 3.  Highlight the name of the company, and then click Delete. 

 4.  Type Yes to confirm, and then click OK.
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The carrier is no longer available from the list. If your agency has policies associated with 

the deleted carrier, users will receive the Invalid Client Policy Data error message when a 

policy with that company needs to be updated.

Related Topics
Editing Carrier Information
Policy/Company Setup: Company Info

Sales Pipeline Configuration

HawkSoft supports your agency's Sales Pipeline to help you track and report on your prospects to 

make sure your new policies move through the process from discovery to sold. It is important to con-

figure HawkSoft to use the Sales Pipeline correctly, for accurate reporting.

See About The Sales Pipeline for more information.

In this topic:

Set Defaults for New Prospects Customize the Sales Pipeline Sub-Statuses

Set your defaults for new prospects

To encourage your agency to utilize the Sales Pipeline, configure your agency's General Settings to 

always default new policies to Prospect. 

 1.  Click the   Settings icon, and then select General Configuration.

The General Configuration dialog opens, with the General Settings side-tab preselected.

 2.  Select Default Status & Company to Prospect on New Policy.

 3.  Click OK.

../../../../../Content/Clients and Policies/Manage Client Policy Changes/Invalid Client Policy Data CSH.htm
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When this setting is selected, new  policies will automatically have the  Policy Status and  Company set 
to  Prospect. 

For commercial policies, make sure you have set up all of your lines of business 
under the Prospect Company in Policy Company Setup.

Customize the Sales Pipeline Sub-Statuses

The Sales Pipeline  policy statuses are  available when users insert a prospect policy and are intended 

to help track prospective business through the sales process. Users can further define the Sales 

Pipeline  by selecting a sub-status.

CMS has default sub-statuses associated with each Sales Pipeline status. 

 

HawkSoft's default Sales Pipeline statuses:

Status
Default Sub-

Status
Description

Lead  

Indicates  possible interest. 

Example: An existing client mentions they might be purchasing a 
vacation home. You can enter a new Home policy with a Status of 

Lead and follow up with the client at a later date.

  Unqualified
Client insurance needs are unknown.

Example: A list of leads in a residential zip code. 

  Qualified

Client insurance needs are known.

Example: A mortgage broker has sent a list of recent mortgage 
applicants.

Prospect  
The client is interested in receiving a quote. The policy has not been 

sold.

  Discovery
The agency is gathering information needed for underwriting and 

quoting.

  Submission The agency has submitted the application to its carriers for approval 

Prospects CSH.htm
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Status
Default Sub-

Status
Description

and/or quote.

Use Submission Tracking in CMS to track the 
status and details of the application. SeeTrack 
Submissions for more information.

  Quote A quote/offer has been extended to the client. 

  Proposal The agency has issued a formal insurance proposal to the client. 

Refused   The client declined the quote/proposal.

  Price The client declined due to price.

  Didn't Buy Risk  The client did not proceed with purchasing the item to be insured.

Rejected   The policy has been disqualified.

  U/W Rejected The Underwriter rejected the client's application.

 
Agency 
Disqualified

The policy doesn't meet the agency's standards.

To add and remove Sales Pipeline sub-statuses to the Action menu

You can modify or remove the default sub-statuses and add custom sub-statuses to meet your 

agency's needs.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Customize Lists

See Setting User Permissions for more information.

 1.  Click the   Settings icon, and then select Customize Lists.

 2.  Select Sales Pipeline Sub-Statuses and then click Edit.

 3.  Modify the list as needed.

#Track%20Submissions_..120
#Track%20Submissions_..120
Quotes CSH.htm
Refused CSH.htm
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 4.  Click OK to save.

You will see your saved sub-statuses next time you use the Action menu Sales Pipeline.

Related Topics

About The Sales Pipeline
Insert a Prospect: Sales Pipeline
Sales Pipeline Reports

Customize HawkSoft CMS

HawkSoft CMS offers a variety of ways to customize your management system to suit your agency's 

workflows, as well as options for customizing the look of the application.

This article gives an overview of all the options available for customizing HawkSoft CMS.

#About%20The%20Sales%20Pipeline
#Insert%20a%20Prospect:%20Sales%20Pipeline_..36
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Agency level

Agency Announcements

HawkSoft CMS enables you to create customized announcements on your 

Agency's Start Page. You might want to use the Announcement section to dis-

play agency news, company goals, and events for your staff. 

In addition to text, you can embed images and tables in the Announcement 

section.

CMS provides a template to help you get started  customizing your announce-

ments. 

This article provides instructions on activating, customizing, and deactivating 

Agency Announcements.

Agency Announcements

Agency Logo

HawkSoft CMS enables you to import your agency logo to be included on 

invoices generated by CMS, ACORD ID cards (other than state specific), cor-

respondence, and on your agency's CMS Start Page.

This article describes how to import your agency logo into CMS, configure the 

logo to display in CMS, and add to documents.

Agency Logo

Customizing the CMS Toolbar

The main toolbar in HawkSoft CMS contains several buttons which provide 

shortcuts to perform common transactions in CMS. You can customize the 

toolbar by adding  buttons to provide additional shortcuts for common tasks 

performed by your agency and you can remove buttons that your agency 

doesn't use. 

This article explains how to customize the toolbar by adding and removing but-

tons for Action menu related tasks. 

See Shortcuts to  External Tools [+ Video] to configure  button shortcuts  to web-

sites or programs (applications), such as a calculator tool or a real estate map-

ping website, etc.
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Customizing the CMS Toolbar

Client Miscellaneous Information

The HawkSoft CMS Client Miscellaneous Information (Client Misc Info) 

screen displays customized fields you can use to enter data not included in 

any of the standard fields found in the Edit Client/Policy dialog.

The information in most of these fields can be included in custom reports 

using Advanced Customized Reports.

The Client Misc Info screen appears blank until the fields are configured. See 

Setting Up Client Miscellaneous Information Fields for instructions on con-

figuring these fields.

The following article explains how to complete the Client Misc Info dialog after 

the fields have been set up.

Client Miscellaneous Information

User level

Font Customization

HawkSoft CMS allows you to edit the font type, style, size, and color of certain 

text categories, such as log text and data text.

This article provides instructions for changing HawkSoft CMS fonts.

NOTE: Font changes are applied only to your com-
puter and will not impact other workstations.

Font Customization

Application Theme

HawkSoft CMS includes themes to customize the look of the CMS applic-

ation.

#Advanced%20Customized%20Reports
#Client%20Miscellaneous%20Information
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This article provides instructions for changing your Application Theme, as well 

as examples of how each theme appears in CMS.

NOTE: Themes are applied only to your computer 
and will not impact other workstations.

Application Theme

Shortcuts to External Tools

Setting up an External Tool enables you to configure a shortcut that links to a 

website or program (application) of your choice. You can set these links to 

appear on the Tools menu, the Quick Launch panel, and/or the main CMS 

toolbar.

Shortcuts to  External Tools [+ Video]

Related Topics
User Setup Overview

Agency Announcements

HawkSoft CMS enables you to create customized announcements on your Agency's Start Page. You 

might want to use the Announcement section to display agency news, company goals, and events for 

your staff. 

In addition to text, you can embed images and tables in the Announcement section.

CMS provides a template to help you get started  customizing your announcements. 

This task is typically performed by an Owner/Administrator or Manager.
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In this topic:

Activate or Deactivate Agency Announcement 

on Start Page

Customize Agency Anouncements

The Agency Announcement section of the Start Page is active by default. To modify 
the Agency Announcement default template or to deactivate the Announcement 
section, you must have permissions to General Configuration.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > General Configuration

See Setting User Permissions for more information.

To activate or deactivate the Agency Announcement section on the Start Page

 1.  Click the   Settings icon, and then select General Configuration.

 2.  Select the Agency Announcements side-tab.

 3.  Check or uncheck Show Announcement on Start Page to include or exclude the Agency 
Announcement section.

 4.  Depending on your preference, you can uncheck Show Title Bar to remove the title bar from the 
Announcement section.

To customize your Agency Announcements

On the Start Page, hover your mouse over the top right corner of the Agency Announcement to see 

and click the Edit button. 

The Agency Announcement opens in the Editor. The available editing options work the same as 

Microsoft Word®. Click on the slides below for some helpful editing tips.

For best results, images should be under 1MB (1000KB).

Click on the slides below for some helpful editing tips. You may want to close the Table of Contents win-

dow when viewing the slides.

#Activate_or_Deactivate_Agency_Announcement_on_the_Start_Page
#Activate_or_Deactivate_Agency_Announcement_on_the_Start_Page
#Customize_Agency_Announcements
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Related Topics
General Agency Configuration 
General Settings

Agency Logo

HawkSoft CMS enables you to import your agency logo to be included on invoices generated by CMS, 

ACORD ID cards (other than state specific), correspondence, and on your agency's CMS Start Page.

This article describes how to import your agency logo into CMS, configure the logo to display in CMS, 

and add to documents.

In this topic:

Before You Login Import Your Agency Logo Display Agency Logo on 

Start Page

Add Agency Logo to Cor-

respondence Templates

 

Before you begin

To import your agency logo, you must first have your logo image saved on your computer or network. 

HawkSoft recommends saving your logo in one of the following image formats: PNG, JPEG, GIF, BMP, 

or TIF.

For best results, use an image with a resolution of 1150 x 280 pixels.

To insert a logo into an email, you must insert the image URL (address). When the email is received, 

the recipient's computer can access  the Internet and download the image via the URL. The logo will not 

display if the image is inserted  without a URL.

To import your agency logo

To import your agency logo, you must first have your logo image saved on your computer or network.  

HawkSoft recommends saving your logo in one of the following image formats: PNG, JPEG, GIF, BMP, 

or TIF.

For best results, use an image with a resolution of 1150 x 280 pixels.

#Before_You_Login
#Import_Your_Agency_Logo
#Display_Agency_Logo_on_Start_Page
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Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > General Configuration

See Setting User Permissions for more information.

For agencies with multiple offices, only one logo can be imported. 

 1.  Click the   Settings icon, and then select  General Configuration.

The General Settings dialog opens.

 2.  Click the Import button next to the Agency Logo field.

File Explorer opens.

 3.  Navigate to your agency logo file, and then click Open.

The ID Card Logo Import dialog opens, and displays your logo.

 4.  If the logo looks correct, click Finish.

OR

If the logo does not look correct, click Cancel, and then make sure your logo is saved correctly 
before importing.

 5.  Click OK. 

Your agency logo is imported into CMS, and you can opt to display the logo on the Start Page and/or 

documents. 

All  Invoices and Auto ID cards (other than state specific)  generated by CMS now 
automatically include your agency logo.

To display your agency logo on the Start Page

Once your logo is imported into CMS, you can display the logo on the Start page.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > General Configuration

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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See Setting User Permissions for more information.

 1.  Click the  Settings   icon, and then select General Configuration.

The General Settings dialog opens.

 2.  Check the Show Logo on Start Page box.

 3.  Click OK.

Your agency logo displays on the Start Page.

To add your agency logo to correspondence templates/correspondence

A logo image saved on your computer or network can be added to letters, memos, proposals, and cor-

respondence templates (for emails, see Email templates or Email, below). HawkSoft recommends sav-

ing your logo in one of the following image formats: PNG, JPEG, GIF, BMP, or TIF.

For best results, use an image with a resolution of 1150 x 280 pixels.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Correspondence Templates

See Setting User Permissions for more information.

Letters, memos, and proposals

How do I get here?

The CMS Letter Editor opens   when creating or editing correspondence templates/correspondence in 

CMS.  The following steps assume you are creating or modifying a correspondence template or  cor-

respondence and have the Letter Editor window open. 

For more information about creating and editing correspondence templates in CMS, see Cor-

respondence Setup Overview.

For more information about creating and editing correspondence in CMS, see Communications Over-

view.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 1.  Position your cursor in the CMS Letter Editor, and then click Insert > Picture.

The Windows ® Open dialog opens.

 2.  Browse to locate the image, and then click Open.

 3.  Click Save & Close when finished.

Your agency logo is inserted into the correspondence template/correspondence.

Email templates

To insert a logo into an email template, you must insert the image URL (address).   
When the email is received, the recipient's computer can access  the Internet and 
download the image via the URL. The logo will not display if the image is inserted  
without a URL.

 1.  Click the   Settings icon, and then select Correspondence Templates.

The Correspondence Templates dialog opens.

 2.  Select the Email side-tab.

 3.  Select your template from the list, and then click Edit, or click Add.

If you select Add, you are prompted to name your new template.

The Email Template Editor opens.

 4.  Position your cursor in the Email Template Editor, and then click Insert > Image.

The Image URL dialog opens.

 5.  Enter the image URL.

 6.  Click OK, and then click Save when finished.

Your agency logo is inserted into the template.

Email

How do I get here?

 During the process of sending an email, you can add your logo  in the CMS Email message window. 
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See Email for the different options and required permissions for sending an email.

Inserting an image into an email does not  insert the actual image. The image URL 
(address) is added to the email.  When the email is received, the computer must 
access  the Internet and download the image  into the email.  Images stored on a 
computer or internal intranet will not be seen by the email recipient.

Pasting images into  a CMS Email is not currently supported. 

For Outlook email users, you must modify the selected template before creating the 
email. If you need to modify an email outside of the template, you need to refer to 
Outlook's Help for options. These instructions only apply when creating an email 
using  the CMS New Message window.

 1.  With the Email message window open, position your cursor, and then click Insert > Image.

The Image URL dialog opens.

 2.  Enter the image URL.

 3.  Click OK.

Your agency logo is inserted into the email.

Related Topics
Auto ID Card
Communications Overview
Correspondence Setup Overview
General Settings
Modifying Correspondence Templates (Letters, Memos,  Proposals, and Policy Overview)
Modifying Email
Modifying Email  Templates

Customizing the CMS Toolbar

The main toolbar in HawkSoft CMS contains several buttons which provide shortcuts to perform com-

mon transactions in CMS. You can customize the toolbar by adding  buttons to provide additional short-

#Email
#Email_Templates
#Auto%20ID%20Card_..70
#Communications%20Overview
#Modifying%20Email
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cuts for common tasks performed by your agency and you can remove buttons that your agency 

doesn't use. 

This article explains how to customize the toolbar by adding and removing buttons for Action menu 

related tasks. 

See Shortcuts to  External Tools [+ Video] to configure  button shortcuts  to websites or programs (applic-

ations), such as a calculator tool or a real estate mapping website, etc.

 

In this topic:

Default Action Menu Toolbar Buttons Customize Action Menu Toolbar

Changes to the toolbar, which include Action menu shortcuts, are seen by all users 
in the agency and cannot be customized for an individual user. 

This task is typically performed by an Owner/Administrator, Manager, or Bookkeeper.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > General Configuration

See Setting User Permissions for more information.

Default Action menu toolbar buttons
The buttons below are included with the CMS installation. These buttons provide shortcuts for Action 

menu transactions and create a log note documenting the transaction. These buttons cannot be mod-

ified, however they can be removed and new buttons can be added. 

Default But-
ton

Action Menu Shortcut

Mail > From > Company > Change Policy Status > Cancel See Changing Policy 

Status for more information.

#Default_Action_Menu_Toolbar_Buttons
#Customize_Action_Menu_Toolbar_Options
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
../../../../../Content/Clients and Policies/Manage Client Policy Changes/Policy Status Changes/Change Policy Status.htm
../../../../../Content/Clients and Policies/Manage Client Policy Changes/Policy Status Changes/Change Policy Status.htm
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Default But-
ton

Action Menu Shortcut

Mail > From > Company > Change Policy Status > Issued See Changing Policy 

Status for more information.

Mail > From > Company > Change Policy Status > Reinstate Opens the Rein-

statement Date dialog. See Changing Policy Status for more information.

Mail > From > Company > Change Policy Status > Renew Opens the Renewal Date 

dialog and additional screens for modifying the policy. See Changing Policy Status for 

more information.

Mail > From > Company > Change Client/Policy

 Opens the Premium Change dialog. 

Mail > To > Insured > Print > Invoicing 

Opens the Invoices and Payments dialog .

Walk-in > From > Insured > Payment

Opens the Payment dialog box to create a receipt when the insured comes into the 

office. If there is an invoice with a balance due,   the Open Invoices dialog box opens 

enabling you to apply the payment to any open invoices.

Use the Action menu to document money received from a cus-
tomer in any other manner, such as Mail > From > Insured.

Internal > Accounting

Opens the Accounting menu.

To customize the Action Menu toolbar options

 1.  Click the   Settings  icon, and then select General Configuration from the main CMS menu 

bar.

 2.  Select  the Action Menu Customize Toolbar side-tab.

A table opens with a description of the icons currently on the toolbar.

../../../../../Content/Clients and Policies/Manage Client Policy Changes/Policy Status Changes/Change Policy Status.htm
../../../../../Content/Clients and Policies/Manage Client Policy Changes/Policy Status Changes/Change Policy Status.htm
../../../../../Content/Clients and Policies/Manage Client Policy Changes/Policy Status Changes/Change Policy Status.htm
../../../../../Content/Clients and Policies/Manage Client Policy Changes/Policy Status Changes/Change Policy Status.htm
#Invoicing%20Overview
#Payment%20and%20Receipting%20Overview
#Invoicing%20Overview
#Trust%20Accounting%20Overview*
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Policy Type – The types of policies the button can be used with

Hotkey – The keystrokes that launch the action

Action – The Action menu steps performed when using this button.

 3.  Customize the toolbar as needed. 

 Click to create a new toolbar item. 

 Select a previously added item, and then click Edit to make modifications. 
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 a.  Complete the  Setup dialog to create a new item or modify an existing item:

Button Title – The title appears below the icon image.

Tooltip –  Pop-up text that appears when a user hovers the mouse over the icon.

Help Text –  A brief description of the icon that appears below the Tooltip when a user hov-
ers over the icon.

Hotkey – CMS keystrokes that launch the action. The hotkey displays when a user hovers 
over the icon.

Policy Action Type – Types of policies this toolbar item is used for.

Action – Click the ellipsis   button to open the Action menu, and then select the actions 

this toolbar icon will perform when clicked.

Icon – Click Load Icon, and then select a Windows  image to display for this toolbar item.

 b.  Click OK.
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 Select a previously added item and then click Remove to delete the button from the 

toolbar.

 Click the  arrows to change the position of a selected    button.

 Click to insert a  separator to organize the buttons into sections.

Use the arrows to move the separator between two buttons.

 Click  to restore the toolbar to the CMS default items.

Custom icons will not be deleted when default items are restored.

 4.  Click OK when finished.

Related Topics
General Agency Configuration 
Shortcuts to  External Tools [+ Video]
Toolbar Icons

Setting Up Client Miscellaneous Information Fields

The HawkSoft CMS Client Miscellaneous Information (Client Misc Info) screen displays customized 

fields you can use to enter data not included in any of the standard fields found in the Edit Client/Policy 

dialog.

Once the Client Miscellaneous Information fields are set up, they are available on the Client Misc Info 
screen when inserting or modifying client information.

The data in most of these fields can be included in custom reports created using Advanced Reports.

Fields created in Client Miscellaneous Information setup are available in all client 
file types.

Example:

ABC Insurance Agency sends a yearly calendar to clients that fit the agency's "send cal-

endar" requirements (whatever these may be). The agency needs a reportable field to 

../../../../../Content/Getting Started/Toolbar Icons.htm
#Advanced%20Customized%20Reports


3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 148

determine how many calendars to order. ABC Insurance creates a miscellaneous client 

information field labeled Calendar, and selects the Y/N format. Now ABC Insurance can 

run a report at the end of the year based on the Yes or No answers.

This task is typically performed by an Owner/Administrator or Manager.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Client Misc. Info

See Setting User Permissions for more information.

To set up Client Miscellaneous Information fields

 1.  Click the   Settings icon, and then select  Client Misc. Info from the main CMS menu bar.

The Client Misc Info dialog displays fourteen customizable fields that can be included in the cli-
ent file.

 2.  Type a label to create a field.

Example: Preferred Language, Calendar, Mailing List, etc.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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Character limits for field labels:

 3.  Select a format from the drop-down list for each data type.

Data 
Format

User can enter or select:

None Data cannot be entered

Text Free form text

Currency  Dollar amount entries up to $9,999,999.99

Date XX/XX/XXXX

Number Numeric entry

Phone  (###) ###-####-#### 

Sex Female or Male

Y/N Yes or No

User 
Defined

customizable field label paired with a free-form input 

field with no format restrictions. Data entered in a 

user defined field is not available for reporting pur-

poses.
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Character limits for field data:

 4.  Click OK.

The fields appear on the Client Misc Info side-tab in the client file in the order they are 

entered on this setup screen.

Example: If you want a field labeled Primary Language to appear to the left of another field 

labeled Secondary Language, create the Primary Language field in the left-hand column 

and the Secondary Language field in the right-hand column.

Configure your list so that unused fields (those set to None) occur at 
the bottom of the list(s) so that empty spaces do not occur between 
available fields.
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The customized fields are now available on the Client Miscellaneous Information screen 

when inserting or modifying client information.

Related Topics
Client Miscellaneous Information
Clients Overview

Font Customization

HawkSoft CMS allows you to edit the font type, style, size, and color of certain text categories, such as 

log text and data text.

This article provides instructions for changing HawkSoft CMS fonts.

Font changes are applied only to your computer and will not impact other work-
stations.

To customize fonts

 1.  Click View from the main CMS menu bar, and then select Fonts.

The Setup Fonts dialog opens.

#Client%20Miscellaneous%20Information
#Client%20Miscellaneous%20Information
#Clients%20Overview
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 2.  Select a  Category:

Data Text

Changes the font for the client and policy data on the view screens.

Example:

The Data Text has been changed to a red Times New Roman font in the image below.

Prompt Text

Changes the font for the Data labels for the client and policy view screens.

Example:

The Prompt Text has been changed to a red Times New Roman font in the picture below.
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Log Text

Changes the font for the list of log notes in the client/policy. 

Changing the color of this font does not affect the color of the text inside a log 
note, suspended log notes, or log notes on policies other than the one cur-
rently selected.

Example:

The Font Text has been changed to a green Times New Roman font in the picture below.
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 3.  Click Modify. 

The Font dialog opens for you to customize the font for the selected Category. 

 4.  Click OK to save your changes.

 5.  Optional: Select another category to modify. 

 6.  Click OK to close the Setup Fonts dialog.

Your fonts are customized and saved to your profile.
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To reset fonts to default settings

 1.  Click View from the main CMS menu bar, and then select Fonts.

The Setup Fonts dialog opens.

 2.  Click Reset All.

 3.  Click OK.

All fonts have been reset to the default settings.

Related Topics
User Preferences
User Setup Overview

Application Theme

HawkSoft CMS includes themes to customize the look of the CMS application.

This article provides instructions for changing your Application Theme, as well as examples of how 

each theme appears in CMS.
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In this topic:

Change Your Application Theme Examples of Themes

Themes are applied only to your computer and will not impact other users.

Required Permissions:
To perform this task, no specific CMS user permissions are required. 

To change your Application Theme

 1.  Click View from the main CMS menu bar, and then select Application Theme.

The list of available themes appears.

 2.  Select the Light Blue, Dark Blue, or Dark theme.

The selected theme applies to all CMS windows on your workstation.

Examples of themes

Light Blue (Default)

#Change_Yuour_Application_Theme
#Examples_of_Themes
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Dark Blue
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Dark
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Related Topics
User Preferences
User Setup Overview
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Shortcuts to  External Tools [+ Video]

Setting up an External Tool enables you to configure a shortcut that links to a website or program 

(application) of your choice. You can set these links to appear on the Tools menu, the Quick Launch 

panel, and/or the main CMS toolbar.

External tools can launch applications only if the application is installed on the 
same computer CMS is running on.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Computer Specific Settings

See Setting User Permissions for more information.

In this topic:

Set up a website or program Additional button options 

To set up a website or program

 1.  Click the   Settings icon, and then select Computer Specific Settings from the 

main CMS menu bar.

The Computer Specific Settings dialog opens.

 2.  Click the External Tools tab.

 3.  Click New to set up a new external tool, and complete the following:

 l Tool Name – Name the external tool.

 l Tool Type – Select Program (application) or Website from the drop-down 
list.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
#To
#Addition
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 l Tooltip – Enter the tool name as you want it to appear when you hover your 
mouse over the toolbar icon.

 l Help Text – Enter a description of the tool. This can include the keyboard 
shortcut associated with the toolbar button.

This description appears as part of the Tooltip when you hover your mouse 

over the toolbar icon.

 l Command – Enter or browse to the program (application) path or website 
URL:

 o For a website, enter the URL

 o For a program, enter the path to the .exe file

See the following table for a list of common programs and commands:

Too-
l 

Na-
me

Co-
m-

ma-
nd

Ex-

cel

Ex-

cel

Out-

loo-

k

Ou-

tlo-

ok

Wo-

rd

Wi-

nw-

ord

Po-

wer-

Poi-

nt

Po-

we-

rpn-

t

Chr-

om-

Ch-

ro-
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Too-
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Na-
me
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ma-
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e me
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Ex-

plo-

rer

iex-

plo-

re

DS-

Pro

DS-

Pro

Pu-

blis-
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ms-

pu-

b

 l Arguments – Use to send command line arguments to the EXE. (Optional: 
Used only when the tool type is Program.)

 l Initial Directory – This field automatically defaults to the same path as the 
Command field. (Optional: Used only when the tool type is Program.)

 l Select Show on Tools Menu, Show on Quick Launch Panel, and/or Show 
on  Toolbar to designate where links to the tool appear.

 4.  Click Test to verify your setup.

Your program or website launches.

 5.  Click OK to save changes and return to the External Tools screen.

 6.  Click OK to close the Computer Specific Settings dialog.

A link to the new tool displays in CMS at the designated location.
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Additional button options on the External Tools screen

 l Edit – Highlight an item from the list, and then click Edit to modify.

 l Delete – Highlight an item from the list, and then click Delete to remove the link.

 l Arrows – Highlight an item from the list, and then click the Up or Down arrow to 
move the items up or down on the list.

 l Separator – Click to insert a dividing line that  displays between external tools you 
have designated to show on the main CMS toolbar. If selected, CMS adds a sep-

arator to the bottom of the external tools list, and then you can use the navigation 

arrows to place the separator.

Related Topics
Customizing the CMS Toolbar

Customize Lists Overview

HawkSoft CMS includes a variety of menu lists accessed from the Action menu and various drop-down 

menus throughout CMS. You can customize many of these lists to meet your agency's workflow and/or 

tracking purposes.

Customizing Lists

 This article describes how to customize the menu lists available from the Action menu and from sev-

eral drop-downs throughout CMS.

Customizing Lists

See the   Customized Lists video.

Cancellation Sub-Status Setup

HawkSoft CMS enables you to add additional sub-statuses to the Cancellation statuses available from 

the Action menu. 

The Cancellation statuses are intended to track policies that have been canceled. The sub-statuses 

associated with each Cancellation status are used to  further define the reasons for the cancellation.

Cancellation Sub-Status Setup

http://help.hawksoftinc.com/webhelp/trainingvideos/#Administrator Learning Path/Settings/Customized Lists.htm%3FTocPath%3DAdministrator%2520Learning%2520Path|Settings|_____1
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See the   Customizing Sub-Statuses video.

Sales Pipeline Sub-Status Setup

HawkSoft CMS enables you to modify Sales Pipeline sub-statuses  available from the Action menu. 

The Sales Pipeline  statuses are  intended to track prospective business through the sales process. You 

can further define the Sales Pipeline  by selecting a sub-status (reason).

CMS has default sub-statuses associated with each Sales Pipeline status. You can modify or remove 

the default sub-statuses and add custom sub-statuses to meet your agency's needs.

Sales Pipeline Configuration

See the   Customizing Sub-Statuses video.

Custom Client Tag Categories

Your agency can customize a list of available Tag Categories to choose from, and designate specific 

categories to display as a  pop-up notification.  When a user opens a client file that contains a pop-up 

Tag,  an alert displays until the user dismisses the Tag.

Custom Client Tags

Commercial Hazard Classifications and Class Codes Setup

HawkSoft CMS enables you to add commercial hazard classifications and class codes for certain Lines 

of Business (LOB), such as Commercial General Liability, Agricultural Liability, or Business Owners 

Liability. Use the Commercial Hazard Classifications dialog to enter or import a list of frequently 
used Classifications and Class Codes. 

When  adding a hazard to a policy, a Classification and Class Code Lookup button is available on the 

Add Hazard dialog for accessing the list of classifications entered on the Hazard Classifications dia-
log. 

Commercial Hazard Classifications and Class Codes Setup

Workers' Compensation Classification Codes

HawkSoft CMS enables you to create and track Workers' Compensation policies, including coverage 

and hazard information. Workers' Compensation  is included as a default line of business within Poli-

cy/Company Setup but can be customized to fit your business needs.

http://help.hawksoftinc.com/webhelp/trainingvideos/#Administrator Learning Path/Settings/Customizing Sub-Statuses.htm%3FTocPath%3DAdministrator%2520Learning%2520Path|Settings|_____2
http://help.hawksoftinc.com/webhelp/trainingvideos/#Administrator Learning Path/Settings/Customizing Sub-Statuses.htm%3FTocPath%3DAdministrator%2520Learning%2520Path|Settings|_____2
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Workers' Compensation Classification Codes

Customizing Lists

HawkSoft CMS includes a variety of menu and drop-down lists that provide options for managing your 

client files and policies.  This article describes how to customize the menu lists available from the Action 

menu and from several drop-downs throughout CMS.

This task is typically performed by an Owner/Administrator, Manager, or Bookkeeper.

In this topic:

Modifying a Menu List Customizable Menu List Descriptions

Creating Sub-Menus for Action Menu Lists Creating Keyboard Shortcuts

The following customized lists are unique. Please see the appropriate articles for 
customizing these lists: 

Cancellation Sub-Status Setup

Sales Pipeline Configuration

Client Tags [+video]

Commercial Hazard Classifications and Class Codes Setup

Workers' Compensation Classification Codes

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Customize Lists

See Setting User Permissions for more information.

#Modifying_a_Menu_List
#Cutomizable_Menu_List_Descriptions
#Creating_Sub-Menus_for_Action_Menu_Lists
#Creating_Keyboard_Shortcuts
#Client%20Tags%20[+video]
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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Modifying a menu list

 1.  Click the   Settings icon, and then select  Customize Lists from the main CMS 

menu bar.

The List Items Setup dialog opens. It contains a set of menu lists that can be 
edited. The Location column indicates where in CMS each of the lists are located. 

 2.  Highlight a menu to modify, and then click Edit. 

The Setup dialog for the selected menu opens with a list of menu items. 

Use the available buttons to make changes to the list. Different options are available 

on the Setup dialog, depending on your selection. 

New – Click to open the Add/Edit Item dialog. 

Enter the list item, and then click OK. 

Edit – Select an item from the list, and then click Edit to open the Add/Edit Item dia-

log.

Modify the name of the list item, and then click OK.

Delete – Select an item from the list, and then click Delete to remove the item from 
the list. 

Delete All – Select to remove all items from the list. 

Delete and Delete All are  immediate actions.

Defaults – Click to restore the list with all default items that may have been deleted. 

When you click Defaults, you are presented with two options:

 l Reset to Defaults – Reset the list to its default state (customized items will 
be deleted)

 OR

 l Load Defaults – Update the current list to make sure all default items are 
included (customized items will not be deleted).

#Menu_lists_that_can_be_customized
#Menu_lists_that_can_be_customized
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The Default button is not available for the following lists:

Cross-Sell/XDates

Suspense/ Log Note Templates

Types of Claims

 Use the  arrow buttons to organize the list according to your preferences.

 3.  Click Apply to save changes.

 4.  Click OK to close the Setup dialog when finished modifying a list.

 5.  Click Close when finished.

Customizable Menu List descriptions
The following table contains the customizable lists and a description of where each list is 

available in CMS.

Customizable Menu Lists Description

Communication Menus 

(Auto,  Home, Boat, MoPro, 

Commercial/All Other)

Communication lists contain common communication top-

ics related to  policies. This list is accessed from the Action 

menu.

 When you select an item from one of these lists, it 

becomes part of the log note record.

For example, if you have sent an email to a client request-

ing updated contact information, your log entry would 

appear as Email > To > Insured > Communication > 

Name/address.

Configure all policy Communication 
Menu Lists (Auto, Home, Boat, MoPro, 
Commercial/All Other)  to have the 
same options for consistency.

T-File Menus (Auto,  Home,  This list is available when  T-File is selected from the 

#Cross-Sell/XDates
../../../../../Content/Log Notes/Log Note Templates.htm
Action Menu.htm
Action Menu.htm
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Customizable Menu Lists Description

Boat, MoPro, Com-

mercial/All Other)

Action menu  with a policy selected. T-File (Transaction 

File) indicates a physical method of filing customer doc-

uments according to transaction date rather than client 

name.

These options are used to describe the                                 type of transaction 

that has been processed in CMS (for example Billing, Can-

cellation, etc.), and then filed using this method.

Configure all T-File policy Com-
munication Menu Lists (Auto, Home, 
Boat, MoPro, Commercial/All Other)  to 
have the same options for con-
sistency.

Action Menu From/To

Every transaction processed in CMS using the Action 

menu creates a log description of what prompted the trans-

action. For example, a transaction in response to a phone 

call from the insured, should be documented as Phone 

> From > Insured.                                 

This menu list contains descriptions of "who" prompted 

the transaction. This menu does not appear when pro-

cessing an "Internal" transaction.

Attachment Categories

Attachments can be organized by various criteria in the cli-

ent file, including Type, Category, and User. You can 

assign a category to an attachment when adding it to a cli-

ent file or when modifying an existing attachment. See                                       

Importing and Attaching Documents to Clients and 

Policies.

Attachment Descriptions

These options are available from the Attachment  Descrip-

tion drop-down list available when processing Unmatched 

Documents, scanning documents, or attaching doc-

uments to a client file. See                                   Importing and Attaching Docu-

Action Menu.htm
Action Menu.htm
Action Menu.htm
#Importing%20and%20Attaching%20Documents%20to%20Clients%20and%20Policies
#Importing%20and%20Attaching%20Documents%20to%20Clients%20and%20Policies
#Importing%20and%20Attaching%20Documents%20to%20Clients%20and%20Policies
#Importing%20and%20Attaching%20Documents%20to%20Clients%20and%20Policies
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Customizable Menu Lists Description

ments to Clients and Policies.

Cancellation Sub-Statuses

This list includes each of the Cancellation statuses and 

default sub-statuses available from the Action menu. You 

can add additional sub-statuses as needed. See Can-

cellation Sub-Status Setup for detailed instructions.

Client Tag Categories

You can add or modify tag categories as needed. This list 

is available when adding a Client Tag from the client view 

screen or when adding a log note. You can also set a cat-

egory to show a pop-up notification when you open a cli-

ent file. See Client Tags for detailed instructions.

Cross-Sell/XDate Items

These options are available in the Type of Insurance 

drop-down list that appears on the Edit - Cross-

Sell/XDates dialog when inserting or editing a client or 

policy.

Commercial Hazard Clas-

sifications

This  list includes liability hazard classifications and class 

codes. The full list is available when adding a hazard on 

certain types of commercial lines of business, for 

example, CGL and BOPGL. The entire list can be copied 

from the Internet and pasted into CMS. Individual entries 

can be added, edited, or deleted.

The Hazard Classification list is 
unique among the customizable lists 
in CMS. See Commercial Hazard Clas-
sifications and Class Codes Setup for 
more information.

Receipt For Items

This list includes payment items listed on the Payments 

dialog.

This list applies to Basic Receipts only and cannot be 

used with Enhanced Receipts.

#Importing%20and%20Attaching%20Documents%20to%20Clients%20and%20Policies
#Client%20Tags%20[+video]
#Cross-Sell/XDates
#Cross-Sell/XDates
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Customizable Menu Lists Description

See Basic Receipts and Enhanced Receipts for more 

information.

Sales Pipeline Sub-Statuses

This list includes each of the Sales Pipeline statuses and 

default sub-statuses available from the Action menu. You 

can customize  the  sub-statuses as needed. See Sales 

Pipeline Configuration for detailed instructions.

Sources

A list of sources  for marketing strategies used with new cli-

ents and/or new policies. This list is available from both 

the Name and Address screen and the General Policy 

Information screen. See Client Name and Address Inform-

ationor General Policy Information for more information.

Suspense Categories

A list of Categories available for assigning to a Sus-

pended Log. You can filter by Category when working 

your Suspense list. See Creating  a Log Note for more 

information. 

Suspense/Log Templates

A list of Log Note templates. Log note templates provide 

standardized language for log note and suspense descrip-

tions. This list of template options is available when you 
click the template icon   on the Add Log Entry Com-

ments dialog.

Types of Claims
A list of claim types available from the Type of Claim drop-

down list when adding or editing a claim on a policy. 

Workers' Compensation 

Classification Codes

This  list includes class codes specifically for Workers' 

Compensation. Any codes added to this list are available  

from the  Class Code field on the  ACORD 130 form. A list 

of class codes can be copied from an Excel spreadsheet 

and pasted into this custom list. 

The Workers' Compensation Clas-

#Basic%20Receipts%20and%20Enhanced%20Receipts
#Client%20Name%20and%20Address%20Information
#Client%20Name%20and%20Address%20Information
#General%20Policy%20Information
Accessing and Working with Suspenses.htm
../../../../../Content/Log Notes/Creating a Log Note.htm
Log Note Templates.htm
#Claims%20Information
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Customizable Menu Lists Description

sification Codes list is unique among 
the customizable lists in CMS. See 
Workers' Compensation Classification 
Codes for more information.

Creating  sub-menus for Action menu  lists
You can create a sub-menu for most  of the Action menu items. Providing sub-menus 

ensures that your log notes contain consistent documentation. See the Customizable 

Menu Lists table for a description of Action menu lists. 

The following Action menu lists are unique. Please see the appropriate 
articles for customizing these lists: 

Hazard Classifications and Class Codes Setup

Workers' Compensation Classification Codes

Cancellation Sub-Status Setup

Sales Pipeline Configuration

A sub-menu must contain a minimum of two items.

Example: For the Auto  Communication Menu, create a Missing Info 
sub-menu with, Valid Driver's License, Proof of prior, Proof of Good 
Student Discount, etc.

 1.  Click the   Settings icon, and then select  Customize Lists from the main CMS 

menu bar.

The List Items Setup dialog opens. It contains a fixed set of menu lists that can be 
edited.

 2.  Highlight an Action menu list item to modify, and then click Edit. 

#Menu_lists_that_can_be_customized
#Menu_lists_that_can_be_customized
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For our example,  choose Auto Communication Menu

The Setup dialog for the selected Action menu opens with a list of menu items. 

 3.  Click Edit to create a sub-menu based on an existing menu item. See example 

above.

The Add/Edit Item dialog opens.

 4.  Enter  a : and the sub-menu item. See example above.

 5.  Click OK to save.
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 6.  Select the new sub-menu item, and then click Edit.

. 

 7.  Press Ctrl-C on your keyboard to copy the sub-menu item to your clipboard, and 
then click Cancel.

 8.  Click New to create the next sub-menu item. 

The Add/Edit Item dialog opens.

 9.  Press Ctrl-V on your keyboard to paste the sub-menu item, and then edit the  sub-
menu. 
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 10.  Click Ok to save.

 11.  Continue to add additional sub-menu items as needed. For our example, add Proof 

of Good Student.

 12.  Click Apply when all sub-menu items have been added.

Your new sub-menu items are listed at the bottom of the menu 

list on the Setup dialog. You can use the   to rearrange 
items in the list. This will make editing the list easier in the future 
and will also determine the order of the sub-menu. 

 13.  Click OK to close the Setup dialog.

Based on our example, the next time Communication > Missing Info is selected 
from the Action Menu on an Auto policy, the following sub-menu will be available:

Creating keyboard shortcuts
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 Using keyboard shortcuts can improve user efficiency and productivity.  This functionality 

allows you to access list items with keyboard commands, rather than using your mouse.  

 1.  Click the   Settings icon, and then select  Customize Lists from the main CMS 

menu bar.

The List Items Setup dialog opens. It contains a fixed set of menu lists that can be 
edited.

 2.  Highlight a menu to modify, and then click Edit.

The Setup dialog for the selected menu opens with a list of menu items. 

List items that already have a shortcut set up are indicated with 
an underscore below the letter set as the shortcut.

 3.  Highlight the list item that you want to  add a shortcut to, and then click Edit.

The Add/Edit Item dialog opens.

 4.  Put your cursor in front of the letter in the word to be used as the shortcut, and then 

press Shift + 6.

You will see the ̂  character appear before the letter.

Example:  ̂ Driver

 This option can then be selected by pressing the D key, rather than using the 
mouse to select Driver from the list.

 5.  Click OK to close the Add/Edit Item dialog and save the shortcut.

 6.  Click Apply to save changes. 

 7.  Click  OK to save your changes and close the Setup dialog.

Related Topics 
Action Menu
Cross-Sell/XDates
Log Note Templates
 Processing Unmatched Documents

../../../../../Content/Getting Started/Action Menu.htm
#Cross-Sell/XDates
../../../../../Content/Log Notes/Log Note Templates.htm
#Processing%20Unmatched%20Documents_..118
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Scanning Documents 

Cancellation Sub-Status Setup

HawkSoft CMS enables you to add additional sub-statuses to the Cancellation statuses available from 

the Action menu. 

The Cancellation statuses are intended to track policies that have been canceled. The sub-statuses 

associated with each Cancellation status are used to  further define the reasons for the cancellation.

See Policy Status for more information about the Cancellation statuses and default sub-statuses.

This article explains how to add Cancellation sub-statuses to the Action menu.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Customize Lists

See Setting User Permissions for more information.

 1.  Click the   Settings icon, and then select Customize Lists.

 2.  Select Cancellation Sub-Statuses, and then click Edit.

 3.  Modify the list as needed.

#Scanning%20Documents
../../../../../Content/Clients and Policies/Manage Client Policy Changes/Policy Status Changes/Change Policy Status.htm
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 4.  Click OK to save.

You will see your saved sub-statuses next time you use the Action menu to cancel a policy.

Sales Pipeline Configuration

HawkSoft supports your agency's Sales Pipeline to help you track and report on your prospects to 

make sure your new policies move through the process from discovery to sold. It is important to con-

figure HawkSoft to use the Sales Pipeline correctly, for accurate reporting.

See About The Sales Pipeline for more information.

In this topic:

Set Defaults for New Prospects Customize the Sales Pipeline Sub-Statuses

#About%20The%20Sales%20Pipeline
#Set_Defaults_for_New_Prospects
#Customize_the_Sales_Pipeline_Sub-Statuses
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Set your defaults for new prospects

To encourage your agency to utilize the Sales Pipeline, configure your agency's General Settings to 

always default new policies to Prospect. 

 1.  Click the   Settings icon, and then select General Configuration.

The General Configuration dialog opens, with the General Settings side-tab preselected.

 2.  Select Default Status & Company to Prospect on New Policy.

 3.  Click OK.

When this setting is selected, new  policies will automatically have the  Policy Status and  Company set 
to  Prospect. 

For commercial policies, make sure you have set up all of your lines of business 
under the Prospect Company in Policy Company Setup.

Customize the Sales Pipeline Sub-Statuses

The Sales Pipeline  policy statuses are  available when users insert a prospect policy and are intended 

to help track prospective business through the sales process. Users can further define the Sales 

Pipeline  by selecting a sub-status.

CMS has default sub-statuses associated with each Sales Pipeline status. 

 

HawkSoft's default Sales Pipeline statuses:

Status
Default Sub-

Status
Description

Lead  

Indicates  possible interest. 

Example: An existing client mentions they might be purchasing a 
vacation home. You can enter a new Home policy with a Status of 

Lead and follow up with the client at a later date.
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Status
Default Sub-

Status
Description

  Unqualified
Client insurance needs are unknown.

Example: A list of leads in a residential zip code. 

  Qualified

Client insurance needs are known.

Example: A mortgage broker has sent a list of recent mortgage 
applicants.

Prospect  
The client is interested in receiving a quote. The policy has not been 

sold.

  Discovery
The agency is gathering information needed for underwriting and 

quoting.

  Submission

The agency has submitted the application to its carriers for approval 

and/or quote.

Use Submission Tracking in CMS to track the 
status and details of the application. SeeTrack 
Submissions for more information.

  Quote A quote/offer has been extended to the client. 

  Proposal The agency has issued a formal insurance proposal to the client. 

Refused   The client declined the quote/proposal.

  Price The client declined due to price.

  Didn't Buy Risk  The client did not proceed with purchasing the item to be insured.

Rejected   The policy has been disqualified.

  U/W Rejected The Underwriter rejected the client's application.

 
Agency 
Disqualified

The policy doesn't meet the agency's standards.

Prospects CSH.htm
#Track%20Submissions_..120
#Track%20Submissions_..120
Quotes CSH.htm
Refused CSH.htm
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To add and remove Sales Pipeline sub-statuses to the Action 

menu
You can modify or remove the default sub-statuses and add custom sub-statuses to meet your 

agency's needs.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Customize Lists

See Setting User Permissions for more information.

 1.  Click the   Settings icon, and then select Customize Lists.

 2.  Select Sales Pipeline Sub-Statuses and then click Edit.

 3.  Modify the list as needed.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 4.  Click OK to save.

You will see your saved sub-statuses next time you use the Action menu Sales Pipeline.

Related Topics
About The Sales Pipeline
Insert a Prospect: Sales Pipeline
Sales Pipeline Reports

Custom Client Tags

 Client Tags can be applied to a client file to serve as a notification to any user that opens that client file.  

For example, you might want to add a Tag to indicate that the client speaks Spanish, is a VIP customer, 

or you might want to alert any user that the client has a returned check for non-sufficient funds.   

#About%20The%20Sales%20Pipeline
#Insert%20a%20Prospect:%20Sales%20Pipeline_..36
#Sales%20Pipeline%20Reports
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Your agency can customize a list of available Tag Categories to choose from, and designate specific 

categories to display as a  pop-up notification.  When a user opens a client file that contains a pop-up 

Tag,  an alert displays until the user dismisses the Tag. 

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Customize Lists 

See Setting User Permissions for more information.

 1.  Click the   Settings icon, and then select  Customize Lists from the main CMS menu bar.

The List Items Setup dialog opens. 

 2.  Select Client Tag Categories, and then click Edit. 

The Setup dialog  opens with a list of Client Tag Categories. 

The following Categories and pop-up notifications are included by default.

Use the available buttons to add, modify, or remove Client Tag Categories.  

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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Item – Enter the Category, and then click OK. 

 To create a blank Category, enter spaces in the Item field.

Color – Select a color for the Category. All Tags entered for this Category will be associated with 
the selected color.

Pop-up – Check the box if all Tags with Category should display as a pop-up alert.

Delete/Delete All – If you delete a Category, it is removed immediately.  

Defaults – Click to restore the list with all default items that may have been deleted. 

 l Reset to Defaults – Reset the list to its default state (customized items will be deleted)

 OR

 l Load Defaults – Update the current list to make sure all default items are included (cus-
tomized items will not be deleted)

 3.  Click Apply to save changes.

 4.  Click OK to close the Setup dialog.

 5.  Click Close.

     Related Topics    
Client Tags [+video]
Customizing Lists

Commercial Hazard Classifications and Class Codes Setup

HawkSoft CMS enables you to add commercial hazard classifications and class codes for certain Lines 

of Business (LOB), such as Commercial General Liability, Agricultural Liability, or Business Owners 

#Client%20Tags%20[+video]
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Liability. Use the Commercial Hazard Classifications dialog to enter or import a list of frequently 
used Classifications and Class Codes. 

When  adding a hazard to a policy, a Classification and Class Code Lookup button is available on the 

Add Hazard dialog for accessing the list of classifications entered on the Hazard Classifications dia-
log. 

This article explains how to set up your Commercial Hazard Classifications list.

See Hazards for more information on adding hazards to a policy.

In this topic:

Import Hazard Clas-

sifications and Class Codes

Manually Add Classifications 

and Class Codes

Remove a Hazard

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Customize Lists

See Setting User Permissions for more information.

To import hazard classifications and class codes

 1.  Select the   Settings icon, and then select  Customize Lists.

The List Items Setup dialog opens.

 2.  Select Commercial Hazard Classifications, and then click Edit.

The Hazard Classifications dialog opens.

 3.  Copy the classification list from your desktop or online source.

 4.  Click Import from Clipboard on the Hazard Classifications dialog.

How CMS Imports Hazard Classifications and Class Codes...

 5.  Click OK to save, and then click Close.

../../../../../Content/Clients and Policies/Client Policy Info Screens/Hazards/Commercial Hazards.htm
#Import_Hazard_Classifications_and_Class_Codes
#Import_Hazard_Classifications_and_Class_Codes
#Manually_Add_Classifications_and_Class_Codes
#Manually_Add_Classifications_and_Class_Codes
#Remove_a_Hazard
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The hazard classifications and codes are now available to be added on the Hazards 

screen.

To manually add a classification and class code

 1.  Select the   Settings icon, and then select  Customize Lists.

The List Items Setup dialog opens.

 2.  Select Commercial Hazard Classifications, and then click Edit.

The Hazard Classificationsdialog opens.

 3.  Scroll to the bottom of the Classification list, and then manually enter the name of 

the Classification and the Class Code.

An additional blank line is created.

 4.  Enter additional classifications, as needed.

 5.  Click OK to save, and then click Close.

The hazard classifications and codes are now available to be added on the Hazards 

screen.

To remove a hazard from the list
Highlight the hazard to be removed, and then click Delete Row.

To remove multiple hazards, press and hold the Ctrl key while selecting the hazards to be 
removed, and then click Delete Row.

Related Topics
Coverages for Commercial and Other Policy Types
Customizing Lists
Hazards

../../../../../Content/Clients and Policies/Client Policy Info Screens/Coverages/Coverages for Com and Other Policy Types.htm
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Workers' Compensation Classification Codes

HawkSoft CMS enables you to create and track Workers' Compensation policies, including coverage 

and hazard information. Workers' Compensation  is included as a default line of business within Poli-

cy/Company Setup but can be customized to fit your business needs.

This article explains how to set up your Workers' Compensation Classification Codes list in CMS.

See Workers' Compensation to learn how to add or edit policies, andWorkers' CompensationCreating 

and Modifying an ACORD Form for more information on generating forms in CMS.

In this topic:

Import Workers' Comp Class 

Codes

Manually Add Workers' 

Comp Class Code

Remove Workers' Comp 

Class Code

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Customize Lists

See Setting User Permissions for more information.

To import  Workers' Comp class codes

You can easily copy and import a list of class codes from an Excel spreadsheet, directly 

into the Workers' Compensation Classification Codes dialog in CMS.

 1.  Copy the Classification codes and descriptions from your Excel spreadsheet to your 

clipboard.

For easy importing, format your list of class codes in your 
Excel® spreadsheet with the code in the first column and the 
description in the second column.

 2.  In CMS, click the   Settings icon, and then select Customize Lists.

The List Items Setup dialog opens.

 3.  Select Workers' Compensation Classification Codes, and then click Edit. 

#Workers'%20Compensation_..42
#Workers'%20Compensation_..42
#Creating%20and%20Modifying%20an%20ACORD%20Form_..68
#Creating%20and%20Modifying%20an%20ACORD%20Form_..68
#Import_Workers_Comp_Class_Codes
#Import_Workers_Comp_Class_Codes
#Manually_Add_Workers_Comp_Class_Code
#Manually_Add_Workers_Comp_Class_Code
#Remove_Workers_Comp_Class_Code
#Remove_Workers_Comp_Class_Code
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The Workers' Compensation Classification Codes dialog opens.

 4.  Click Import from Clipboard.

To manually add a Workers' Comp class code

 1.  Select the   Settings icon and then select Customize Lists.

The List Items Setup dialog opens.

 2.  Select Workers' Compensation Classification Codes, and then click Edit.

The Workers' Compensation Classification Codes dialog opens.

 3.  Enter a Class Code and a Description. 

To remove a Workers' Comp class code

 1.  Select the   Settings icon and then select Customize Lists.

The List Items Setup dialog opens.

 2.  Select Workers' Compensation Classification Codes, and then click Edit.

The Workers' Compensation Classification Codes dialog opens.

 3.  Select a Class Code from the list, and then click Delete Row. 

Related Topics
Coverages for Commercial and Other Policy Types
Creating and Modifying an ACORD Form
Customizing Lists
Workers' Compensation

Correspondence Setup Overview

HawkSoft CMS provides a variety of ways in which users can correspond with customers, prospects, 

and other contacts entered into the CMS database.

Emails, letters, memos, proposals, the Policy Overview,  and text messages can be conveniently cre-

ated, and then printed and/or sent from the client files using the Action menu. Data from client files can 

be inserted into correspondence using merge fields.

../../../../../Content/Clients and Policies/Client Policy Info Screens/Coverages/Coverages for Com and Other Policy Types.htm
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Some template setup is necessary to get the most from the correspondence features. These templates 

are found in Setup > Correspondence Templates on the main CMS menu bar.  For more information, 
see the linked articles in the sections below. 

Base Templates

HawkSoft CMS has default base templates which provide the default layout and formatting for creating 

new email and form letter templates created in CMS, and serve as the actual templates for memos and 

the Policy Overview printed through CMS. 

The base templates can be modified to meet the needs of your agency. For example, you can set up 

the Base Email Template to always include the customer’s name and policy number in the Subject line 

using merge fields.  When creating a new email template, those merge fields will already be included on 

the template, saving you time.

See the articles listed below to create your specific correspondence templates, using the CMS Base 

Templates.

The  Policy Overview Summary and Memo Base Templates are not used to create 
additional templates. Your agency will use the Policy Overview and Memo Base 
Templates when printing these correspondence types. 

Base Templates

Form Letter Templates

HawkSoft CMS enables you to create form letter templates for printing customized letters to meet 

agency correspondence needs. This article describes how to create and modify form letter templates.

Form Letter Templates

Proposal Templates

Proposals  can consist of cover letters and post letters, line of business descriptions, and any attach-

ments or photos that the user chooses to include. All proposal templates are created using the layout 

and formatting of the Base Form Letter Template.

Proposal Templates
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Email Templates

HawkSoft CMS enables you to create email templates for composing standardized emails to send to cli-

ents.  All email templates use the layout and formatting of the Base Email Template. 

This article describes how to create and modify email templates. 

Email Templates

Modifying Email Templates

HawkSoft CMS text messaging templates provide users with the tools to create  standardized text mes-

sages that can be sent to individual recipients. Merge fields can be added for inserting client/policy 

information  for more personalized messages.

Modifying Email  Templates

Text Messaging Templates

Agencies can create templates that will merge information from client and policy files into a text mes-

sage.

Text Message Templates

E-Signature Templates

HawkSoft CMS enables you to create  templates for composing standardized e-signature messages to 

send  to clients with documents to be signed. Each template can include a subject and message con-

tent, as well as attached standard documents. 

E-Signature Templates

Modifying Correspondence Templates (Letters, Memos, Proposals, and Policy Over-
view)

HawkSoft CMS enables you to  make formatting changes and insert merge fields, signatures, and other 

elements into  your letter, memo,   proposal, and the Policy Overview templates.

Modifying Correspondence Templates (Letters, Memos,  Proposals, and Policy Overview)



3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 190

Importing and Exporting Correspondence Templates

HawkSoft CMS enables you to share Correspondence Templates with HawkSoft users outside of your 

agency, as well as third-party sources, such as a drip marketing vendor.   This topic provides instruc-

tions for exporting templates out of your database to your local computer, and importing templates from 

your local computer.

Importing and Exporting Correspondence Templates

Base Templates

HawkSoft CMS has default base templates which provide the default layout and formatting for creating 

new email and form letter templates created in CMS, and serve as the actual templates for memos and 

the Policy Overview printed through CMS. 

The base templates can be modified to meet the needs of your agency. For example, you can set up 

the Base Email Template to always include the customer’s name and policy number in the Subject line 

using merge fields.  When creating a new email template, those merge fields will already be included on 

the template, saving you time.

HawkSoft CMS comes with four default base template types that can be edited to suit your agency’s 

needs: 

Base Email Template Provides the basic formatting for all email templates.

CMS Form Letters Provides the basic formatting for all form letter and proposal templates.

Memos
Provides the layout for the three memo formats available in CMS: Memo 

to Additional Interests, Memo to Company, Memo to Insured.  You don't 

need to create an additional memo template.

Policy Overview

This is a simplified summary of the policy that describes the carrier, lines 

of business, coverages, and effective dates for a policy. This template 

determines how the Policy Overview will appear when printed from a 

policy.  You don't need to create an additional Policy Overview template.
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In this topic:

Modifying the Default Base 

Email Template

Modifying Form, Letter, 

Memo, and Policy Overview 

Base Templates

Restoring a Default Base 

Template

This task is typically performed by an Owner/Administrator or Manager.

Because Email and Letter Base Templates  provide the starting point for any new 
email and letter templates, they should  be configured to fit general correspondence 
needs. For more information on creating specific correspondence templates, 
please see the Correspondence Setup Overview.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Correspondence Templates

See Setting User Permissions for more information.

Modifying the default Base Email Template
This template provides the layout and formatting for all new email templates created in 

CMS. 

 1.  Click the   Settings icon, and then select Correspondence Templates.

The Correspondence Templates dialog opens.

 2.  Select Base Templates.

The list of Base Templates is displayed.

 3.  Select Base Email Template, and then click Edit.

The Email Template Editor displays the default merge fields and layout for this 
template.

#Modifying_the_Default_Base_Email_Template
#Modifying_the_Default_Base_Email_Template
#Modifying_Form_Letter_Memo_and_Policy_Overview_Base_Templates
#Modifying_Form_Letter_Memo_and_Policy_Overview_Base_Templates
#Modifying_Form_Letter_Memo_and_Policy_Overview_Base_Templates
#Restoring_a_Default_Base_Template
#Restoring_a_Default_Base_Template
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 4.  Format the template according to your agency preferences.

 a.  Select the HTML or Plain Text option from the template editor icon bar.

Users who have enabled MAPI email configuration can 
only send Plain Text messages, because MAPI is incom-
patible with HTML. See Email Templates for more inform-
ation.

 b.  Add text, merge fields, hyperlinks, and images, as needed.

For information on formatting text and inserting merge fields, images/agency 

logos, and objects, see Modifying Correspondence Templates (Letters, 

Memos,  Proposals, and Policy Overview).

 c.  Format text fields.

This might include changes to the font, font size, color, or other text effects 

(bold, underlined, etc.).

 5.  When all changes have been made, click Save, and then close the template.

Modifying Form Letter, Memo, and Policy Overview 

Base Templates
These templates provide the layout and formatting for new form letter templates created in 

CMS, as well as the Memos and the Policy Overview printed through CMS. 

All of these correspondence templates use the CMS Letter Editor. The basic formatting 

features are the same for all three.

See Modifying Correspondence Templates (Letters, Memos,  Proposals, and Policy Over-

view) for more information.

 1.  Click the   Settings icon, and then select Correspondence Templates.

The Correspondence Templates dialog opens.

 2.  Select Base Templates.

The list of Base Templates is displayed.

 3.  Select a template, and then click Edit.
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The CMS Letter Editor displays the default merge fields and layout for the template.

 4.  Format the template as needed.

For information on formatting text and inserting merge fields, images/agency logos, 

and objects, see Modifying Correspondence Templates (Letters, Memos,  Pro-

posals, and Policy Overview).

 5.  When all changes are made, click Save & Close.

Restoring a default Base Template 
You can reset a modified base template back to the original template installed with CMS.

 1.  Select a Base Template from the list.

 2.  Click Reset, and then select Yes to confirm.

A confirmation message appears.

 3.  Click Yes to replace the modified template with the original template.

Related Topics
Correspondence Setup Overview
Email Templates
Form Letter Templates
Modifying Correspondence Templates (Letters, Memos,  Proposals, and Policy Overview)
Proposal Templates
Text Message Templates

Form Letter Templates

HawkSoft CMS enables you to create form letter templates for printing customized letters to meet 

agency correspondence needs. 

This article describes how to create and modify form letter templates.

This task is typically performed by an Owner/Administrator or Manager.
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 To get you started, all form letter templates use the layout and formatting of the Base Form Letter Tem-

plate. You can also create a template based on an existing Word document. 

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Correspondence Templates

See Setting User Permissions for more information.

In this topic:

Access Form Letter Templates Editing a Form Letter Template

Categorizing Your Templates Form Letter Templates

To access the Form Letter Templates 

Click the   Settings icon, and then select Correspondence Templates.

The Correspondence Templates dialog opens with the Form Letters tab selected.

Adding a form letter template
You can create a new template using the default Base Templates, or if you already have a Word doc-

ument created outside of CMS, you can copy and paste the document to create a template.

Create a new template from a Base template

 1.  Click the Add button.

Each new form letter template contains the layout saved in your CMS Form 
Letters Base Template. See Base Templates to modify, if needed.

 2.  Complete the  Name of Letter field, and then click OK.

The CMS Letter Editor displays the Base Template.

#Create_a_new_template_from_an_existing_Word_document
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 3.  Type and format the letter contents, as needed, to create the new Form Letter Template.

See Modifying Correspondence Templates (Letters, Memos,  Proposals, and Policy Overview) 

for more information on adding merge fields, images, logos, etc.

When you have created several letter templates, these templates can be sor-
ted into categories, for example, "Personal Lines" or "Commercial", to enable 
quick retrieval of specific templates.

 4.  Click Save & Close.

The Form Letter template is now ready to use.

Create a new template from an existing Word doc-

ument 

 1.  Open File Explorer and navigate to your Word document.

 2.  Right-click on the Word document and click Copy.

 3.  Return to the Correspondence Templates dialog and right-click in the list of Form 
Letters templates, and then select Paste.

The new template appears in the list and keeps the title of the original Word doc-

ument.

 4.  Optional: Highlight the new template and click Rename to change the template 
description, and then click OK.

 5.  Optional: Click Edit to modify the template. See detailed steps below.

When you have created several letter templates, these templates can 
be sorted into categories, for example, "Personal Lines" or "Com-
mercial", to enable quick retrieval of specific templates.

Once your form letter templates have been added, you can create form letters from a client file  or from 

a report.

Editing a form letter template

#Categorizing_your_templates
#Categorizing_your_templates
#Form%20Letters
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Select a form letter template from the list, and then use the following buttons as needed:

Edit – Click to open the CMS Letter Editor and modify the template as needed, and then click Save 
and Close.

See Modifying Correspondence Templates (Letters, Memos,  Proposals, and Policy Overview) for 

more information.

Each correspondence template is created from a base template. See 
Base Templates to modify the default CMS Form Letter base template, 
if needed. 

Rename – Click to enter a new template description.

Duplicate – Click to copy the template and enter a new description for the copy.

Remove – Click to delete the template. 

Categorizing your templates
Create template categories to help organize your form letter templates. Once created, these categories 

are available for the entire agency.

Example: You may want to group together all letters pertaining to Personal Lines, Commercial Lines, 
etc. 

To create a new category

 1.  Click the Categories button.

The Category Setup dialog opens.

 2.  Click New.

 3.  Enter a Category name, and then click OK.

Assign or remove templates
Each template is listed with a check box. Select each template to be included in the selec-

ted Category.
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 1.  Click the Categories button.

The Category Setup dialog opens.

 2.  Select a Category from the drop-down.

 3.  Check each box next to the templates to be included in the selected category.

When creating a letter using the Action menu, users can filter templates by category to quickly find the 

right template to use for the  new letter.

Importing and exporting form letter templates
HawkSoft includes the ability to import form letter templates into CMS from your local files, as well as 

export existing templates to your local files. This enables you to use templates from other sources, as 

well as send your agency's templates to other HawkSoft agencies.

See Importing and Exporting Correspondence Templates for detailed steps.

Related Topics
Base Templates
Batch Mailing (Print)
Form Letters
Importing and Exporting Correspondence Templates
Microsoft Word Form Letters
Modifying Correspondence Templates (Letters, Memos,  Proposals, and Policy Overview)

Proposal Templates

Proposals  can consist of cover letters and post letters, line of business descriptions, and any attach-

ments or photos that the user chooses to include. All proposal templates are created using the layout 

and formatting of the Base Form Letter Template.

 See Proposals for information on creating and printing proposals based on the Proposal Template.

This task is typically performed by an Owner/Administrator or Manager.

#Batch%20Mailing%20(Print)
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#Microsoft%20Word%20Form%20Letters
#Proposals
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In this topic:

Adding a Proposal Template Adding Hazards or Schedules to an LOB Pro-

posal Template

Proposal Templates Proposal Templates

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Correspondence Templates

See Setting User Permissions for more information.

CMS includes three types of templates that are used together to create a complete proposal template. 

 l Cover Letter – A basic letter template.

Each new Cover Letter template contains the layout saved in your Form Let-
ter Base Template. See Base Templates to modify, if needed.

 l Post Letter – The post letter is blank by default and is fully customizable.

 l Line of Business – The lines of business in a proposal template include the ACORD Terms and 
Definitions, where applicable, and coverage, hazard, and schedule merge fields to insert data 

from client or policy files.

Multiple versions of each type of template type can be created.

For efficiency, HawkSoft, Inc. recommends adding  templates for each line of busi-
ness that your agency might need before attempting to create a proposal for a cli-
ent.

For LOBs with hazards or schedules, templates must contain merge fields for that 
information to be included.

Adding a proposal template

#Adding_a_Proposal_Template
#Adding_Hazards_or_Schedules_to_an_LOB_Proposal_Template
#Adding_Hazards_or_Schedules_to_an_LOB_Proposal_Template
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To create a proposal template for lines of business with hazards and/or 
schedules, see  below.

 1.  Click the   Settings icon, and then select Correspondence Templates.

 2.  Select the Proposals tab.

 3.  Click Add.

The Add Proposal Template dialog opens.

 4.  Select Cover Letter, Post Letter, or a specific Line of Business from the Select a 
Line of Business drop-down list.

 5.  Enter a Proposal Template Description for the item selected in the drop-down. 
The description should include the type of proposal this template will be used for. 

For example, you could create a cover letter, line of business, and post letter that is 

specifically tailored to a niche you are targeting such as Attorneys, Restaurants, or 

Janitorial Services.

 6.  Click OK.

 The CMS Letter Editor opens the selected template.

 l Cover Letter – The CMS Base Form Letter Template is displayed.

 l Line of Business – Depending on the coverage, the template may contain a 
list of the ACORD Terms and Definitions (where applicable), as well as a 

merge field to insert a list of coverages for that line of business. 

To add hazards and schedules to a Line of Business template, see below. 

Some lines of business, such as Business Automobile, 
have state-specific templates. In this case, a second 
Select Template menu will appear. Click the drop-down 
arrow and select the appropriate state for the selected line 
of business.

 l Post Letter – A blank CMS Letter Editor is displayed.  Make formatting 
changes according to agency preferences. You can add text, agency logo, 

merge fields, and objects. 

#Adding_a_Proposal_Template_for_LOBs_with_Hazards_and/or_Schedules
#Adding_a_Proposal_Template_for_LOBs_with_Hazards_and/or_Schedules
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 7.  Edit each of the  items, as needed.

See  Modifying Correspondence Templates (Letters, Memos,  Proposals, and Policy 

Overview) for more information.

 8.  Click Save & Close to save each new item.

When you've created several letter templates, these templates 
can be sorted into categories, for example, "Restaurants" or 
"Contractors", to enable quick retrieval of specific templates.

 9.  When all items have been added to your proposal template, click Close.

Adding Hazards or Schedules to an LOB Proposal  

Template 

 1.  Click the   Settings icon, and then select Correspondence Templates.

 2.  Click the Proposals tab.

 3.  Click Add.

The Add Proposal Template dialog opens.

 4.  Select  a specific Line of Business from the Select a Line of Business drop-down 
list.

 5.  Enter a Proposal Template Description for the item selected in the drop-down. 

The description should include the type of proposal this template will be used for. 

For example, you could create an LOB template for Inland Marine that includes  a 

detailed list of scheduled items, and then create another template that includes a 

summary list. 

 6.  Click OK.

 The CMS Letter Editor opens the selected Line of Business template.

Depending on the line of business, the template may contain a list of the ACORD 

Terms and Definitions (where applicable), as well as a merge field to insert a list of 

#Categorizing_your_templates
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coverages for that line of business. 

 7.  Insert merge fields to add a hazard and/or schedule list to the template. 

 a.  Place your cursor in your template where you want the hazard or schedule 

information to appear.

 b.  Click Insert > Field.

The Select Merge Field  to Insert dialog opens.

 c.  Use the Filter Fields box to locate Hazard or Schedule fields.

 d.  Select the Detail List, or the Summary List for the schedules and/or haz-
ards, and then click Insert.

The Merge Field Properties dialog opens. 

 e.  Leave the Line of Business default to All Lines of Business.

You already selected an LOB in step 4. 

 f.  Use the check boxes to select information to be included.

Depending on the selected merge field, different check boxes will be avail-

able.

 g.  Optional: Select a color for the Header Text and Header background as you 
want it to appear on the correspondence.

 h.  Click OK.

 8.  Click Close when you are done inserting merge fields.

 9.  Click Save & Close to save the template.

 10.  When all items have been added to your proposal template, click Close to exit the 
Correspondence Templates dialog.

Editing an existing proposal template

 1.  Click the   Settings icon, and then select Correspondence Templates.

The Correspondence Templates dialog opens.

 2.  Click the Proposals tab.
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 3.  Select a proposal template item from the list, and then use the following buttons as 

needed:

Edit – Click to open the CMS Letter Editor and modify the template as needed, and 
then click Save and Close.

See Modifying Correspondence Templates (Letters, Memos,  Proposals, and Policy 

Overview) for more information.

Each correspondence template is created from a base template. 
See Base Templates to modify the default CMS Form Letter 
base template, if needed. 

Rename – Click to enter a new template description.

Duplicate – Click to copy the template and enter a new description for the copy.

Remove – Click to delete the template. 

Importing and exporting proposal templates
HawkSoft includes the ability to import proposal templates into CMS from your local files, 

as well as export existing templates to your local files. This enables you to use templates 

from other sources, as well as send your agency's templates to other HawkSoft agencies.

For full steps on importing and exporting proposal templates, see Importing and Exporting 

Correspondence Templates.

Related Topics
Base Templates
Form Letter Templates
Importing and Exporting Correspondence Templates
Modifying Correspondence Templates (Letters, Memos,  Proposals, and Policy Overview)
Proposals

#Proposals
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Email Templates

HawkSoft CMS enables you to create email templates for composing standardized emails to send to cli-

ents.  All email templates use the layout and formatting of the Base Email Template. 

This article describes how to create and modify email templates. 

This task is typically performed by an Owner/Administrator or Manager.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Correspondence Templates

See Setting User Permissions for more information.

In this topic:

Access Email Templates Editing an Email Template

Categorizing Your Templates Email Templates

To access the email templates 

 1.  Click the   Settings icon, and then select Correspondence Templates.

The Correspondence Templates dialog opens.

 2.   Select the Email side-tab.

Adding an email template

 1.  Click the Add button.

 2.  Name the template, and then click OK.

The Email Template Editor opens.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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Each new Email template contains the layout saved in your 
Email Base Template. See Base Templates to modify, if needed.

 3.  Select the HTML or Plain Text option.

HTML Language allows format options such as different fonts, bold, italics, under-
lined print, bullet points, and inserting merge fields, images, and hyperlinks. 

Plain Text offers fewer formatting options, however, all CMS merge fields can be 
inserted into a plain text email template.

MAPI (Messaging Application Programming Interface) is NOT 
compatible with HTML. When Email  integration is set to use 
MAPI, and HTML-formatted email template (including the “No 
Template” option) is selected, the following message appears in 
a yellow bar at the bottom of the New Message window: 

“Your current email setting does not support HTML emails. All 
HTML formatting has been removed from the loaded template.”

The recipient will receive a Plain Text email.

Email integration settings are located on the Email side-tab in 
the User Profile. See  User Email Setup for more information.

 4.  Enter a subject for the email template.

 5.  Optional: Check Request Read Receipt to receive confirmation when an email cre-
ated from this template is sent and received.

This option cannot be seen or changed when creating an email 
based on this template. If this option is selected, a confirmation 
email will be returned to the user from each email recipient 
including batch email, which could result in a large number of 
confirmations returned. You can create two identical email tem-
plates, one with this option selected and one without. Indicate 
"confirmation" in the template title.

 6.  Delete <<Body of Letter>> and replace with the content of your message. 

 7.  Modify and format the email template as needed.

#Batch%20Emails
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See Modifying Email  Templates for information on inserting merge fields and 

images.

 8.  When finished, click Save.

 9.  Click the X in the upper right hand corner to close. 

When you have created several email templates, these tem-
plates can be sorted into categories, for example, "Personal 
Lines" or "Commercial", to enable quick retrieval of specific tem-
plates.

 10.  Click Close to exit Correspondence Templates.

Editing an email template
Select a template from the list, and then use the following buttons as needed: 

Edit – Click to open the Email Template Editor and modify the template as needed.

 Click Save, and then click the X in the upper right hand corner to close.

See Modifying Email  Templates for more information.

Each correspondence template is created from a base template. See 
Base Templates to modify the default Email template, if needed. 

Rename – Click to enter a new template description.

Duplicate – Click to copy the template and enter a new description for the copy.

Remove – Click to delete the template. 

See Base Templates to modify the base  template for your agency's email templates.

Categorizing your templates
Create template categories to help organize your email templates. Once created, these 

categories are available for the entire agency.

Example: You may want to group together all emails pertaining to Personal Lines, Com-
mercial Lines, etc. 
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To create a new category

 1.  Click the Categories button.

The Category Setup dialog opens.

 2.  Click New.

 3.  Enter a Category name, and then click OK.

Assign or remove templates
Each template is listed with a check box. Select each template to be included 

in the selected Category.

 1.  Click the Categories button.

The Category Setup dialog opens.

 2.  Select a Category from the drop-down.

 3.  Check each box next to the templates to be included in the selected cat-

egory.

When creating an email using the Action menu, users can filter templates by category to 

quickly find the right template to use for the new letter.

Importing and exporting email templates
HawkSoft includes the ability to import email templates into CMS from your local files, as 

well as export existing templates to your local files. This enables you to use templates from 

other sources, as well as send your agency's templates to other HawkSoft agencies.

See Importing and Exporting Correspondence Templates for detailed steps.

Related Topics
Base Templates
Batch Emails

#Batch%20Emails
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Correspondence Template Properties
Email
Importing and Exporting Correspondence Templates
Modifying Email  Templates
User Email Setup

Modifying Email  Templates

HawkSoft CMS enables you to  make formatting changes and insert merge fields, logos, and other ele-

ments into  your email templates.

See Communications Overview and Correspondence Setup Overview for more information about the 

different types of correspondence in CMS, and how to create and use templates.

 l Letter, Memo, Proposal, and the Policy Overview – To modify 
correspondence templates, see Modifying Correspondence Tem-

plates (Letters, Memos,  Proposals, and Policy Overview).

 l Text Messaging – To format a text message template, see Text 
Message Templates. 

This article describes the various formatting options available    when modifying email templates  within 

CMS.  

See Email Templates for instructions on creating or modifying Email templates.

In this topic:

Adding Merge Fields Adding Images/Logos Adding Website Links

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Correspondence Templates

See Setting User Permissions for more information.

How do I get here?

../../../../../Content/Correspondence Setup/Correspondence Template Properties CSH.htm
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An Email Template Editor is available when creating or modifying an email template in CMS. The fol-

lowing steps assume you have the editing window open. 

Adding merge fields
Merge fields are used to insert information from client or policy files into email templates as 

well as all other correspondence at the time it is generated. For example, you can insert a 

merge field to include  a policy number or carrier name in correspondence.

Some field selections activate the Merge Field Properties dialog. Fol-
low on-screen prompts to insert the field.

 1.  With the Email Template Editor open, position your cursor where the merge field 

information should appear, and then click Insert > Field from the  editing menu bar.

The Select Merge Field to Insert dialog opens.

 2.  Select a field from the list.

Use the Filter Fields and Filter Category to quickly find a field 
name.

 3.  Optional: If available, select a capitalization format for the field  from the Formatting 
drop-down list.

 l Proper Case – The first letter of each word is capitalized.

 l Upper Case – All letters are capitalized.

 l Lower Case – All letters are lower case.

 4.   Click Insert.

The merge field is inserted and the dialog stays open to add more fields if neces-

sary.

 5.  Reposition your cursor to insert another merge field, as needed.

 6.  Click Close to exit the Select Merge Field to Insert dialog when all fields have 
been inserted.
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Adding User Input fields

A User Input field provides a "placeholder" for the user to enter information 

that cannot be automatically merged from a CMS client or policy. These fields 

are typically added to form letter templates. When a user selects a form letter 

that contains a User Input field, they are prompted to insert specific inform-

ation before printing the letter.

User Input fields should not be placed in form letters inten-
ded for mass mailings.

 1.  With the Letter Editor open, position your cursor, and then click Insert > 
Field.

The Select Merge Field to Insert dialog box opens.

 2.  Select User Input from the  Field list.

 3.  Enter the expected user input in the Description field at the bottom of 
the dialog.

Example: If you enter  "Need By" in the Description field, this descrip-
tion appears as a prompt to the user.

 4.  Click Insert.

The merge field is inserted and the dialog stays open to add more fields 

if necessary.

 5.  Optional: Reposition your cursor to insert another Input field, as 

needed.

With the User Input field selected, you can change the Description, and 

then click Insert.

 6.  Click Close to exit the Select Merge Field to Insert dialog when all 
input fields have been inserted.

Formatting merge fields
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Edit the font, font size, or color 

 1.  Highlight the entire field, including chevrons: <<text>>.

 2.  Modify the field, as needed.

Use the Format menu or toolbar icons to apply formatting 

and edit the font, font size, or color.

Delete a merge field

 1.  Highlight the entire field, including chevrons: <<text>>.

 2.  Press Delete on your keyboard.

Adding images/logos to email templates

Inserting an image into an email does not  insert the actual image. The 
image URL (address) is added to the email.  When the email is 
received, the computer must access  the Internet and download the 
image  into the email.  Images stored on a computer or internal intranet 
will not be seen by the email recipient.

Pasting images into  a CMS Email is not currently supported.

 1.  With the Email Template Editor open, position your cursor, and then 

click Insert > Image.

The Image URL dialog opens.

 2.  Enter the image URL.

 3.  Click OK.

Adding website links to an email template
You can use any text or an image to create a clickable link to a website. 

See above for steps to add an image, and then follow the steps below to create a link for 

your image.
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 1.  With the Email Template Editor open, highlight the text or image to be used for the 

link.

You can use your mouse to click-and-drag to highlight text or an 
image. Alternatively, you can click next to an image, then use 
Shift+Arrow Key to highlight it. If your image is selected, it will be 
highlighted in blue.

 2.  Click Insert > Hyperlink.

The Hyperlink dialog box opens.

 3.  Select the hyperlink type from the Type drop-down list.

 4.  Enter the web address in the URL field.

 5.  Click OK.

Click Save, and then click the X to close the Email Template Editor when all changes are made.

Related Topics
Correspondence Setup Overview
Text Messaging with Email-to-SMS Services
Text Message Templates

#Text%20Messaging%20with%20Email-to-SMS%20Services


3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 212

Text Message Templates

HawkSoft CMS text messaging templates provide users with the tools to create  standardized text mes-

sages that can be sent to individual recipients. Merge fields can be added for inserting client/policy 

information  for more personalized messages.

Text messages are limited to 160 characters. Messages exceeding this limit may be cut off, or sent as 

separate messages. When using merge fields, the actual character count of the text message sent will 

vary depending on the data merged. Be sure to consider the potential character count when creating 

your text message templates.

HawkSoft provides two options for texting your clients: HawkSoft Texting or Texting via email-to-SMS. 

Once text messaging is configured for your agency, the Text Message templates are accessed from 

the Action menu.

In this topic:

Access the Text Message 

Templates

Adding a Text Message Tem-

plate

Editing a Text Message Tem-

plate

Categorizing Your Tem-

plates

Text Message Templates

This task is typically performed by an Owner/Administrator or Manager.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Correspondence Templates

See Setting User Permissions for more information.

To access the text message templates 

 1.  Click the   Settings icon, and then select Correspondence Templates.

The Correspondence Templates dialog opens.

#About%20HawkSoft%20Text%20Messaging_..128
#Text%20Messaging%20with%20Email-to-SMS%20Services
#Access_the_Text_Message_Templates
#Access_the_Text_Message_Templates
#Adding_a_Text_Message_Template
#Adding_a_Text_Message_Template
#Editing_a_Text_Message_Template
#Editing_a_Text_Message_Template
#Categorizing_Your_Templates
#Categorizing_Your_Templates
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 2.   Select the Text Messaging side-tab.

Adding a text message template

 1.  Click Add to open the Edit Text Message Template dialog.

 2.  Enter a Template Name.

 3.  Enter your message in the Text Message Template field.

 4.  Optional: Add merge fields.

 a.  Place your cursor in the Template Name field and/or the Text Message Tem-

plate box where you want the merge field to appear, and then click 

 button.

The Select Merge Field to Insert dialog opens. 

Select a merge field from the list, and then click Insert.

 b.  Repeat, to add additional merge fields. 

The client/policy data will be merged when the text mes-
sage is created

 5.  When the text message template is complete, click OK.

The new template is displayed in the Template Name list.

 6.  Click Close to exit the Correspondence Templates dialog.

When you've created several Text Message templates, these templates can be sorted into 

categories, for example, "Personal Lines" or "Commercial", to enable quick retrieval of spe-

cific templates.

Editing a text message template 
Select a template from the list, and then use the following buttons as needed:

Edit – Click to open the Edit Text Message Template dialog and modify the template as 
needed, and then click OK.

See Adding a text message template for more information on inserting merge fields.
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Rename – Click to enter a new template description.

Duplicate – Click to copy the template and enter a new description for the copy.

Remove – Click to delete the template. 

With your text message template  complete, your agency will be able to send consistently 

formatted text messages to your contacts.

Categorizing your templates
Create template categories to help organize your text message templates. Once created, 

these categories are available for the entire agency.

Example: You may want to group together all text messages  pertaining to Personal Lines, 
Commercial Lines, etc. 

To create a new category

 1.  Click the Categories button.

The Category Setup dialog opens.

 2.  Click New.

 3.  Enter a Category name, and then click OK.

Assign or remove templates
Each template is listed with a check box. Select each template to be included 

in the selected Category.

 1.  Click the Categories button.

The Category Setup dialog opens.

 2.  Select a Category from the drop-down.

 3.  Check each box next to the templates to be included in the selected cat-

egory.
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When creating a text message using the Action menu, users can filter templates by cat-

egory to quickly find the right template to use for the new letter.

Importing and exporting text message templates
HawkSoft includes the ability to import text message templates into CMS from your local 

files, as well as export existing templates to your local files. This enables you to use tem-

plates from other sources, as well as send your agency's templates to other HawkSoft 

agencies.

See Importing and Exporting Correspondence Templates for detailed steps.

Related Topics
Correspondence Template Properties
Importing and Exporting Correspondence Templates
Text Messaging Overview
Text Messaging with Email-to-SMS Services
Text Messaging Setup

E-Signature Templates

HawkSoft CMS enables you to create  templates for composing standardized e-signature messages to 

send  to clients with documents to be signed. Each template can include a subject and message con-

tent, as well as attached standard documents.  

See E-Signature  Overview for more information about e-signature options.

Templates can be selected and modified  when sending documents for electronic signature.

This article describes how to create and modify e-Signature templates. 

This task is typically performed by an Owner/Administrator or Manager.

In this topic:

Adding an E-Signature Template Editing an E-Signature Template

../../../../../Content/Correspondence Setup/Correspondence Template Properties CSH.htm
#Text%20Messaging%20Overview
#Text%20Messaging%20with%20Email-to-SMS%20Services
../../../../../Content/User Setup/Text Messaging Setup Email to Text.htm
#E-Signature%20Overview_..122
#Adding_an_E-Signature_Template
#Editing_an_E-Signature_Template
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Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Correspondence Templates

See Setting User Permissions for more information.

Adding an E-Signature template

 1.  Click the   Settings icon, and then select Correspondence Templates.

 2.  Click the E-Signature tab.

 3.  Click Add.

The Edit E-Signature Template dialog opens.

 4.  Enter a Template Name.

 5.  Optional: Enter a Subject line  that will appear on the message when this template is 
selected. 

Optional: Place your cursor within the subject, and then click  . 

If the Subject is left blank, the user can enter a subject before sending the message 

with the documents to be signed.

 6.  Type the Message to be sent when this template is selected. 

You can click   to use the spell check. 

Optional: Place your cursor within the message, and then click  . 

 7.  Optional: You can Attach  Documents  that will be included when this template is 
used. For example, a disclaimer, agency questionnaire, or a supplemental inform-

ation form. 

Attached documents can be removed before sending, if needed.

Check with your e-signature provider for supported file types.

 8.  Click OK to save and close.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 9.  Click Close to exit Correspondence Templates.

Editing an E-Signature template

 1.  Click the   Settings icon, and then select Correspondence Templates.

The Correspondence Templates dialog opens.

 2.  Select the E-Signature side-tab.

 3.  Select a template from the list, and then use the following buttons as needed:

Click to open the Edit E-Signature Template dialog and modify 
the template as needed, and then click OK.

See steps 5 through 7 above to modify the subject, message, or 

attachments.

Click to enter a new template description.

Click to copy the template and enter a new description for the copy.

Click to delete the template. 

 4.  Click Close to exit Correspondence Templates.

E-Signature templates are available from the Send for E-Signature dialog when sending documents for 

signature.

Related Topics
Correspondence Setup Overview
E-Signature  Overview
Using DocuSign or RightSignature
Using HawkSoft E-Signature (Powered by Formstack Sign)

Send Document for E-Signature CSH.htm
#E-Signature%20Overview_..122
#Using%20DocuSign%20or%20RightSignature
#Using%20HawkSoft%20E-Signature%20(Powered%20by%20Formstack%20Sign)
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Modifying Correspondence Templates (Letters, Memos,  Proposals, and Policy Over-
view)

HawkSoft CMS enables you to  make formatting changes and insert merge fields, signatures, and other 

elements into  your letter, memo,   proposal, and the Policy Overview templates. 

See Communications Overview and Correspondence Setup Overview for more information about the 

different types of correspondence in CMS, and how to create and use templates.

Email – To modify email templates, see Modifying Email  Templates. 

Text Messaging – To format a text message template, see Text Mes-
sage Templates.

This article describes the various formatting options available    when modifying correspondence tem-

plates within CMS. 

HawkSoft includes the ability to import Email, Text Messaging, Proposal, and Form 
Letter templates from your local files, enabling you to quickly use templates from 
other HawkSoft agencies or other sources. See Importing and Exporting Cor-
respondence Templates for more information.

In this topic:

Adding Merge Fields Adding Objects to Correspondence

Adding Images/Logos/Pictures to Cor-

respondence

Adding Page Breaks and Lines

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Correspondence Templates

See Setting User Permissions for more information.

#Communications%20Overview
#Adding_Merge_Fields
#Adding_Objects_to_Correspondence
#Adding_Images/Logos/Pictures_to_Correspondence
#Adding_Images/Logos/Pictures_to_Correspondence
#Adding_Page_Breaks_and_Lines
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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How do I get here?

The CMS Letter Editor opens   when creating correspondence templates in CMS. The following steps 

assume you are creating or modifying a template and have the Letter Editor window open. 

Adding merge fields
Merge fields are used to insert information from client or policy files into correspondence at 

the time it is generated. 

For example: You can insert a Policy Number merge field into a template, and then when 
you create a letter, the Policy Number from the selected policy will prefill where you inser-

ted the merge field in the template. 

Some field selections activate the Merge Field Properties dialog. Fol-
low on-screen prompts to insert the field.

 1.  With the CMS Letter Editor open, position your cursor where the merge field inform-

ation should appear, and then click Insert > Field from the  editing menu bar.

The Select Merge Field to Insert dialog opens.

 2.  Select a field from the list.

Use the Filter Fields and Filter Category to quickly find a field 
name.

 3.  Optional: If available, select a capitalization format for the field  from the Formatting 
drop-down list.

 l Proper Case – The first letter of each word is capitalized.

 l Upper Case – All letters are capitalized.

 l Lower Case – All letters are lower case.

 4.   Click Insert.

The merge field is inserted in your template and the dialog stays open to add more 

fields as needed.

 5.  Reposition your cursor to insert another merge field, as needed.
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 6.  Click Close to exit the Select Merge Field to Insert dialog when all fields have 
been inserted.

Adding a signature

CMS enables you to insert a signature into form letter, proposal, and memo 

templates.   

See User Signature Setup to scan and set up your signature in CMS. Once 

your signature is set up, use the steps to Add a merge field.

Insert > Field > Agent Signature

The following fields are available for the signature:

Agent Signature (Agent 1)

Agent2 Signature

Agent3 Signature

 l The user creating the correspondence must 

be authorized to use the signature intended 

for this item in order for the signature to dis-

play.

 l When inserting the signature of another user 

on a letter or proposal, the agent's initials must 

appear on the GPI screen in the Agent 1, 

Agent 2, or Agent 3 field.

Adding User Input fields

A User Input field provides a "placeholder" for the user to enter information 

that cannot be automatically merged from a CMS client or policy. These fields 

are typically added to form letter templates. When a user selects a form letter 

#MergeFields
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that contains a User Input field, they are prompted to insert specific inform-

ation before printing the letter.

User Input fields should not be placed in form letters inten-
ded for mass mailings.

 1.  With the Letter Editor open, position your cursor, and then click Insert > 
Field

The Select Merge Field to Insert dialog box opens.

 2.  Select User Input from the  Field list.

 3.  Enter the expected user input in the Description field at the bottom of 
the dialog.

Example: If you enter  "Need By" in the Description field, this descrip-
tion appears as a prompt to the user.

 4.  Click Insert.

The merge field is inserted and the dialog stays open to add more fields 

if necessary.

 5.  Optional: Reposition your cursor to insert another Input field, as 

needed.

With the User Input field selected, you can change the Description, and 

then click Insert.

 6.  Click Close to exit the Select Merge Field to Insert dialog when all 
input fields have been inserted.

Formatting merge fields

Edit the font, font size, or color 

 1.  Highlight the entire field, including chevrons: <<text>>.

 2.  Modify the field, as needed.
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Use the Format menu or toolbar icons to apply formatting 

and edit the font, font size, or color.

 3.  Click Save & Close when all changes are made.

Delete a merge field

 1.  Highlight the entire field, including chevrons: <<text>>.

 2.  Press Delete on your keyboard.

 3.  Click Save & Close when all changes are made.

Adding objects to correspondence 
Objects are files such as graphs or tables that can be added to CMS correspondence. 

Objects can be added to correspondence templates as well as correspondence created 

from a client/policy. 

Creating a new object
You can insert a new object, for example a blank Excel spreadsheet, and then 

insert your data directly into the object. 

 1.  With the Letter Editor open, position your cursor, and then click Insert > 
Object.

The Insert Object dialog box opens.

 2.  Select the appropriate Object Type (file), and then click OK.

The CMS Letter Editor refreshes to display the selected object, with 

available editing tools from the corresponding program.

 3.  Modify the object as needed.
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Adding an object from an existing file
You can insert a previously saved document, for example an Excel spread-

sheet that contains data.

 1.  With the Letter Editor open, position your cursor, and then click Insert > 
Object.

The Insert Object dialog box opens.

 2.  Select Create from File.

 3.  Click Browse.

The Browse dialog opens.

 4.  Select the file, and then click Open.

The path to the object is displayed in the Insert Object dialog.

 5.  Select Link or Display As Icon:

Link – Inserts a picture of the file contents into your document. The pic-
ture will be linked to the file so that changes to the file will be reflected in 

your document.

Display As Icon – Inserts a picture of the file contents.

 6.  Click OK to insert the object into the template.

Adding images/logos/pictures to correspondence 
Images saved on your computer or network as JPG, BMP, TIF, or GIF can be added to let-

ters, memos, and proposals.

 1.  With the CMS Letter Editor open, position your cursor, and then click Insert > Pic-
ture.

The Windows ®Open dialog opens.

 2.  Browse to locate the image, and then click Open.
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Adding page breaks and lines
Page breaks and lines can be added to correspondence templates as well as cor-

respondence created from a client/policy. 

 l Page Break – Provides a way to manually insert a page break at any point so you 
can determine the flow of the document.

 l Line – Can be used to visually separate one section of text, objects, or pictures from 
another section to make the document more readable.

Adding a page break
Position your cursor, and then click Insert > Page Break.

The break will be visible in the  Print Preview.

Adding a line

 1.  Position your cursor, and then click Insert > Horizontal 
Line.

The Horizontal Line dialog appears.

 2.  Select line height and color.

The preview changes as you modify the line.

 3.  Click OK.

Related Topics
Correspondence Setup Overview
Importing and Exporting Correspondence Templates
Modifying Correspondence (Letters, Memos,  Proposals, and Policy Overview)
Modifying Email
Text Messaging with Email-to-SMS Services
Text Message Templates

#Modifying%20Correspondence%20(Letters,%20Memos,%20Proposals,%20and%20Policy%20Overview)
#Modifying%20Email
#Text%20Messaging%20with%20Email-to-SMS%20Services
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Importing and Exporting Correspondence Templates

HawkSoft CMS enables you to share Correspondence Templates with HawkSoft users outside of your 

agency, as well as third-party sources, such as a drip marketing vendor.   This topic provides instruc-

tions for exporting templates out of your database to your local computer, and importing templates from 

your local computer. 

For more information on setting up Correspondence Templates, see the Correspondence Setup Over-

view. For  using and creating correspondence in HawkSoft, see Communications Overview.

This task is typically performed by an Owner/Administrator, Manager, or Bookkeeper.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Correspondence Templates

See Setting User Permissions for more information.

In this topic:

Importing and Exporting Correspondence 

Templates

Importing and Exporting Correspondence 

Templates

Importing and Exporting Correspondence 

Templates

Importing and Exporting Correspondence 

Templates

To import a Correspondence Template
You can import HawkSoft correspondence templates created and sent by HawkSoft users 

outside of your agency into your HawkSoft database.  For a list of what types of files can be 

imported, see the Importing and Exporting Correspondence Templates section below.

Imported Correspondence Templates might not be formatted to your 
agency's standards and should be reviewed before use.

#Communications%20Overview
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 1.  Click the     Settings icon, and then select Correspondence Templates.

The Correspondence Templates dialog opens.

 2.  Select the Form Letters, Email, Proposals, or Text Messaging side-tab, depend-
ing on which kind of template(s) you will be importing.

 3.  Click Importon the Correspondence Templates window.

File explorer opens so you can select the template file(s).

Hold the Ctrl key and select multiple templates to import multiple 
templates at once.

 4.  Browse to the location of the template(s) in your files.

 5.  Select the desired template(s), and then click Open to import the template(s).

If the file already exists, you are prompted  to overwrite the existing file.

To export a correspondence Template
You can export your existing HawkSoft correspondence templates to share with HawkSoft 

users outside of your agency. For more information about HawkSoft template file types, 

see Importing and Exporting Correspondence Templates.

Correspondence templates that were not created inside of HawkSoft might not  export suc-

cessfully.

Correspondence Templates might contain proprietary data – they 
should be reviewed before exporting.

 1.  Click the    Settings icon, and then select Correspondence Templates.

The Correspondence Templates dialog opens.

 2.  Select the Form Letters, Email, Proposals, or Text Messaging side-tab.

 3.  Select the template(s) you wish to export.

Hold the Ctrl key and select multiple templates from the list to 
export multiple templates at once. When exporting multiple 
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templates, all templates are saved together in a single 
'CMS Template Package' file.

 4.  Click Export.

File Explorer opens.

 5.  Browse to the location where you want to save this template.

You can re-name this template in the Name field as needed.

 6.  Click Save.

A confirmation message appears, and your template package is saved in your local 

files, ready to be shared with other agencies.

File Types
HawkSoft uses custom file types to make sharing correspondence templates as easy as 

possible.  These file types are readable by any current HawkSoft CMS application.  All files 

are exported using these file types.  HawkSoft can also import additional file types, depend-

ing on the type of correspondence template.

Exported file types
 l Form Letter templates are exported as .CMSLetterTemplate files.

 l Email templates are exported as .CMSEmailTemplate files.

 l Text Message templates are exported as .CMSSMSTemplate files.

 l Proposals are exported as .CMSProposalTemplate files.

Importable file types
In addition to the file types above, you might need to import a template with a different file 

type from a third-party. The following file types can be imported into correspondence tem-

plates:
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 l Form Letter templates can be imported from .rtf files.

 l Email templates can be imported from .html files.

 l Proposal templates can be imported from .zip and .rtfpc files.

 l Text Message templates can be imported from .txt files.

HUG Template Repository
You can source correspondence templates from the HawkSoft User Group (HUG). You 

will need to create a HUG account, at no charge, to view this page.

https://hawksoftusergroup.org/resources/template-library/

Related Topics
Communications Overview
Correspondence Setup Overview
Email Templates
Form Letter Templates
Modifying Correspondence Templates (Letters, Memos,  Proposals, and Policy Overview)
Proposal Templates
Text Message Templates

HawkSoft Integrations and Product Add-Ons 

HawkSoft CMS offers additional features and integrations with a variety of third-party software applic-

ations.

This article includes a variety of features and integrations for your agency.

In this topic:

Communications Quotes Consumer Applications

Marketing Solutions State Specific Integrations  

https://hawksoftusergroup.org/resources/template-library/
#Communications%20Overview
#Consumer_Applications
#Marketing_Solutions
#State_Specific_Intergrations
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Communications

About HawkSoft Text Messaging

HawkSoft Text Messaging enables you to send text messages to your clients  and manage 

their replies directly from HawkSoft CMS. This feature is available to your agency as an 

add-on service, and is purchased through the Marketplace.

This topic provides links to additional articles to help you set up text messaging as well as 

everything you need to know to use the text messaging feature.

About HawkSoft Text Messaging

Electronic Signature Providers

HawkSoft enables you to easily send documents directly from CMS to your customers for 

an electronic signature. You can create templates to send with your client/policy attach-

ments, ACORD forms, Change Request forms, as well as additional documents saved to 

your computer. Your customers can then "sign" the document(s) electronically and return 

them via the electronic signature application you have configured in CMS.

Providing your customers with the ability to electronically sign documents can help 

improve the quality of their service experience and speed up the time necessary to get doc-

uments signed.

You can purchase HawkSoft E-Signature (Powered by Formstack Sign) as an add on 

product, or you can use one of the e-Signature providers that HawkSoft integrates with.

E-Signature  Overview

HawkSoft CMS Phone System Integration

 HawkSoft enables you to configure your phone system to integrate with CMS. This integ-

ration enables you to place outbound calls from within a client file with the click of a mouse, 

and to open an inbound caller's client file as soon as you receive a call.

Depending on your provider, different configuration options are available. Most providers 

enable you to configure both outbound dialing and inbound call screen pops with CMS. 

 If your provider has configured  inbound calls,  CMS either opens the client file auto-

matically, or displays a dialog with the option to open the client file.

Phone System Integration

HawkSoft Marketplace.htm
#About%20HawkSoft%20Text%20Messaging_..128
#E-Signature%20Overview_..122
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Quotes

IVANS Market Appetite

HawkSoft CMS integrates with IVANS Market Appetite to enable you to quickly identify 

markets for commercial lines risks directly from CMS.

IVANS Market Appetite is easy to use. Simply click the link provided in CMS to view a list 

of carriers with an appetite for a specific risk in your client/policy.

You can easily access the IVANS Market Appetite website from within the client policy or 

from the CMS toolbar.

IVANS Market Appetite

Comparative Raters

The HawkSoft Client Management System provides tools for integrating CMS with com-

parative rating programs. Depending on the vendor your agency works with, the integ-

ration may be one-way or two-way.

 l One-way integration –   Enables your agency to seamlessly pass client and policy 
information to the rater for quoting new business or re-rating current clients. These 

"one-way" bridges transfer information to or from  CMS, but not both directions.

 l Two-way integration –  Enables CMS to  send client and policy data to the rater, 
and from the rater back to CMS.  Using these bridges reduces the amount of time 

spent entering data  and can significantly increase productivity.

Comparative Raters Overview

HawkLink

HawkLink is a tool that enables you to launch websites from within HawkSoft CMS, and 

populate website fields with information from a client file or policy stored in HawkSoft. 

Using HawkLink makes it quick and easy to request quotes from carriers.

HawkLink Overview

#Comparative%20Raters%20Overview_..46
#HawkLink%20Overview_..116
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Consumer Applications

Agent Portal

HawkSoft Agent Portal enables you to access client and policy information stored in 

CMS from your web browser. Because it is optimized for mobile devices, you can use 

Agent Portal on your phone or tablet to quickly and securely access the information you 

need on the go.

Agent Portal Setup

Agent Portal

HawkSoft Partner API

 HawkSoft enables partnered third-party vendors, such as agency marketing services, to integrate with 

your HawkSoft database. Using the Partner API, approved vendors can pull client and policy data from 

HawkSoft into the third-party application, or send log notes and/or attachments directly into a policy in 

HawkSoft. 

Integrations with partnered third-party applications can be enabled through the HawkSoft Marketplace.

To create a toolbar shortcut for 3rd-party programs

HawkSoft enables you to create a shortcut on the CMS Toolbar that allows you to quickly 

open a 3rd-party program or website, such as the integrations listed below, from within 

CMS.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Computer Specific Settings

See Setting User Permissions for more information.

 1.  Open the   Setup menu.

 2.  Select Computer Specific Settings.

 3.  Select the External Tools tab.

 4.  Click New.

#Agent%20Portal
../../../../../Content/HawkSoft Integrations and Product Add Ons/HawkSoft Marketplace.htm
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 5.  Enter a Tool Name.

 6.  Select the Tool Type (Program or Website).

 7.  Optional: Enter a Tooltip that will appear upon hovering over the shortcut.

 8.  Optional: Enter Help Text to describe the Tooltip.

 9.  Enter the path to the program in the Command field.

If this is a Website tool, enter the web address in this field.

Use the   button to browse to the program through the File 
Explorer.

 10.  Advanced: Enter launch parameters in the Arguments field, if necessary.

Most programs do not require Arguments or a separate Initial Dir-
ectory. If arguments are required to launch the program, or to 
perform an action such as logging in, contact your vendor's sup-
port to see what arguments to enter.

 11.  Advanced: Change the Initial Directory of the shortcut, if necessary.

 12.  Click Test to test your shortcut.

If your program or website launches, the shortcut is set up correctly.

 13.  Click OK.

 14.  Click OK to save your Computer Specific Settings.

The shortcut should now be visible from your CMS Toolbar.

For more information on External Tools, see Shortcuts to  External Tools [+ Video].

Rocket Referrals/ClientCircle

HawkSoft and Rocket Referrals have always shared a unique point of view in 

the industry as family-owned, private businesses committed to bringing tech-

nology solutions to independent insurance agencies without relying on out-

side investors.

We have made it easier   than ever for agencies to pair our complimentary 

products by offering HawkSoft+ Rocket Referrals, our standard software 
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bundle that includes both systems on a single bill. This all-in-one solution 

provides the most powerful agency management and client communication 

combination in the industry, so your agency can get more done with less 

effort. Your staff can spend their workday in HawkSoft while the com-

munications and follow-up task assignments happen automatically in the 

background through Rocket Referrals.

In addition, existing HawkSoft agencies can integrate their HawkSoft data-

base with ClientCircle™ by Rocket Referrals. This two-way integration 

enables you to send client data from HawkSoft to ClientCircle, and enables 

ClientCircle to send log notes and attachments back to client files in 

HawkSoft.

Rocket Referrals

Levitate

Levitate is a keep-in-touch marketing platform that enables you to auto-

matically sync client contact information from HawkSoft into the Levitate sys-

tem, along with key policy information such as renewal dates and line of 

business. Leverage your HawkSoft data in Levitate and set up unique remind-

ers to reach out, such as on birthdays or renewal dates, and be notified to 

email contacts you haven’t spoken to in a while.

Purchase Levitate via HawkSoft Marketplace.

Learn more about Levitate

AgencyBuzz

AgencyBuzz® is "web-based audience engagement" marketing software cre-

ated by Insurance Technologies Corporation (ITC). AgencyBuzz integrates 

with CMS to  enable agencies to automate their email and social media mar-

keting programs by accessing client information directly from CMS.

AgencyBuzz

Agency Revolution

Hawksoft CMS supports direct integration with Agency Revolution’s auto-

mation software, Fuse™. Hawksoft customers that use Fuse™ will be able to 

micro-segment and automate email, direct mail, and text messages to their 

../../../../../Content/HawkSoft Integrations and Product Add Ons/Rocket Referrals.htm
HawkSoft Marketplace.htm
https://www.levitate.ai/?utm_campaign=Partner%20API&utm_medium=email&_hsenc=p2ANqtz-8oi0h10V4lXnhkUoYEt3s7L0KV4yvZYGak4wlUPsSU2zvUtw09cgitD-uCFgjvFQJPWAMPARKe3CbypiNhrQlk9qsBeg&_hsmi=85968343&utm_source=hs_email&utm_content=85968343&hsCtaTracking=b4cf2774-988d-49b5-b4fd-f74d69d50922%7C8f201f3e-ae06-4495-9812-b22d50eef033#/try/hawksoft
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clients based on the information stored in Hawksoft CMS. To learn more 

about this integration, please contact Agency Revolution.

Agency Revolution

NetQuote Integration

Integration with NetQuote® allows users to move insured and policy inform-

ation from NetQuote leads into HawkSoft CMS.

NetQuote Integration

Insurance Agent Mobile

HawkSoft integrates with Insurance Agent Mobile® to help agencies engage and retain cli-

ents on a mobile application platform. Your clients can conveniently view their profile and 

policy information at any time.

Insurance Agent App

Generic/Website Integration

CMS includes a generic data importer that allows users to import data using ACORD XML, 

AL3 (ACORD Level 3, and Tagged file formats.  This article is intended for IT, software, or 

website developers that have been tasked with sending data to CMS.

Generic/Website Integration

State Specific Integrations

New York ID Card Generator Integration

HawkSoft CMS integrates with the New York ID Card DMV software (Insur-

ance Information Enforcement Systems IIES) to enable you to print ID cards 

from within CMS.   Policy information is sent from CMS directly to the New York 

ID Card DMV software, and then the  software creates the ID card for CMS to 

print, email, and/or attach to a policy. 

New York ID Card Generator Integration

Related Topics 
HawkSoft Marketplace

../../../../../Content/HawkSoft Integrations and Product Add Ons/Marketing Solutions/Agency Revolution.htm
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About HawkSoft Text Messaging

HawkSoft Text Messaging enables you to send text messages to your clients  and manage 

their replies directly from HawkSoft CMS. This feature is available to your agency as an 

add-on service, and is purchased through the Marketplace.

This topic provides links to additional articles to help you set up text messaging as well as 

everything you need to know to use the text messaging feature.

As an alternative to using the built in HawkSoft Text Messaging feature, your 
agency can subscribe to a third-party email-to-text messaging service provider and 
send text messages directly from a client file. This feature enables you to use your 
existing mobile number.

See Text Messaging Overview for more information.

Notes about HawkSoft Text Messaging

 l Opt in required
Federal law requires your customers to opt in to receive text messages from your agency. This is 

mandated by the FCC’s Telephone Consumer Protection Act. HawkSoft automates this opt in 

process with the click of a button. Learn more.

 l Texting is not for marketing purposes
HawkSoft Text Messaging is only for informational texts. You may be in violation of federal 

and/or state regulations if you use texting for marketing purposes. You can read more about best 

practices for text messaging and maintaining TCPA compliance on our blog.

 l Your agency receives one text messaging phone number
Your agency is assigned one central text message phone number. Even if multiple staff mem-

bers are texting a client, that client will see text messages arriving from a single phone number.

Purchasing HawkSoft Text Messaging

To take advantage of this feature, your agency must first enable . Once Data Sync has 

been enabled, a billing contact  for  your agency can purchase Text Messaging through the 

Marketplace. 

HawkSoft Marketplace.htm
#Text%20Messaging%20Overview
#Text%20Messaging%20Opt-In%20Compliance_..132
https://blog.hawksoft.com/texting-best-practices-tcpa-compliance


3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 236

See Purchasing HawkSoft Text Messaging for detailed steps on how to purchase the text 

messaging feature. 

Text Messaging Opt in Workflow & Compliance

FCC requires all clients opt in to receive text messages from your agency. HawkSoft sim-

plifies this requirement with an automated opt-in workflow.

Text Messaging Opt-In Compliance

Viewing & Sending Text Messages

HawkSoft makes it easy to view client text messages and send replies from a variety of loc-

ations within CMS. Available views and options depend on your texting permissions.

Viewing & Sending Text Messages

Processing Text Messages

Once you have taken action as a result of the text conversation, you can copy the relevant 

texts into a log note to document history   and mark the texts as "processed." This guide 

details our recommended workflow for processing text messages.

Processing Text Messages

Unmatched Texts

When a text message is received from a number that does not match a client file, those 

texts are collected in the "Unmatched Texts" view. Learn how to match text messages with 

a client file in this guide.

Unmatched Texts

Text Message Notification Settings

HawkSoft CMS keeps your team updated on incoming text messages through real-time 

notifications and text counts.

You can receive text notifications and number of incoming texts for:

#Purchasing%20HawkSoft%20Text%20Messaging_..130
#Text%20Messaging%20Opt-In%20Compliance_..132
#Viewing%20&%20Sending%20Text%20Messages
#Processing%20Text%20Messages
#Unmatched%20Texts
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 l Clients for which you are listed as a policy CSR or producer.

 l  Clients you choose to follow.

 l Any unmatched text messages.

Text Message Notifications

Cancelling HawkSoft Text Messaging

If your agency no longer wishes to use HawkSoft Text Messaging, agency administrators 

can download your agency's texting history and attachments and cancel your subscription 

through the HawkSoft Marketplace.

Cancelling HawkSoft Text Messaging

Purchasing HawkSoft Text Messaging

HawkSoft Text Messaging enables you to send text messages to your clients  and manage their replies 

directly from HawkSoft CMS. This feature is available to your agency as an add-on service, and is pur-

chased through the Marketplace.

This guide walks you through the steps to purchase and set up Text Messaging for your agency. Since 

HawkSoft Text Messaging is a Data Sync feature, you must first enable HawkSoft Data Sync from the 

Marketplace.

As an alternative to using the built in HawkSoft Text Messaging feature, your 
agency can subscribe to an  email-to-text messaging service provider and send text 
messages directly from a client file. 

See Text Messaging Overview for more information.

In this topic:

Notes on HawkSoft Text 

Messaging

Before You Begin Register for HawkSoft Text 

Messaging

Purchasing HawkSoft 

Text Messaging

Purchasing HawkSoft 

Text Messaging

Purchasing HawkSoft 

Text Messaging

#Following_Client_Texts:
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Notes on HawkSoft Text Messaging
 l Opt in required

Federal law requires your customers to opt-in to receive text messages from your agency. This is 

mandated by the FCC’s Telephone Consumer Protection Act. HawkSoft automates this opt-in 

process with the click of a button. Learn more.

 l Texting is not for marketing purposes
HawkSoft Text Messaging is only for informational texts. You may be in violation of federal 

and/or state regulations if you use texting for marketing purposes.

 l Your agency receives one text messaging phone number
Your agency is assigned one central text message phone number. Even if multiple staff mem-

bers are texting a client, that client will see text messages arriving from a single phone number.

Before you begin
Before purchasing HawkSoft Text Messaging, you must first register for the HawkSoft Marketplace and 

enable HawkSoft Data Sync so the application can access your HawkSoft data.

Your email address must be listed on the HawkSoft License Agreement as a main contact.

Register for the HawkSoft Marketplace

The HawkSoft Marketplace offers  agency managers the option to enable HawkSoft Data Syncing,  pur-

chase and configure HawkSoft products, and  integrate with third-party applications. 

 1.  Click the   Settings icon on the  the  HawkSoft CMS toolbar, and then select  Marketplace.

 2.  Click Register Now.

 3.  Enter your Email Address, and then click Submit.

Your email address must be listed on the HawkSoft License Agreement as a main contact. If you 

receive an error indicating your email address is not listed as a main contact, or your current 

email address is different than the one used for the HawkSoft License Agreement, please have 

your agency owner contact billing@hawksoft.com to update your information, and then try again.

#Text%20Messaging%20Opt-In%20Compliance_..132
mailto:billing@hawksoft.com
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An Authentication Code is sent to your email address.

 4.   Copy the code from the email and paste it into the corresponding field on the Marketplace regis-

tration window.

 5.  Check the box below the Authentication Code field stating you agree to the Terms 
and Conditions for HawkSoft Marketplace.

 6.  Click Submit.

A confirmation message appears. 

 7.  Close the HawkSoft Marketplace Registration screen. 

You are ready to enable additional HawkSoft products and third-party applications. 

Enable HawkSoft Data Sync

You can enable  HawkSoft Data Sync to leverage the power of your HawkSoft data  and integrate with 

third-party services as they become available in HawkSoft Marketplace. 

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > General Configuration Settings

See Setting User Permissions for more information.

 1.  Click the   Settings icon, and then select  Marketplace.

If you haven't registered for the Marketplace, see HawkSoft Marketplace for detailed instruc-

tions.

 2.  Click and read the HawkSoft Terms and Conditions in the HawkSoft Data Sync section, and 

then check the box to accept the Terms and Conditions.

 3.  Click Activate.

The HawkSoft Cloud Confirmation window opens.

 4.  Click Confirm.

A confirmation message appears.

 5.  Click the Return to Marketplace button.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
../../../../../Content/HawkSoft Integrations and Product Add Ons/HawkSoft Marketplace.htm
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Purchase HawkSoft Text Messaging
Once Data Sync is enabled, you can register for Text Messaging through the Marketplace.

 1.  Click the   Settings icon, and then select  Marketplace.

 2.  Under HawkSoft Text-Messaging, click Activate.

Important HawkSoft Text Messaging Information displays.

 3.  Review the opt-in requirements, rules regarding use for marketing purposes, information about 

your phone number, read the terms and conditions, and then click Next.

 4.  Determine if your agency will require users to opt-in before sending messages, allow users to 

skip the opt-in process, or if HawkSoft's opt-in process will be disabled for your agency. 

Federal regulations require that agencies receive opt-ins from clients before 
sending text messages. If you choose to disable opt-ins, or allow agents to 
skip opt-ins, you agree to receive opt-ins from clients through other means. 
HawkSoft is not responsible for any fines or penalties imposed by telecom 
carriers for non-compliance.

See Text Messaging Opt-In Compliance to learn more. 

 5.  Enter a phone number for clients with questions to call in the "Help" Response section.

When a client sends the phrase 'HELP' to your texting number, an automated message will dir-

ect the customer to call this number.

 6.   Enter an Area Code or Zip Code to generate a localized phone number to be used by your 
agency for text messaging, and then click Finish. 

 In some metropolitan areas, your desired area code may be unavailable. If 
you receive this error message, use a zip code to generate your phone num-
ber.

 7.  Check "I understand my agency will be charged $20.00 per month starting on my next 
HawkSoft invoice."

 8.  Read the Additional Required Information.

#Text%20Messaging%20Opt-In%20Compliance_..132
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This section explains that additional information will be required on the next page in order to 

register your agency with The Campaign Registry (TCR). Telecom carriers require that all busi-

nesses sending text messages register their business with TCR.

 9.  Click Finish to complete your order.

A Congratulations page appears, which shows the status of your HawkSoft texting number and 
lists the next steps towards enabling HawkSoft Text Messaging.

Complete required information to start registration pro-

cess
Additional information is required to register your agency with The Campaign Registry (TCR) before 

HawkSoft Text Messaging can be enabled. Telecom carriers require that all businesses sending text 

messages register their business, or "brand", with TCR.

If this information is not filled out by the agency, a HawkSoft representative will contact your agency to 

gather this information.

If you are interested in using your agency's main phone number as your HawkSoft 
Texting number, you can request to enroll in Main Number Texting through the 
Required Information Form. See Purchasing HawkSoft Text Messaging for more 
information.

 1.  Open The Campaign Registry Required Information Form in your web browser.

 2.  Fill out the information requested in the form.

 3.  Click Submit Information to send this information to HawkSoft.

HawkSoft will use this information to register the agency in The Campaign Registry.

 4.  Close the Marketplace window and return to HawkSoft CMS.

HawkSoft submits this information to The Campaign Registry. After  registration is complete within 

TCR, HawkSoft will activate Text Messaging for your agency.

HawkSoft will send an email to your agency's main contacts once Text Messaging is activated. 

If your agency previously used a different text messaging integration (such as Bulk SMS or Message 

Media), HawkSoft Text Messaging will be automatically set as the default texting tool within all  User 

Settings after activation. If the additional text messaging service is no longer needed, you may cancel 

the service.

https://www.hawksoft.com/10dlc
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Once your agency receives notification that HawkSoft Text Messaging is activated, 
all users must restart CMS in order to begin using HawkSoft text messaging.

Your texting number
Once you complete your HawkSoft Text Messaging order, HawkSoft begins creating and registering a 

new texting number from your agency, using the area code provided on the previous page.

It can take up to five minutes for HawkSoft to register your new phone number. You can click the 

refresh   button after waiting, or view your number at a later time by re-opening the Marketplace 

and clicking Manage under HawkSoft Text Messaging.

Main Number Texting
Upon request, HawkSoft can set up your agency's main phone number as your HawkSoft 

Text Messaging number. There is a $99 one-time fee for enabling Main Number Texting.

Not all phone numbers are able to be used for Main Number Texting. 
Your agency will not be charged the one time fee  until  your requested 
phone number has been successfully enrolled in Main Number Tex-
ting.

HawkSoft Text Messaging setup must be completed before the pro-
cess for enrolling in Main Number Texting can begin. Your agency will 
use the separate texting number ordered through the Marketplace until 
the enrollment is complete.

 1.  Complete and submit  The Campaign Registry Required Information Form in your 

web browser.

If your agency already submitted the form  but selected not to 
enroll in Main Number Texting, and you would now like to switch 
to your agency's main number, contact Product Support for 
assistance.

 a.  Within the Required Information Form,  select Yes next to "Do you wish to 
enroll in Main Number Texting?"

https://www.hawksoft.com/10dlc
https://www.hawksoft.com/10dlc
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 b.  Complete the additional fields that appear with your main number, your phone 

service provider, the business name you use with your phone service pro-

vider, and the service address you use with your phone service provider.

Once HawkSoft is notified of intent to enroll, the agency principal will receive an 

email from HawkSoft staff containing a Letter of Authorization and signing instruc-

tions. If your agency did not complete the additional Main Number Texting fields 

within the TCR Required Information Form, you will be asked to provide additional 

information.

 2.  Complete the Letter of Authorization.

 3.  Reply to the email from HawkSoft with the completed Letter of Authorization 

attached. Provide any additional information needed within your reply, if requested 

to do so by HawkSoft.

Upon receipt, HawkSoft informs all agency main contacts that HawkSoft will now 

attempt to get the requested phone number for Main Number Texting, and will notify 

the agency when the process is complete.

You will receive an email from HawkSoft confirming that your agency is now signed 

up for Main Number Texting, using the number you requested.

Once Main Number Texting is enabled, all old messages and 
opt-ins will remain, however your previous HawkSoft Text Mes-
saging number will no longer be active, and any texts sent to the 
old texting number  will not be received going forward. Make sure 
to inform your clients of the changed texting number.

 If HawkSoft is unable to get the requested number, HawkSoft will inform the 

agency's main contacts, and you may request to try a different number.

Text messaging administration 
Once HawkSoft Text Messaging is enabled, all users can begin sending outgoing text messages to cli-

ent files they have access to. Administrators can disable text messaging for certain users within User 

Permissions. 

Available Texting Permissions:
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 l Client File > Allow Sending Text Messages: Grants permission for CMS users to send out-
going texts to clients.

 l Setup > Texting Administration: Allows users to view all text messages, regardless of client 
file permissions, via the All Unprocessed Text Menu.

Permissions are not required to viewtext messages, so long as the user has permissions to access the 

client's file. 

See About HawkSoft Text Messaging for more information on HawkSoft Text Messaging workflows.

Related Topics 
Processing Text Messages
Text Message Notifications
Text Messaging Opt-In Compliance
Viewing & Sending Text Messages

Text Messaging Opt-In Compliance

Federal law requires your clients to opt in to receive text messages from your agency. This is man-

dated by the FCC’s Telephone Consumer Protection Act. 

As part of setting up HawkSoft Text Messaging for your agency, you are given the option to auto-

matically require clients to opt in before receiving text messages from your agency. 

In this topic:

  Configuring Opt-In Settings Sending an Opt-In Request

Verify Client Opt-In Status Manually Opt-Out a Phone 

Number

Resend Opt-In Texts

This guide walks you through the steps to change the opt-in requirement setting after setup is com-

plete. 
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As an alternative to using the built in HawkSoft Text Messaging feature, your 
agency can subscribe to an  email-to-text messaging service provider and send text 
messages directly from a client file. This feature enables you to use your existing 
mobile number.

See Text Messaging Overview for more information.

Configuring opt-in settings
During setup, HawkSoft provides three options to address opt-in requirements:

Use HawkSoft's automated opt-in process – This option requires that all users send an automated 
opt-in message to clients. Clients must reply "yes" to this message before outgoing texts can be sent. 

This is the recommended option as it helps your agency maintain compliance with federal regulations.

Allow users to accept legal liability for my agency and skip the opt-in process – This option 
allows HawkSoft users to skip the opt-in process for individual phone numbers. This is helpful if your 

agency collects opt-ins through another method and certain clients have already given their permission 

to receive text messages.

Accept legal liability on behalf of my agency and disable the automatic opt-in process - This 
option removes the opt-in process for all client files.

You can change your selection at any time by returning to Marketplace. 

 1.  Click the   Settings icon, and then select  Marketplace.

 2.  Scroll down to the Text Messaging section.

 3.   Click Manage, and then click Next to change your Opt-in selection.

 4.  Click Save.

Each user must restart CMS for the new opt-in workflow to take effect.

Regardless of which method you select, if a client opts out of text messages by sending "Stop," you are 

required to complete the HawkSoft opt-in process and receive a "yes" in reply to resume text com-

munication.

#Text%20Messaging%20Overview
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To send an opt-in request
If Automatic Opt-In is enabled,  HawkSoft CMS will not allow you to send an outgoing text message until 

the client has opted in for text messages. 

The opt-in request is sent as a text message. Once a client replies with "Yes," they will be opted in and 

ready to receive future texts.

Send an opt-in request from the Action menu

HawkSoft recommends using the Action menu to send the initial opt-in request, to create a log note. 

 1.  Retrieve the client file, and then select the Client tab.

 2.  Click Action, and then select one item in each of the first three lists to describe what prompted 

this transaction.

 3.  Select Send Text Message.
The Text Message Recipients dialog opens to display all cell phone numbers associated with 
the client file, as well as their opt-in status. 

 4.  Select one or more phone numbers by checking the box next to the number, and then click Send 
Opt In. The opt-in status for each phone number will change to Pending.

If your agency does not require automatic opt-in, you will see the option to 
skip sending this message.

 5.  Click Finish on the Text Message Recipients dialog.

 6.  Click  Finish on the Action menu.

HawkSoft creates a log note to document the opt-in request.

Send an opt-in request from a texting view

 1.  Select a phone number from the side-bar of the Client Texts, My Texts, or Unmatched Texts 

view.

 2.  Click Send Opt-In Text. 

Action Menu.htm
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If your agency does not require automatic opt in, you will see the option to 
skip sending this message.

Once the opt-in request is sent, it remains Pending until the client accepts.

Once the client replies "Yes" to the automatic opt in message, you can begin sending text messages.

Clients can opt out of text messaging anytime by texting "Stop."

To verify client Opt-In Status
You can verify the client's opt-in status from a few places in CMS:

 l Click the  icon on the Text Messaging dialog, to view the client's Opt-In Status at any time. 

 l View the status  from the Text Message Recipients dialog when using the Action menu to ini-
tiate a text.
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 l Click on the Cell Phone link on the client file to open the  Contact Information dialog.

To manually Opt Out a phone number
Clients can automatically opt out of text messaging anytime by texting "Stop." In addition, if a client 

expresses verbally or otherwise that they do not wish to receive text messages from your agency, you 

can manually opt out their phone number.

 1.  Retrieve the client file, and then select the Client tab.

 2.  Click Action, and then select one item in each of the first three lists to describe what prompted 
this transaction. 

 3.  Select Change Client.
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 4.  Select a phone number within the Contact Info box, and then click Edit.

 5.  Click Opt Out Phone Number. 

A confirmation message appears.

If you wish to send a text message to the client in the future, you will have to initiate the opt in process. 

To resend Opt-In Texts
Occasionally you might need to resend the opt-in message to a client. Some agencies might want to 

renew opt-in statuses yearly, or a client might acquire a different phone number.

 1.  Retrieve the client file, and then select the Client tab.

 2.  Click on Client Texts.

 3.  Click on the   icon in the right-hand corner of the Texting window, then select Opt-In Status.

A message appears  confirming the number has already been opted in. 

 4.  Click Send Opt-In Text.

HawkSoft will not allow any outgoing text messages to the client's number until they have replied 

"Yes" to the opt in text message.

Related Topics
About HawkSoft Text Messaging
Text Message Notifications
Purchasing HawkSoft Text Messaging
Viewing & Sending Text Messages

E-Signature  Overview

HawkSoft enables you to easily send documents directly from CMS to your customers for an electronic 

signature. You can create templates to send with your client/policy attachments, ACORD forms, 

Change Request forms, as well as additional documents saved to your computer.  Your customers can 

then "sign" the document(s) electronically and return them via the electronic signature application you 

have configured in CMS. 
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Providing your customers with the ability to electronically sign documents can help improve the quality 

of their service experience and speed up the time necessary to get documents signed.

You can purchase HawkSoft E-Signature (Powered by Formstack Sign) as an add on product, or you 

can use one of the  e-Signature providers that HawkSoft integrates with. 

HawkSoft E-Signature (Powered by Formstack Sign)

Formstack Status: PSRs can check for issues/outages with Formstack Sign at 
https://formstacksign.statuspage.io/

To purchase HawkSoft E-Signature (Powered by Form-

stack Sign)
HawkSoft E-Signature (Powered by Formstack Sign)  is available to your agency as an add 

on service through Marketplace. Once purchased, you can begin sending documents for 

an electronic signature without any setup. 

To purchase HawkSoft E-Signature  and assign licensing to specific users, your email 

address must be listed on the HawkSoft License Agreement as a main contact. If your 

agency contact information needs to be updated, please have your agency owner contact 

billing@hawksoft.com to request a change.

No additional configuration is needed with HawkSoft E-Signature.

See Purchasing HawkSoft E-Signature (Powered by Formstack Sign) for instructions.

HawkSoft E-Signature (Powered by Formstack Sign) 

Account Settings
Once you have purchased HawkSoft E-Signature (powered by Formstack Sign), you can 

configure Account settings for yourself and for your agency. 

HawkSoft E-Signature Account Settings

https://formstacksign.statuspage.io/
#Purchasing%20HawkSoft%20E-Signature%20(Powered%20by%20Formstack%20Sign)
#HawkSoft%20E-Signature%20Account%20Settings
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Using HawkSoft E-Signature (Powered by Formstack 

Sign)
HawkSoft E-Signature enables you to quickly prepare and send documents for signature 

directly from a client's file in HawkSoft CMS. This topic describes many of the E-Signature 

options and features available.

Using HawkSoft E-Signature (Powered by Formstack Sign)

Additional HawkSoft E-Signature providers

In addition to HawkSoft E-Signature (Powered by Formstack Sign), HawkSoft has direct integration 

available with the following e-Signature providers: 

DocuSign™

Contact: 800-379-9973

Original RightSignature® v3

RightSignature enables integration only with Original RightSignature v3. If you have New RightSig-

nature v4, you can contact your RightSignature representative and request to roll back to v3.

Contact: 855-884-2257

If HawkSoft doesn't have direct integration with your e-Signature provider, you can 
easily drag and drop documents from a client/policy into your e-Signature program.

Configuring Docusign or RightSignature
Before the e-Signature feature can be used with another provider, integration  must be con-

figured in your User profile. 

E-Signature Configuration: DocuSign or RightSignature 

Using Docusign or RightSignature
HawkSoft enables you to easily send documents directly from CMS to your customers for 

an electronic signature. You can create templates to send with your client/policy attach-

#Using%20HawkSoft%20E-Signature%20(Powered%20by%20Formstack%20Sign)
#E-Signature%20Configuration:%20DocuSign%20or%20RightSignature_..124
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ments, ACORD forms, and Change Request forms, as well as additional documents 

saved to your computer.

Using DocuSign or RightSignature

HawkSoft E-Signature Templates

HawkSoft CMS enables you to create templates for composing standardized e-Signature messages to 

send to clients with documents to be signed. These templates can be used with any e-Signature pro-

vider. You can also attach documents to templates, such as agency, company, or state disclosures or 

acknowledgments. These documents will be included in your e-Signature package when the template 

is selected. Templates can be selected, and modified, if needed, when sending documents for elec-

tronic signature.

 E-Signature Templates  

Phone System Integration

 HawkSoft enables you to configure your phone system to integrate with CMS. This integration enables 

you to place outbound calls from within a client file with the click of a mouse, and to open an inbound 

caller's client file as soon as you receive a call.

Depending on your provider, different configuration options are available. Most providers enable you to 

configure both outbound dialing and inbound call screen pops with CMS. 

 If your provider has configured  inbound calls,  CMS either opens the client file automatically, or dis-

plays a dialog with the option to open the client file.

This article  explains how to configure CMS to integrate with your phone system. 

In this topic:

Before you begin Incoming Call Integration 

(ScreenPops)

Outbound Call Integration

Phone integration is only supported on Windows workstations and cannot be con-
figured on Mac devices. Inbound call integration is not supported on Windows 7.

#Using%20DocuSign%20or%20RightSignature
#Before
#Incoming
#Incoming
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Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > General Configuration 

See Setting User Permissions for more information.

Before you begin
Before integrating the agency's phone system with HawkSoft, verify that the phone system supports 

integration.

 l For inbound call integration, the phone software must include the ability to launch third-party 

applications upon receiving a call.

 l For outbound call integration, the phone software must support placing calls using the CallTo 
and/or Tel protocols within Windows.

Phone Integration Glossary

VoIP
Voice Over Internet Protocol - This term describes any voice or phone service that operates 

through the Internet instead of through telephone lines. Most VoIP services run through a com-

puter.

Protocol
A language that computers use to communicate with each other. On workstations running Win-

dows, the main protocols for communicating with VoIP software are CallTo and Tel.
Argument

Information that one program shares with another. For the purposes of this article, arguments 

include the CMS Username, CMS Password, and caller's phone number.

Program Call
An action one program takes to launch a separate program. For outbound phone calls, CMS 

makes a program call to the phone system, and for inbound calls the phone system makes a call 

to CMS.

Path
Also known as 'file path' or 'program path'. This is the location of a program, file, or folder on a 

computer.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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%LocalAppData%
This is a variable pre-built into Windows that points to the user's local appdata folder. (C:\Users\

[User Name]\AppData\Local).

Incoming Call Integration (ScreenPops)

Incoming call integration is not supported on Windows 7.

Incoming call integration uses a feature called "ScreenPops" to match client files to a caller's phone 

number. Upon receiving a call, CMS searches all client files for the caller's  number. If at least one client 

contains the caller's number, a ScreenPop opens showing all client files containing that number.

To configure incoming calls, your agency's VoIP software must be configured to launch the ScreenPop 

application, with arguments for the CMS user's initials, password, and the caller's phone number. The 

steps to do so vary between VoIP providers, and as such it is recommended to have an agency tech-

nician assist with incoming call integration setup.

Local agencies

For locally hosted agencies, the VoIP software should be configured to launch %localap-
pdata%\hawksoft\cms\program\CmsScreenPop.exe. 

If you have a non-standard HawkSoft installation, such as a terminal server, this path may differ for 

you. If the above path does not work, have your agency technician point the VoIP software to the 

CMSScreenPop.exe application within the HawkSoft folder in your local AppData or the agency's 
HawkSoft database.

Incoming Call Arguments
Arguments highlighted in bold are required for ScreenPops to function.

/PHONE:"%P"

Passes the phone number to CMS. 

%P stands for the variable used by the phone system 
for the caller's phone number. This variable may vary 

between phone vendors; for example, %P should be 

replaced with %E on RingCentral phones.



3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 255

/LOGIN:[user initials]
Passes the user's CMS initials to the ScreenPop 

application. For example, /LOGIN:CMS

/PASSWORD:[password]
Passes the user's CMS password to the ScreenPop 

application. For example, /PASSWORD:Secret123!

/LAUNCH (Optional)

If this argument is included, HawkSoft will auto-

matically launch the matching client file. 

If this argument is not included, or if there is more than 

one matching client file, a ScreenPop appears show-

ing which client files match the caller's number, and 

gives an option to launch the selected client.

/CFG:[config file path] (Optional)

For local agencies in multiple database environments, 

use this argument to point to the correct configuration 

path.

/DURATION:[seconds] (Optional)
If this argument is included, ScreenPops will only 

appear for the amount of time set once launched.

List of common phone providers and parameters required

HawkSoft does not maintain documentation for any of the following phone systems. 
Please direct phone system questions to the agency technician or phone provider.

Toshiba Call Manager

/PHONE:"%P" /LOGIN:[initials] /PASSWORD:[password] /LAUNCH

Xarios Phone Manager

Set objShell = CreateObject ("Wscript.Shell")

ObjShell.Run ("C:\HAW\HawkSoft.Connect.exe" /cfg:C:\haw\hawk.ini /PHONE: " + 

PhoneControl.CLI + " /LOGIN:"[initials]" /PASSWORD:"[password]")

ISymphony

/PHONE:"%CID NUMBER%" /LOGIN:[initials] /PASSWORD:[password] /LAUNCH

SAMSUNG XCHANGE
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/PHONE:"%CALL" \CONTACT\TEL% /LOGIN:[initials] PASSWORD:[password] 

/LAUNCH

XChange Integration needs to be set up as a Custom   Button.

RINGCENTRAL

/PHONE:"%E" /LOGIN:[initials] /PASSWORD:[password] /LAUNCH

AllWorx

/PHONE:"%CALLNUM%" /LOGIN:[initials] /PASSWORD:[password] /LAUNCH

IdentaPop Pro

Supports many Tel Protocol compliant business telephone systems including 3CX, Alcal-

tel, Allworx, Asterisk, Avaya, Cisco, Ericsson, ESI, Freeswitch, NEC, Nitsuko, NBX, Nor-

tel, Panasonic, Phillips, Siemens, Splicecom and Zultys.  

This software can pass Caller ID information from these phone systems to an external pro-

gram such as HawkSoftConnect.exe.

/PHONE:[CID] /LOGIN:[initials] /PASSWORD:[password] /LAUNCH

Outbound call integration

HawkSoft enables users to call clients' phone numbers directly from CMS by placing a program call 

containing the number to call to the user's phone system.

To enable outbound integration within CMS, a default phone provider or protocol needs to be set inside 

of General Configuration. However, individual users can override the default setting from the User List.

To set the default phone provider or protocol in CMS

 1.  Open the  Setup menu.

 2.  Open General Configuration, and then select Phone Dial-Out Integration.

 3.  Select the agency's phone provider or protocol from the Phone Provider drop-down.
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 4.  Optional: Enter a phone number and click Call Now to test the integration.

 5.  Click OK to save changes.

To override a user's phone provider or protocol in CMS

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > User List (Required to edit a user profile other than your own) 

See Setting User Permissions for more information.

 1.  Open the   Setup menu.

 2.  Open the User List.

 3.  Select the user to edit, and then click Edit.

 4.  Select the Phone Dial-out Integration tab.

 5.  Check Override Setup > General Configuration Setting.

 6.  Select the new provider/protocol from the drop-down.

 7.  Optional: Enter a phone number and click Call Now to test the integration.

 8.  Click Finish to save changes.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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To pair your phone to CallTo or Tel in Windows

For agencies/users with either CallTo or Tel selected as the phone provider/protocol, the CallTo or Tel 
protocol must be set to open the phone system within Windows.

 1.  Open the Start Menu on the user's workstation.

 2.  Search for "Default apps".

 3.  Click "Choose default apps by protocol".

 4.  Locate the CALLTO or TEL protocol.

The list of protocols is sorted alphabetically.

 5.  Click on "Choose a default" next to the CALLTO or TEL protocol.

 a.  If an app is already selected as the default, click the app icon instead.

 6.  Click the user's phone application.
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Comparative Raters Overview

The HawkSoft Client Management System provides tools for integrating CMS with comparative rating 

programs. Depending on the vendor your agency works with, the integration may be one-way or two-

way.

 l One-way integration –   Enables your agency to seamlessly pass client and policy information to 
the rater for quoting new business or re-rating current clients. These "one-way" bridges transfer 

information to or from  CMS, but not both directions.

 l Two-way integration –  Enables CMS to  send client and policy data to the rater, and from the 
rater back to CMS.  Using these bridges reduces the amount of time spent entering data  and can 

significantly increase productivity.

Comparative Raters

AccuAuto Web Rater Integration

ACS 2000 Rater Integration

Applied  Rater Integration

Capital Evolution Rater Integration

EZLynx Rater Integration

FSC Rater Integration

IBQ Rater Integration

ITC TurboRater Integration

PL Rating Integration

Quomation PowerQuote Integration

QuoteRush

SinglePoint Integration

The HawkSoft Importer

../../../../../Content/HawkSoft Integrations and Product Add Ons/Comparative Raters/Accu-Auto Web Rater Integration.htm
../../../../../Content/HawkSoft Integrations and Product Add Ons/Comparative Raters/ACS 2000 Rater Integration.htm
../../../../../Content/HawkSoft Integrations and Product Add Ons/Comparative Raters/Applied Rater Integration.htm
../../../../../Content/HawkSoft Integrations and Product Add Ons/Comparative Raters/Capital Evolution Rater Integration.htm
../../../../../Content/HawkSoft Integrations and Product Add Ons/Comparative Raters/EZLynx Rater Integration.htm
../../../../../Content/HawkSoft Integrations and Product Add Ons/Comparative Raters/FSC Rater Integration.htm
../../../../../Content/HawkSoft Integrations and Product Add Ons/Comparative Raters/IBQ Rater Integration.htm
../../../../../Content/HawkSoft Integrations and Product Add Ons/Comparative Raters/ITC TurboRater Integration.htm
../../../../../Content/HawkSoft Integrations and Product Add Ons/Comparative Raters/PL Rating Integration.htm
../../../../../Content/HawkSoft Integrations and Product Add Ons/Comparative Raters/Quomation PowerQuote Integration.htm
../../../../../Content/HawkSoft Integrations and Product Add Ons/Comparative Raters/QuoteRushcsh.htm
../../../../../Content/HawkSoft Integrations and Product Add Ons/Comparative Raters/SinglePoint.htm
../../../../../Content/HawkSoft Integrations and Product Add Ons/Comparative Raters/The HawkSoft Importer.htm


3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 260

IVANS Market Appetite

HawkSoft CMS integrates with IVANS Market Appetite to enable you to quickly identify markets for 

commercial lines risks directly from CMS.

IVANS Market Appetite is easy to use. Simply click the link provided in CMS to view a list of carriers 

with an appetite for a specific risk in your client/policy.

You can easily access the IVANS Market Appetite website from within the client policy or from the CMS 

toolbar.

This task is typically performed by an Owner/Administrator, Manager, or CSR/Producer.

Required Permissions:
To perform this task, no specific CMS user permissions are required. 

In this topic:

Subscribing Markets Sign Up

Access IVANS Market from a Client/Policy Access IVANS Market from the CMS Tool-

bar

Subscribing Markets
The following list includes current IVANS Market Appetite carriers: 

 New carriers are added to this list periodically.

 l Affinity Nonprofits

 l Affinity Travel

 l Amerisure

 l AmTrust

 l Aon Attorneys Advantage

 l Attune

 l Bankers Insurance

#Subscribing_Markets
#Sign_Up
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#Access_IVANS_Market_Appetite_from_CMS_Toolbar
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 l Berkshire Hathaway GUARD

 l Brownstone

 l Central Insurance

 l CNA

 l Employers

 l Encova/Motorists

 l Hagerty

 l Hanover

 l Hiscox

 l HSB (Hartford Steam Boiler)

 l Huntington T. Block

 l Ian H. Graham

 l Insurmark

 l JM Wilson

 l K&K Insurance

 l Main Street America Group

 l MiniCo

 l Missouri Employers Mutual

 l Nationwide

 l Nonprofits Insurance Alliance

 l Pekin

 l Quincy Mutual

 l State Auto

 l Travelers

To sign up
Before using IVANS Market Appetite, you will need to sign up with your agency's account 

information.
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 If your agency does not have an IVANS account, see IVANS Transfer 
Manager for more information.

 1.  Access IVANS Market Appetite from a client policy or from the CMS toolbar (see 

below).

The IVANS Request Registration Email dialog opens.

 2.  Complete the registration information.

 l IVANS finds a match between your email domain and a single existing Y-

Account.

 l You should receive a verification email.

 l Once you verify your email, you will have access to IVANS Market 

Appetite.

 l IVANS does NOT find a match between your email domain and a single Y-

Account OR your email domain matches multiple Y-Accounts.

 l The Confirm Your Agency dialog opens.

Enter your agency Y-Account, Mailbox Number and Password, and 
then click Confirm.

If you don't know your Y-Account information, click 
the Request Assistance button.

Complete the information fields on the Request 
Assistance Page to send an email to the IVANS 
Support Team.

Access IVANS Market Appetite from a Client/Policy

 A  Launch Market Appetite link is available from the Name and Address  and General 
Policy Information screens when the Business check box is selected on the Name and 
Address screen. Click this link to open the IVANS Market Appetite website with search res-

ults displayed, according to the  NAICS and  State entered on the Name and Address 
screen. These results will tell you which carriers have "an appetite" for this risk, and which 

Line of Business it would be written under.
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Access IVANS Market Appetite from the CMS Toolbar 

The IVANS Market Appetite button is available from the CMS Toolbar.   Click this button to 
launch the IVANS Market Appetite website and perform a search for carriers who have "an 

appetite" for a specific risk.

To remove this button from your toolbar,  remove the setting in User 
Preferences. 

Related Topics
Client Name and Address Information
General Policy Information
IVANS Transfer Manager
Tour of the CMS Start Page

Agent Portal Setup

HawkSoft Agent Portal enables you to access client and policy information stored in CMS from your 

web browser. Because it is optimized for mobile devices, you can use Agent Portal on your phone or 

tablet to quickly and securely access the information you need on the go.

This topic walks you through the steps to enable and set up Agent Portal for your agency. 

For information on accessing and using this feature, see Agent Portal.

In this topic:

Before You Begin Agent Portal Setup

Before you begin

Before enabling HawkSoft Agent Portal, you must first register for the HawkSoft Marketplace and 

enable HawkSoft Data Syncing so the application can access your HawkSoft data.

Your email address must be listed on the HawkSoft License Agreement as a main contact.

#Client%20Name%20and%20Address%20Information
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Register for the HawkSoft Marketplace

The HawkSoft Marketplace offers  agency managers the option to enable HawkSoft Data 

Syncing,  purchase and configure HawkSoft products, and  integrate with third-party applic-

ations. 

 1.  Click the   Settings icon on the  the  HawkSoft CMS toolbar, and then select  Mar-

ketplace.

 2.  Click Register Now.

 3.  Enter your Email Address, and then click Submit.

Your email address must be listed on the HawkSoft License Agreement as a main 

contact. If you receive an error indicating your email address is not listed as a main 

contact, or your current email address is different than the one used for the 

HawkSoft License Agreement, please have your agency owner contact 

billing@hawksoft.com to update your information, and then try again.

An Authentication Code is sent to your email address.

 4.   Copy the code from the email and paste it into the corresponding field on the Mar-

ketplace registration window.

 5.  Check the box below the Authentication Code field stating you agree to the Terms 
and Conditions for HawkSoft Marketplace.

 6.  Click Submit.

A confirmation message appears. 

 7.  Close the HawkSoft Marketplace Registration screen. 

You are ready to enable additional HawkSoft products and third-party applications. 

Enable HawkSoft Data Sync

You can enable  HawkSoft Data Sync to leverage the power of your HawkSoft data  and 

integrate with third-party services as they become available in HawkSoft Marketplace. 

Required Permissions:
In order to complete this task, user permissions must be set to include:

mailto:billing@hawksoft.com


3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 265

Setup > General Configuration Settings

See Setting User Permissions for more information.

 1.  Click the   Settings icon, and then select  Marketplace.

If you haven't registered for the Marketplace, see HawkSoft Marketplace for detailed 

instructions.

 2.  Click and read the HawkSoft Terms and Conditions in the HawkSoft Data Sync 

section, and then check the box to accept the Terms and Conditions.

 3.  Click Activate.

The HawkSoft Cloud Confirmation window opens.

 4.  Click Confirm.

A confirmation message appears.

 5.  Click the Return to Marketplace button.

Enable the HawkSoft Agent Portal

Once you've registered for the HawkSoft Marketplace and Data Sync is enabled, you can register for 

Agent Portal through the Marketplace.

 1.  Access the HawkSoft Marketplace through one of the following methods:

 a.  Click the   Settings icon from the  CMS toolbar, and then select  Marketplace. You are 

logged into the Marketplace automatically.

OR

 b.  Navigate to https://marketplace.hawksoft.cloud/ in a web browser.

 i.  Enter your username in the following format: [CMS User Initials]@[Agency ID]

For example, if you log into HawkSoft using the initials ABC, and your Agency ID is 

12345678, enter ABC@12345678 as your Username.

Your Agency ID can be found on the login page of HawkSoft 
CMS.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
../../../../../Content/HawkSoft Integrations and Product Add Ons/HawkSoft Marketplace.htm
https://marketplace.hawksoft.cloud/
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 ii.  In the Password field, enter the same password you use to log into HawkSoft.

 iii.  Click Sign In to log into the Marketplace.

 2.  Under HawkSoft Agent Portal, click Activate.

 3.  On the product page for Agent Portal, click Subscribe.

Set User Permissions
Once HawkSoft Agent Portal is enabled, users are given access by default. Remove the following per-

missions for any user you do not want to access Agent Portal:

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Allow Agent Portal Access

See Setting User Permissions for more information.

Related Topics 
HawkSoft Marketplace
Policy/Company Setup Overview
Client Search Overview
Agent Portal

Insurance Agent App

HawkSoft integrates with Insurance Agent Mobile® to help agencies engage and retain clients  on a 

mobile application platform.  Your clients can conveniently view their profile and policy information   at 

any time.

See Insurance Agent for more information about the Insurance Agent Mobile product. 

This article is intended to help you purchase and/or activate Insurance Agent Mobile through the 

HawkSoft Marketplace.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
../../../../../Content/HawkSoft Integrations and Product Add Ons/HawkSoft Marketplace.htm
#Client%20Search%20Overview_..48
#Agent%20Portal
https://insuranceagentapp.com/
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In this topic:

Before You Login Purchase and/or Activate 

Insurance Agent Mobile

Sign in to Insurance Agent 

Mobile

HawkSoft encourages your agency to make an effort to clean up client data to 
make it consistent, complete, and accurate.

See Best Workflow Practices and Cleaning up Agency Data. 
Most important for Insurance Agent Mobile:

Data Replace Using Advanced Reports

Linking Personal Profiles with  Missing Contact Information

Insurance Agent Mobile Rules for Importing Data

Before you begin

Before using the Insurance Agent Mobile application, you must first register for the HawkSoft Mar-

ketplace, and enable HawkSoft Data Syncing so the application can access your HawkSoft data.

Your email address must be listed on the HawkSoft License Agreement as a main contact.

It is recommended that your agency processes downloads each day to keep your 
data current in the IAM application. See Best Practices: Download Settings   for 
more information.

Register for the HawkSoft Marketplace

The HawkSoft Marketplace offers  agency managers the option to enable HawkSoft Data 

Syncing,  purchase and configure HawkSoft products, and  integrate with third-party applic-

ations. 

 1.  Click the   Settings icon on the  the  HawkSoft CMS toolbar, and then select  Mar-

ketplace.

 2.  Click Register Now.

#Before_You_Login
#Purchase_and/or_Activate_Insurance_Agent_Mobile
#Purchase_and/or_Activate_Insurance_Agent_Mobile
#Sign_in_to_Insurance_Agent_Mobile
#Sign_in_to_Insurance_Agent_Mobile
#Best%20Workflow%20Practices
#Cleaning%20up%20Agency%20Data
../../../../../Content/Reports/List of Reports/Data Replace Using Advanced Reports.htm
../../../../../Content/Best Practices for Clean Data/Best Workflow Practices/Linking Profiles with Contact Information.htm
../../../../../Content/HawkSoft Integrations and Product Add Ons/IAM Rules for Importing Data.htm
../../../../../Content/Best Practices for Clean Data/Best Workflow Practices/Best Practices Download Settings.htm
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 3.  Enter your Email Address, and then click Submit.

Your email address must be listed on the HawkSoft License Agreement as a main 

contact. If you receive an error indicating your email address is not listed as a main 

contact, or your current email address is different than the one used for the 

HawkSoft License Agreement, please have your agency owner contact 

billing@hawksoft.com to update your information, and then try again.

An Authentication Code is sent to your email address.

 4.   Copy the code from the email and paste it into the corresponding field on the Mar-

ketplace registration window.

 5.  Check the box below the Authentication Code field stating you agree to the Terms 
and Conditions for HawkSoft Marketplace.

 6.  Click Submit.

A confirmation message appears. 

 7.  Close the HawkSoft Marketplace Registration screen. 

You are ready to enable additional HawkSoft products and third-party applications. 

Enable HawkSoft Data Sync

You can enable  HawkSoft Data Sync to leverage the power of your HawkSoft data  and 

integrate with third-party services as they become available in HawkSoft Marketplace. 

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > General Configuration Settings

See Setting User Permissions for more information.

 1.  Click the   Settings icon, and then select  Marketplace.

If you haven't registered for the Marketplace, see HawkSoft Marketplace for detailed 

instructions.

 2.  Click and read the HawkSoft Terms and Conditions in the HawkSoft Data Sync 

section, and then check the box to accept the Terms and Conditions.

mailto:billing@hawksoft.com
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 3.  Click Activate.

The HawkSoft Cloud Confirmation window opens.

 4.  Click Confirm.

A confirmation message appears.

 5.  Click the Return to Marketplace button or close the Marketplace window.

 6.  Restart CMS.

 7.  Upon restart, your agency's files begin to sync instantly. You can work in CMS while 

your files  sync.

Monitor the progress

If you are curious to see what is happening with your data during the initial syn-

chronization or anytime after, click the   Settings icon, and then select Gen-

eral Configuration. Select the HawkSoft Data Sync tab, and click the Show 
HawkSoft Cloud Manager button to view details. 

 This utility enables you to see the progress of your sync, and you can also 

pause and re-start the synchronization process if needed. 

The top section of the screen displays information such as the path to your cli-

ent files, your Agency ID, the count of remaining files to process, and the 

status of the synced files. 

The History information displays the date, time, synchronization status, client 

file ID, and the computer from which the sync was run for each file.

To purchase and/or activate Insurance Agent Mobile

 1.  Click the   Settings icon on the main CMS toolbar, and then select  Marketplace.

 2.  Scroll down to the Insurance Agent Mobile product and agree to the Terms and Conditions. 

 3.  Click Share Data. 

 4.  Activate your Insurance Agent Mobile account. 

New customers:  Register to create your Insurance Agent Mobile account.

https://admin.insuranceagentapp.com/agents/sign_up?source=HSmarketplace
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Existing customers: Click the Sign In button in the Insurance Agent Mobile section of the Mar-
ketplace. 

 a.  Select the Integrations tab.

 b.  Select HawkSoft from the Add Integration drop-down.

 c.  Enter the HawkSoft Contract License #.

 To find your license number, click the   at the top of the CMS Start 
page, and then select License Info. The HawkSoft Contract ID is the 
license number.

 d.  Click Activate.

Contact Kiki@InsuranceAgentApp.com or support@InsuranceAgentApp.com if you have any 

questions about on-boarding, setup, or training before you click Activate.

Your agency's initial data synchronizes overnight. After the initial sync is complete, the  sync process 

continues to pick up changes made in CMS. These changes are  reflected in the Insurance Agent 

Mobile application within 8 to 24 hours.

It is recommended that your agency processes downloads each day to keep your 
data current in the IAM application. If you don’t process downloads every day, 
updates won’t be sent to the IAM application every day See Best Practices: Down-
load Settings   for more information.

mailto:Kiki@InsuranceAgentApp.com
mailto:support@InsuranceAgentApp.com
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To sign in to Insurance Agent Mobile

Once you have activated your account, simply click the Sign In button in Marketplace to access your 
Insurance Agent Mobile account or simply bookmark the website for future access.

Related Topics
Best Workflow Practices
Best Practices: Download Settings
Cleaning up Agency Data
HawkSoft Marketplace
HawkSoft Integrations and Product Add-Ons 
Insurance Agent Mobile Rules for Importing Data
Linking Profiles with  Contact Information
Personal Profiles with Missing Contact Information

Marketing (API) Solutions Overview

HawkSoft CMS enables agencies to integrate with third-party marketing solutions companies. These 

companies may provide a variety of marketing services, including the management of drip campaigns, 

email marketing, and social media presence.

AgencyBuzz

AgencyBuzz® is "web-based audience engagement" marketing software created by Insurance Tech-

nologies Corporation (ITC). AgencyBuzz integrates with CMS to  enable agencies to automate their 

email and social media marketing programs by accessing client information directly from CMS.

AgencyBuzz

Agency Revolution

Hawksoft CMS supports direct integration with Agency Revolution’s automation software, Fuse™. 

Hawksoft customers that use Fuse™ will be able to micro-segment and automate email, direct mail, 

and text messages to their clients based on the information stored in Hawksoft CMS. To learn more 

about this integration, please contact Agency Revolution.

Agency Revolution

https://insuranceagentapp.com/
#Best%20Workflow%20Practices
Best Practices Download Settings.htm
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Generic/Website Integration

HawkSoft CMS includes a generic data importer that enables users to import data using one of the 

data formats listed below.  

Website Integration Builders

HawkSoft has assisted several insurance agency website design companies to understand how to set 

up website integration with HawkSoft. These companies include:

Alicor: http://www.alicorsolutions.com/

SmartHarbor: https://smartharbor.com/

This article is intended for IT and software or website developers that have been tasked with sending 

data to CMS. 

In this topic:

Moving Data into CMS Supported File Formats

Moving Data Into CMS

Moving data into CMS from a website

 1.  Place a link on your webpage to a file as defined with one of the Gen-

eric/Website Integration below. 

Ensure that the link uses the correct extension as defined by that file 

format.

 2.  Click on the link for that file.

Windows automatically launches the program associated with that file 

extension. 

HawkSoft CMS registers those file extensions so that HawkSoft 

Importer will be launched.

 3.  Select one of the following options:

 l Create a New Client

 l Create a New Policy on an Existing Client

https://alicorsolutions.com/
https://smartharbor.com/
#Moving_Data_Into_CMS
#File_Formats
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 l Update a Policy on an Existing Client

Moving data into CMS from an email

 1.  Attach a file to an email as defined with one of the Generic/Website 

Integration below. 

Ensure that the attached file uses the correct extension as defined by 

that file format.

 2.  When the email is received, double-click on the attachment to auto-

matically launch the program associated with that file extension.

 HawkSoft CMS registers those file extensions so that the HawkSoft 

Importer will be launched.

 3.  Select one of the following options to update your CMS data:

 l Create a New Client

 l Create a New Policy on an Existing Client

 l Update a Policy on an Existing Client

Supported file formats

HawkSoft CMS supports the following file formats:

ACORD XML

 l Lines of Business – Personal Auto, Business Auto, Home, and 
Dwelling Fire.

 l File Format – XML file format defined and licensed by ACORD. 

Sample File

 l Documentation – ACORD XML is a standardized insurance industry 
data transfer format. Contact ACORD at http://www.acord.org    for doc-

umentation and licensing information.

https://download.hawksoft.com/download/integration/AUTO-ACORD 5x.cmsacordxml
http://www.acord.org/Pages/default.aspx
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Launching the ACORD XML

Launch file with.CMSACORDXML extension.

HawkSoft associates the file extension
 .CMSACORDXML so that launching one of 
these files automatically launches the 
HawkSoft Importer.

AL3 (ACORD Level 3)

 l Lines of Business – Personal Auto, Business Auto, Home, Dwelling 
Fire, CGL, Commercial Property, Workers' Comp, Umbrella, Com-

mercial Umbrella, Inland Marine, BOP, or Crime.

 l File Format – Structure based binary file (AL3 is an industry standard 
file format for transferring insurance data.)

 l Documentation – ACORD AL3 is a standardized insurance industry 
data transfer format.    Contact ACORD at http://www.acord.org  for doc-

umentation and licensing information. 

Launching the AL3

 1.  Launch file with a .CMSAL3 extension.

HawkSoft associates the file extension
 .CMSAL3 so that launching one of 
these files will automatically launch the 
HawkSoft Importer.

 2.  Launch CMS as follows: CMS.EXE /AL3 (filename).

Tagged file format

The Tagged file format is similar to an INI file.

http://www.acord.org/Pages/default.aspx
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 l File Format – Tagged file format  can be viewed by opening the 
CMSMTF file in notepad.

Fieldname = value

Example: 

 l  gen_sLastName = Dali

 l gen_sFirstName = Salavador

 l Documentation – Auto File Format; Auto Sample File; Home File 
Format; Commercial File Format.

Launching the Tagged File Format

Launch file with a .CMSMTF extension.

HawkSoft associates the file extension .CMSMTF so that 
launching one of these files will automatically launch the 
HawkSoft Importer.

Related Topics
Data Importer
The HawkSoft Importer

User Setup Overview
Before getting started using HawkSoft, it is important to get your User Profile and your workstation con-

figured to ensure success using HawkSoft.

Workstation Setup

HawkSoft CMS enables you to easily configure each workstation  to access and use HawkSoft CMS. 

Some settings are required, such as  mapping to the network drive and setting folder locations. Others, 

like setting up external tools, and some computer-specific settings, are optional. This section of 

https://download.hawksoft.com/download/HelpDocumentation/CMS_Multico_Tagged_Field_Format_-_Auto.xls
https://download.hawksoft.com/download/HelpDocumentation/SPH.CMSMTF
https://download.hawksoft.com/download/HelpDocumentation/CMS_Multico_Tagged_Field_Format_-_Home.xls
https://download.hawksoft.com/download/HelpDocumentation/CMS_Multico_Tagged_Field_Format_-_Home.xls
https://download.hawksoft.com/download/HelpDocumentation/CMS_Multico_Tagged_Field_Format_-_Commercial.xls
#Data%20Importer
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CMS Help describes how to set up workstations and modify computer specific settings for your work-

station.

Workstation Setup Overview

My User Profile

Now that your administrator has created your profile, it is important for you to complete your user 

information and configuration settings to ensure your success using HawkSoft. 

My User Profile

Customize Your Database 

Customization Options

HawkSoft CMS offers a variety of ways to customize your management system to suit your agency's 

workflows, as well as options for customizing the look of the application.

This article gives an overview of all the options available for customizing HawkSoft CMS.

Customize HawkSoft CMS

Workstation Setup Overview

HawkSoft CMS enables you to easily configure each workstation  to access and use HawkSoft CMS. 

Some settings are required, such as  mapping to the network drive and setting folder locations. Others, 

like setting up external tools, and some computer-specific settings, are optional. This section of 

CMS Help describes how to set up workstations and modify computer specific settings for your work-

station.

See General Agency Configuration  for information about settings that affect all users and work-

stations.

System Information

HawkSoft CMS System Information is located under the   Help on the HawkSoft CMS menu bar.

The System Information dialog provides  details about your computer, network, and CMS settings.

System Information
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Installing HawkSoft on Microsoft Windows

After CMS is installed on the server or networked workstation, each additional workstation at your 

agency needs to be configured 

Installing HawkSoft  CMS Using Microsoft Windows

 Folder Locations

CMS folder locations define where program settings and data are stored and accessed. Folder loc-

ations are computer specific and are configured  on each workstation when running Workstation Setup.

 Folder Locations

Computer Specific Settings

Computer specific settings apply to the Windows user profile   logged in.  These settings include options 

for several CMS features, such as what programs to use when viewing images and PDFs, installing the 

Virtual Printer, and printer settings.

Computer Specific Settings [+Video]

Setting Up External Tools

Setting up an External Tool enables you to configure a shortcut that links to a website or program 

(application) of your choice. You can set these links to appear on the Tools menu, the Quick Launch 

panel, and/or the main CMS toolbar.

Shortcuts to  External Tools [+ Video]

System Information

HawkSoft CMS System Information is located under the   Help on the HawkSoft CMS menu bar.

The System Information dialog provides  details about your computer, network, and CMS settings.
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In this topic:

Permissions Folder Size

File Versions Locations

System Information details

 l Windows Version

The Windows® operating system that is installed on the computer.

 l Computer Name

The name assigned to the computer.

 l IP Address(es)

 The IP (Internet Protocol) address of the computer.

 l User Name

The profile name  entered to log into Windows.

 l Drives

 Provides you with a snapshot of all the drives set up on the computer.

 l Current Directory

The path from which the HawkSoft program files are running.

 l Install Directory

The directory the program was installed to.

 l Haw Folder

The location of the HAW folder. The Haw folder contains the HawkSoft 

CMS application, and its related components.

 l Component Path

The location of CMS Configuration settings files. These paths will vary, depending 

on your computer operating system.

Example:    C:\Users\[username]\AppData\Local\HawkSoft\CMS

#Folder_Size
#File_Versions
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 Configuration Setting Files:

 l Cache folder (Cache location for Policy\Company configuration 

settings) 

 l  Export folder (Rater XML files)

 l HAWK.INI

 l HawkLink.INI

 l LogViewSpellCheck.INI  

 l NETWORK.INI

 l Base Config File

The default path to the HAWK.INI. These paths will vary, depending on your com-

puter operating system.

Example:    C:\Users\[username]\AppData\Local\HawkSoft\CMS\HAWK.INI

 l Config file

Location where the active configuration file is stored.

 l CMS Version

 This is the version of HawkSoft  CMS that is currently running.

This CMS version should match on all workstations. Multiple 
CMS versions might create multiple HAW folders.

 l CMS Instances

The number of instances of CMS running on this computer.

 l IE Version

The version of Internet Explorer running on this computer.

Permissions

System Permissions  represent local computer settings assigned by an agency system 

administrator to control access to various components of the network. If the Result 
column for any Permission item is marked as Failed, it typically indicates that the user's 
access to this component is restricted. This does not necessarily mean CMS will not run.
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 l Windows\System32

Indicates whether or not the user logged in to Windows has administrative rights to 

the Windows System32 folder.

 If the Result column displays Failed, the  user will not be able to install HawkSoft 
CMS components. This does not prevent CMS from running.

 l Haw\Agency Folder

Indicates whether the user has read\write permissions to the Haw\Agency folder.  If 

the Result column displays Failed, CMS will not run.

 l Client Folder

Indicates whether user has read\write permissions to the Haw\Client folder.   If the 

Result column displays Failed, CMS will not run.

 l Config File

Indicates whether user has read\write permissions to HAWK.INI.  If the Result 

column displays Failed, CMS will not run.

 l HKey_CLASSES_ROOT

 If the Result column displays Failed, the  user will not be able to install HawkSoft 
CMS components. This does not prevent CMS from running.

 l HKEY_LOCAL_MACHINE

 If the Result column displays Failed, the  user will not be able to install HawkSoft 
CMS components. This does not prevent CMS from running.

Component installation does not apply to HSO users.

File Versions

This window displays a list of installed CMS, Windows, and third-party .DLL and .EXE 

files. CMS uses an internal code to verify the correct version for these files.

The column reflecting the “Correct Version”  of the program file is based on the current 

installed version of CMS.  Incorrect versions of a program file are displayed in red.

In the case of third-party applications, CMS cannot determine whether the installed ver-

sion is the most recent.

 There are seven column headers:
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 l Name

 l Size

 l Date Modified

 l Installed Version

 l Correct Version

 l Company

Click on any header label to sort the report by that information.

From a troubleshooting standpoint, we are only concerned with those files where 

HawkSoft, Inc. is listed as the Company.

WSSetup.exe does not get updated with every CMS version update so 
it is not a problem for it to display in red.

Folder Size

The Folder Size Information window displays:

 l  A list of all sub-folders in the HAW folder

 l The number of files in each sub-folder

 l The total size of the HAW folder and sub-folders

Locations

The System Folder Locations dialog displays system folder locations for all networked 

users. It is primarily used to determine where the CMS files are stored.

 l The File Location drop-down contains the following seven paths: 

 l Archive Path

 l Client Path

 l  Download Path

 l Haw Path

 l  Images Path

 l  Inbox Path

 l WAN Path

Select one of the above options to view the path for the corresponding folder.
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 l System Folder Locations

Column header definitions:

 l Computer

The computer name of each networked computer that is currently logged into 

HawkSoft. 

 l Username

The windows user profile name for each user logged in.

 l Actual Path

This is the path the associated user is mapped to for each File Location drop-

down item.

 l Resolved Path

This is the UNC path.

Example: \\Server\DATA\HawkSoft.

 l Reset All:  Details displayed on this list do not get updated automatically, so if for 
instance a user is given a new computer, both the old and new computer will be dis-

played here.

 l Click Reset All to clear the information on all seven path lists.

 l The list refreshes with each user's current information as they log out of CMS.

Related Topics
 Folder Locations

Installing HawkSoft  CMS Using Microsoft Windows

In this topic: 

Compatibility Checker Workstation Setup (Quick Start Guide)                     

#To_run_Compatibility_Checker
#To_run_Workstation_Setup
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After HawkSoft CMS is installed on the server or networked workstation, each additional workstation at 

your agency needs to have required components installed. 

HawkSoft CMS includes a Workstation Setup Wizard, called "WSSetup.exe", that will automatically 

install required components and create the CMS shortcut for you. 

This article describes the process of installing HawkSoft CMS to each workstation.

Required Permissions:
No specific CMS user permissions are required to perform this task.  However, all cli-
ent workstations must be networked to the server or workstation that has CMS 
installed.  The client workstations must have full read/write and modify permissions 
to the Haw folder on the server/workstation that has CMS installed, and must have 
a mapped network drive pointing to the Haw folder. 

To run Compatibility Checker (optional)
The Compatibility Checker is  found on the HawkSoft, Inc. website and ensures that the workstation has 

the minimum required components before running WSSetup.exe.  

 1.  Go to the HawkSoft, Inc. Home Page.

 2.  Click Support > System Requirements.

Paste the following URL into your browser so you can leave these instruc-
tions open in this window: https://hawksoftinc.com/agency-management-
system/system-requirements

 3.  Click on the Compatibility Checker link, and then click Run.

The HawkSoft CMS Compatibility Checker dialog opens.

A list of Required Components appears with green check marks. 

 4.  Click Install Now if a red X appears next to any of the components.

 5.  Click Close.

To run Workstation Setup

 1.  Open the Windows File Explorer.

 2.  Locate the shared network drive that contains HawkSoft CMS in a folder named HAW.

https://hawksoftinc.com/
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For example: Z:\Haw.

 3.  Open the HAW folder, and then  double-click WSSetup.exe. 

The HawkSoft Updater dialog opens. 

 4.  Choose the HawkSoft CMS location where the program source files are  stored. 

The location defaults to the path from Step 2.

 5.  Click Next.

 The Select Icons to install options appear with  the On Desktop option selected by default. 

Additional options are available if the Terminal Services/Citrix Client setting is selected in Gen-
eral Configuration.

 6.  For agencies with Terminal Services, determine how CMS will be installed on this workstation. 

This option appears only when CMS has been installed on a Terminal 
Server. 

 l This computer is a client workstation – Select this option to configure this workstation 
to  run CMS in the Windows user's local AppData folder.

Program files are copied from  the server to the local workstation directory. This con-

figuration enables the program to run on each workstation, rather than across a network. 

The computer still requires a connection to the server to retrieve client and agency data.

 l This computer hosts the CMS program (Terminal Server) – Select this option if CMS 
will be accessed on this computer remotely, with this computer acting as a server for other 

users to connect to using terminal services such as Microsoft Remote Desktop/RDP.  

 7.  Click Update. 

If Workstation Setup previously ran on this workstation, a confirmation message appears. 

Click Yes to update the Haw Path.

Updating HAW path configures Folder Locations for you. 

See  Folder Locations for more information.

 If your workstation does not have the minimum required Microsoft components installed, CMS 

will install these components.

The Setup Complete dialog opens. 
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 8.  Click  Finish.

After HawkSoft CMS is installed on the server or networked workstation, Workstation Setup 

(WSSetup.exe) needs to be run on each additional workstation at the agency  to install required com-

ponents and create the CMS shortcut.

Related Topics
Logging In and Out of HawkSoft CMS
 Folder Locations
Workstation Setup Overview

 Folder Locations

CMS folder locations define where program settings and data are stored and accessed. Folder loc-

ations are computer specific and are configured  on each workstation when running Workstation Setup.

See Installing HawkSoft  CMS Using Microsoft Windows for more information.

Folder locations are typically configured by an Owner/Administrator or Manager.

Folder locations should be verified:

 l When setting up workstations

 l When CMS has been moved to a new server

 l If problems arise when trying to retrieve client data

Folder location settings are critical to proper software functionality. HawkSoft, Inc. 
recommends that you contact HawkSoft Support to verify your settings if you have 
any questions or concerns.

In this topic:

Folder Types and Paths Modify Folder Locations

Required Permissions:
In order to complete this task, user permissions must be set to include:

../../../../../Content/Getting Started/Logging In and Out of CMS.htm
https://hawksoftinc.com/insurance-agency-support/support
#Folder
#Modify_Folder_Locations
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Setup > Folder Locations

Even with the Folder Locations permission selected, access to this function is 
blocked when Terminal Services/Citrix Client (Local) has been selected in Gen-
eral Settings.

See Setting User Permissions for more information.

Folder types and paths

Folder Path Description

Client Path The shared network location where the client files reside.

Haw Path
The shared network location where HawkSoft CMS is installed for 

the agency.

Images Path

Location of  items attached to clients and policies. This path 

should be in a UNC (Universal Naming Convention) format on 
most network configurations.

For example: \\servername\shared\Haw\Images

Optional: Click Multiple Image Paths to create additional image 
folder locations. 

Rater Path Location for transferring quote data to a locally installed Rater.

Unmatched Docu-

ments Inbox

Default location where unattached images are initially stored until 

they are assigned to a client/policy. This path is set up auto-

matically.

Unmatched Down-

loads Inbox

Location where unmatched carrier downloads are stored until 

manually processed.

To  modify folder locations

 1.  Click the   Settings icon, and then select  Folder Locations.

The HawkSoft Folder Locations dialog opens.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 2.  Select a folder location and select one of the following options: 

 3. 
The Images Path should be a Universal Naming Convention 
(UNC) path to the shared installation of CMS for the agency.  If 
you enter a mapped drive for the images folder location, you will 
be prompted to use the UNC path.

Optional: Click Multiple Image Paths to create additional image 
folder locations. 

 l Click Edit to change the path where the selected folder is stored.

Modify all folder locations from the Haw Path. Click 
Browse to select a new path, and then select Use as 
Base Path to set this path as the root path for all other 
folder locations. No other folder locations need to be set 
up.

 l Click Explorer to view the selected folder path in Windows Explorer.

 l Click System Info to view CMS version and computer information.

See System Information for details.

 l Select Use Separate Archive Path to store archived client files in an altern-
ate location other than the Client Path.

All computers must be set to access the same archive 
path and folder.

HawkSoft Inc. recommends enabling this setting for databases with over 

10,000 client files to reduce processing time when running CMS reports.

The Current Directory, listed at the bottom of the Folder Locations dialog, reflects 
the path from which CMS program files are running.

 4.  Click OK to close the Edit Path dialog.

 5.  Click OK to close the HawkSoft Folder Locations dialog.
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Related Topics
Installing HawkSoft  CMS Using Microsoft Windows
General Settings

Computer Specific Settings [+Video]

Computer specific settings apply to the Windows user profile   logged in.  These settings include options 

for several CMS features, such as what programs to use when viewing images and PDFs, installing the 

Virtual Printer, and printer settings.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Computer Specific Settings

See Setting User Permissions for more information.

To access Computer Specific Settings

Click the   Settings icon, and then select Computer Specific Settings from the main CMS menu 

bar.

Image (TIF/JPG) File Viewer – Select the program used to view TIF or JPG images 
within CMS.

Scanner Control – If using a TWAIN compliant scan driver, select one of the following 

options that works with your drivers:

 It is best to leave this option on the Default (Version 7) setting unless 
instructed by your tech or HawkSoft representative. 

 l Basic (Version 7) 

 l Default (Version 7) 

 l Enhanced (Version 8) 

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 l Windows Image Acquisition (WIA) – Select WIA only if using a WIA Scan Driver (not 

recommended).

Unmatched Documents PDF Viewer – Select a default viewer to open  PDFs.

The most commonly used are Adobe Acrobat Reader (Internal) and Tracker XChange 

Viewer (Internal).

Remember Last Printer Used – Selecting this option defaults the printer to the last one 
used when printing from the Action menu.

Show Start Page on start up – If this option is checked, the CMS Start Page opens when 
logging into CMS.

If this option is not checked, CMS opens with a blank screen.

Compress image on attach – If this option is checked, TIF images attached to the client 
file from the Unmatched Documents Inbox are automatically compressed using TIF level 4 

compression. This will reduce the size of the TIF image files and improve the use of disk 

space on your server/workstation if images added to CMS are in TIF format.

Exlude this computer from managing the cloud synchronization process - This 
option is available only when your agency has   enabled. If this setting is checked, files  will 

not upload to the HawkSoft Cloud Servers from this workstation. All updated client data 

will still be   uploaded by other workstations that have HawkSoft CMS running at your 

agency. Agencies may want to check this setting for workstations configured through a 

VPN connection (not supported), or workstations experiencing network/internet slowness 

issues.

For synching to occur, at least one workstation must leave this setting un-checked.

See  for more information. 

For information about managing the synchronization process, see .

A restart of CMS is required if you check the Exclude this computer 
from managing the cloud synchronization process  box, to ensure 
that the Cloud Manager upload does not  run. 

Install/Uninstall Virtual Printer – Opens the Virtual Printer Manager.

 Follow on-screen prompts to reinstall or uninstall Virtual Printer. 
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Reset Printer Settings – Resets the default printer selected in CMS to the Windows® 

default printer.

Related Topics
Client and Policy Documents  Overview
Shortcuts to  External Tools [+ Video]
The HawkSoft Virtual Printer

Shortcuts to  External Tools [+ Video]

Setting up an External Tool enables you to configure a shortcut that links to a website or program 

(application) of your choice. You can set these links to appear on the Tools menu, the Quick Launch 

panel, and/or the main CMS toolbar.

External tools can launch applications only if the application is installed on the 
same computer CMS is running on.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Computer Specific Settings

See Setting User Permissions for more information.

In this topic:

Set up a website or program Additional button options 

To set up a website or program

 1.  Click the   Settings icon, and then select Computer Specific Settings from the 

main CMS menu bar.

#Client%20and%20Policy%20Documents%20Overview
#The%20HawkSoft%20Virtual%20Printer
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
#To
#Addition
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The Computer Specific Settings dialog opens.

 2.  Click the External Tools tab.

 3.  Click New to set up a new external tool, and complete the following:

 l Tool Name – Name the external tool.

 l Tool Type – Select Program (application) or Website from the drop-down 
list.

 l Tooltip – Enter the tool name as you want it to appear when you hover your 
mouse over the toolbar icon.

 l Help Text – Enter a description of the tool. This can include the keyboard 
shortcut associated with the toolbar button.

This description appears as part of the Tooltip when you hover your mouse 

over the toolbar icon.

 l Command – Enter or browse to the program (application) path or website 
URL:

 o For a website, enter the URL

 o For a program, enter the path to the .exe file

See the following table for a list of common programs and commands:
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 l Arguments – Use to send command line arguments to the EXE. (Optional: 
Used only when the tool type is Program.)

 l Initial Directory – This field automatically defaults to the same path as the 
Command field. (Optional: Used only when the tool type is Program.)

 l Select Show on Tools Menu, Show on Quick Launch Panel, and/or Show 
on  Toolbar to designate where links to the tool appear.

 4.  Click Test to verify your setup.

Your program or website launches.
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 5.  Click OK to save changes and return to the External Tools screen.

 6.  Click OK to close the Computer Specific Settings dialog.

A link to the new tool displays in CMS at the designated location.

Additional button options on the External Tools screen

 l Edit – Highlight an item from the list, and then click Edit to modify.

 l Delete – Highlight an item from the list, and then click Delete to remove the link.

 l Arrows – Highlight an item from the list, and then click the Up or Down arrow to 
move the items up or down on the list.

 l Separator – Click to insert a dividing line that  displays between external tools you 
have designated to show on the main CMS toolbar. If selected, CMS adds a sep-

arator to the bottom of the external tools list, and then you can use the navigation 

arrows to place the separator.

Related Topics
Customizing the CMS Toolbar

My User Profile

Once you have installed HawkSoft on your workstation, and you have logged into HawkSoft, you are 

ready to complete your User Profile.  It is important for you to complete your user information and con-

figuration settings to ensure your success using HawkSoft. 

 Some of your user settings have been set by your administrator. The following table lists each of the 

settings and indicates which settings you have access to and which settings your administrator may 

have configured for you. 

Profile Settings
By 

Admin
By User

General: User Name and Password

User Permissions  
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Profile Settings
By 

Admin
By User

User Preferences

Contact Information

Agent Signature  

Commissions  

Calendar  

Email

Text Messaging (additional permission required)

E-Signature (additional permission required)

Phone Dial-Out Integration (Initial Admin setup 

required)

Batch Email (additional permission required)

 You might  not have access to settings marked with a green checkbox. Per-
missions to these settings are managed in User Permissions by your administrator.

For information on entering a new user in HawkSoft as an administrator, see Manage Agency Users.

No permissions are required to update your own User Profile. 

See Setting User Permissions for more information.

No permissions are required to update your own User Profile. 

See Setting User Permissions for more information.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
../../../../../Content/Agency Setup/Manage Agency Users/Manage Agency Users.htm
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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User Profile Tabs

In your User Profile, you will see a series of tabs available for you  to enter your contact information, set 

user preferences for your search and view options, import a user signature, and configure email and 

text messaging. Setup is usually completed in sequence, starting with the General tab.

To complete your User Profile

 1.  Click the   Settings icon, and then select User List.

Your profile opens with the General tab selected. Your User initials and name have been 
entered by your administrator.

The General tab enables you to change your name, account email, and password. 

The Account Email is used if you forget your password. To update your email 
address for customer communication, see Contact Information.

 2.  (Optional) You can click the Update Password button at anytime. 

 l A strong password is required for all user profiles.

 l A password must contain at least three of the four following types of characters:

 l Uppercase letter

 l Lowercase letter

 l Number

 l Special character

 l The following special characters are allowed:

! - @ # $ % ^ * ( ) + _ <  > [ ] '

 l All other special characters, including spaces, are not allowed.

 l Passwords must be at least 8 characters and at most 32 characters.

 3.  (Optional) You can change your Account Email if needed. 

 The Account Email is used to reset a forgotten password.

See General Information to learn more.

 4.  Finish setting up your profile on the following tabs:

#Contact_Information
Forgot Password.htm#Reset
../../../../../Content/User Setup/General Information.htm
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User Preferences

Setting User Preferences enables you to set your own default search parameters when retriev-

ing a client file, as well as control the way CMS organizes client file information, policies, and 

attachments. Complete the settings on this tab. 

For detailed information about each field, see User Preferences.

Contact Information

The Information screen in the User Profile dialog is where your address, contact phone numbers, 

work email address and notes are stored in CMS.

Information entered here can also be used to flood into form letter, email, proposal, and text mes-

saging templates.

If your state requires a Producer license number on emails sent to clients, 
you can enter the license number in the Notes field. Your agency admin-
istrator can add a merge field to email templates to include this number. See 
California Agencies: Agency and Producer License Numbers for detailed 
steps.

Your Account Email address, entered on the General tab, defaults to the Email address on this 

tab. You can change the email on this tab if preferable. 

When you send an email from within HawkSoft,  this email address is used as your  return 

address. The Account Email on the General tab is used  for resetting your password.

The email address cannot be left blank. 

See User Contact Information for more details.

Agent Signature

The HawkSoft CMS Electronic Agent Signature enables you to "sign" form letters, proposals, 

memos, Change Request forms, and most ACORD forms with the click of mouse.

See User Signature Setup or  to learn how to import your signature.

Calendar

Calendar integration with CMS makes it possible for you to view, edit, and create calendar items 

from the Calendar side panel on the Start Page.

See Calendar Integration to learn how to integrate your personal calendar with HawkSoft.

../../../../../Content/Correspondence Setup/California Agency and Prod. Lic. Numbers.htm
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Email

The CMS email feature enables you to send an email from within a client file in CMS. You must 

have an email entered on the Information tab. Sending an email using CMS creates log note doc-

umentation that includes the date, time, sender, recipient, and content of the email in the selec-

ted client file.

Email settings might be configured by your agency administrator or IT, or you may need to con-

tact your email provider for the correct settings.

See User Email Setup for detailed instructions to set up your email with HawkSoft.

Batch Email

You can set up Batch Emailing if your administrator gave you permissions. Your administrator 

might have already completed your setup for you.  Once set up, HawkSoft CMS enables mass 

emailing  to customers and prospects in conjunction with  Report Generator.

Batch Email Setup [+Video]

Text Messaging

You can set up Text Messaging if your administrator gave you permissions.  Configuration 

options depend on the text messaging tool your agency uses, or can be configured to use a dif-

ferent text messaging provider for yourself.

 Text Messaging Integration – Select your text message service  provider.

 l HawkSoft Text Messaging: This is the default integration if your agency administrator 
has enabled HawkSoft Text Messaging  from the Marketplace. If this is the text messaging 

service you use, no further action is needed on this screen.  See About HawkSoft Text Mes-

saging for more information.

 l Bulk SMS: http://usa.bulksms.com/register/

 l Message Media-New (Email-to-SMS): http://www.message-media.com
Available for HawkSoft version 4.8 and later.

Message Media (Email-to-SMS): For HawkSoft CMS versions 4.7 and older. Use this 
option only if directed to do so by Message Media.

E-Signature Setup

You can set up E-Signature if your administrator gave you permissions.   HawkSoft CMS integ-

rates with select e-Signature providers to make it easier to send documents directly from CMS to 

#Batch%20Emails
#Batch%20Emails
#About%20HawkSoft%20Text%20Messaging_..128
#About%20HawkSoft%20Text%20Messaging_..128
User Permissions.htm
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your customers for electronic signature. 

If your agency is subscribed to HawkSoft E-Signature and you are licensed to use it, the drop-
down populates with HawkSoft E-Signature and cannot be changed.

Otherwise, you can select your e-Signature provider from the available drop-down:

 l Original Right Signature – Available for integration. See E-Signature Configuration: 
DocuSign or RightSignature for configuration details.

 l DocuSign – Available for integration. See E-Signature Configuration: DocuSign or 
RightSignature for configuration details.

See E-Signature  Overview

Phone Dial-Out Integration

Only modify the settings in this tab if your phone system is different from the 
rest of your agency. This dialog does not configure incoming calls.

Phone dial out integration can be configured by your agency administrator in General Con-

figuration Settings. To use the phone integration set up by your administrator, you do not need to 

do any setup on this dialog. 

However, you can click the Override box if you prefer to set up a different phone integration. Use 

this dialog to override your agency's default Phone Dial-Out Integration. 

To configure incoming calls, your agency's VoIP software must be configured to launch the 

CMS ScreenPop application, with arguments for your HawkSoft user initials, password, and the 

caller's phone number. The steps to do so vary between VoIP providers, and as such it is recom-

mended to have an agency technician assist with incoming call integration setup. 

See Phone System Integration for more information.

Once you have completed each of your Profile tabs, click Finish. 

User Preferences

HawkSoft CMS enables users  to set  their own default search parameters when retrieving a client file, 

as well as control the way HawkSoft CMS organizes client file information, policies, and attachments. 

#E-Signature%20Configuration:%20DocuSign%20or%20RightSignature_..124
#E-Signature%20Configuration:%20DocuSign%20or%20RightSignature_..124
#E-Signature%20Configuration:%20DocuSign%20or%20RightSignature_..124
#E-Signature%20Configuration:%20DocuSign%20or%20RightSignature_..124
#E-Signature%20Overview_..122
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Unlike settings made in General Configuration (global settings that affect all users and computers) or 

Computer Specific Settings (local settings that affect any user logged in to a specific computer), these 

settings are applied for each user regardless of  which computer he or she is using.

This task is optional and is typically the responsibility of the user logged into CMS.

Required Permissions:

No special user permissions are required to make changes to your own User Prefer-
ences.

In order to set up or modify User Preferences for another user, user permissions 
must be set to include:

Setup > User List 

User Permissions override settings made in  User Preferences. For example, if your 
HawkSoft CMS administrator has not given you permission for  Access to Cus-
tomer Types: Commercial, you will not have access to Commercial customer 
files, even if you select Commercial as a Customer Type in User Preferences. 

See Setting User Permissions for more information.

In this topic:

Setting User Preferences Preferences Dialog

Setting User Preferences

To set user preferences from the CMS menu bar

 1.  Click the drop-down arrow next to your user name on the CMS menu 

bar, and then select User Preferences.

The Preferences dialog opens.

 2.  Modify preferences, as needed.

See  User Preferences below.

 3.  Click OK to save your changes and close the Preferences dialog.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
#Setting
#Preferences
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To set user preferences from the User Profile dialog

 1.  Click the   Settings icon, and then select User List.

The HawkSoft User List dialog opens.

 If you are editing your own profile, and do not have 
User List permissions, CMS immediately opens 
your user profile. Skip to step 3.

 2.  Select a user, and then click Edit.

The User Profile dialog for that user opens, with the General tab selec-
ted.

 3.  Click the Preferences side-tab.

 4.  Modify preferences, as needed. 

 See User Preferences, below.

 5.  Click Finish to close the User Profile dialog.

For users without User List permissions, this step 
closes the User Profile dialog.

 6.  Optional: Click Apply to save the User List changes and add or edit 
additional user profiles.

 7.  Click OK to close the User List dialog.

To set user preferences from the Search dialog 

 1.  Click the   button on the main CMS toolbar.

The Search dialog opens.

 2.  Click User Preferences at the bottom of the Search dialog.

The Preferences dialog opens.

 3.  Modify preferences, as needed. 
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See  User Preferences, below.

 4.  Click OK to save your changes and close the Preferences dialog.

 5.  Continue to search for a client, or click Cancel to exit the Search dialog.

Preferences dialog

Search

The Search section of the Preferences dialog enables you to select default 
search options  when searching for a client. CMS remembers your settings for 

future searches.

Remember Last Used –  This option remembers the most 
recent setting for the user. 

Default Focus – Determines which search field your cursor defaults to in the 
Search dialog.

Partial Text Search –  When checked, enables the user to search with a par-

tial text string, such as a few letters from the client name or part of an address.

Search Archived Clients – Defaults CMS to search for archived client files 
only. 

Open in New Tab – Defaults every client file to open in a new tab after the ini-
tial file has been retrieved. This allows you to have multiple client files open at 

the same time.

Client Type – Enables the user to search for a specific Client Type, or all cli-
ent types.

Customer Type – Enables the user to search for a specific Customer Type, 
or multiple customer types.

Status – Enables the user to search for client files with a specific status, or 
search all client files, regardless of status.

Policy Lookup on Search – Enables the user to select a specific policy to 
open when the client file is launched. When a client file is selected, the 

Choose a Policy dialog opens. When the client file launches, the policy you 
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select opens automatically.

Settings

Check spelling as you type in Log Notes – When activated, the Spell 

Check tool automatically checks your spelling in log notes while you are typ-

ing.

Show IVANS Appetite button on toolbar – When activated, the Appetite 
button is available on the CMS toolbar.  This button links directly to the Market 

Appetite website enabling you to quickly identify markets for commercial lines 

risks. 

This setting is selected by default. If you don't enter commercial policies, you 

can uncheck this setting to remove the Appetite button. 

See IVANS Market Appetite for a full description of this tool.

Notification Preferences

Enable Notifications - Allows for pop up notifications to appear in the bottom 
right of your screen to alert you to items such as a new text message. 

Enable Notification Sounds - When enabled, pop up notifications play the 

default Windows sound set for notifications.

On Launch of Customer

These settings affect which policies and logs display when the client file is 

launched. 

Show Active Policies – Determines if active  policies display when launching 
a client file.

Include policies active in the last [x] days – Determines if 
recently canceled/expired policies display when launching a cli-

ent file. The number of days can be set by clicking the drop-

down, or by typing in a specific value.
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Show Prospect Policies - Displays prospect policies when a client file is 
launched.

Show All Canceled/Expired Policies – Displays canceled and expired 
policies  when a client file is launched.

Show Archived Policies – Determines if archived policies display when a cli-
ent file is launched.

Show Logs for All Policies – Determines if the  Show Logs for All Policies 
check box is selected by default in the Log Note window pane. When 

checked, you can view all log notes regardless of the selected policy.

Default Client Tab – Specifies which tab is initially selected when a client file 
is launched, such as contacts, policies, or invoices. 

See Tour of the Client File for additional information.

Attachments

When a CMS user launches a client file, the Attachment screen displays 

information organized into specific columns (see Sort Column, below). The fol-

lowing settings enable you to determine how these items are grouped, dis-

played, and sorted. 

Group By – Specifies how attachments are grouped when the attachment list 
is initially loaded.

Options include:

Remember Last Used – CMS groups attachments based on the grouping 
last used.

None –  Attachments display in order of attachment date, newest to oldest.

Attachment Type – Groups by file type, for example, PDF, Company Down-
load, Image files, etc.

Description/Type – Groups by the description added to the document as ref-
erence, for example, Application, Renewal, Declaration Page, Receipt.

Searching and Viewing Log Notes.htm
#Tour%20of%20the%20Client%20File
#Sort_Column
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Category – Categories are set by your CMS Administrator. Documents can 
be assigned to a category when attached to the client file, or by editing the 

attachment properties from the Attachments screen.

For example, a scanned photograph depicting vehicle damage can be 

attached to the client file and assigned to a Photo category. This enables you 

to group by document categories.

See Attachment Properties for details.

User – Groups attachments according to the CMS user who attached the doc-
ument to the client file.

Documents for Review – Groups attachments based on whether the attach-
ment is currently in another user's Documents for Review queue.

Date Attached – Groups attachments based on the date the document was 
attached to the client file. Options include Today, Yesterday, Last month, and 

other set time periods.

Effective Date – Groups attachments according to the effective date of the 
item being attached, where applicable.

Group Expand/Collapse – Specifies whether the initial display on the attach-
ment screen is expanded to display all items, or collapsed to display the group 

headings only.

Sort Column – Specifies which column  information to sort by when the list ini-
tially loads.

Sort Order – Specifies chronological, or other, listing order for column data 
when attachment list is initially loaded. Only available when Sort Column is 

set to something other than Remember Last Used.

For example, if Sort Column - Date Attached is selected, options include:

 n Oldest to Newest

 n Newest to Oldest

File Menu and Quick Launch                 

#Attachment%20Properties
#Documents%20for%20Review
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Recent Client List Count – Setting determines the number of most recently 
viewed client files that display on the Quick Launch panel.

Web Browser/HawkLink

Use the Browser drop-down list to select the browser you want to use for 
launching any website, including carrier websites:

HawkSoft's HawkLink browsers enable you to take advantage of mapping 

capabilities.

See HawkLink Overview to learn more about the different HawkLink options. 

Agency administrators can override which browser opens 
for a specific carrier using the Website drop-down in Poli-
cy/Company Setup. See Policy/Company Setup: Com-
pany Website for more information.

HawkLink options

The following options enable you to use HawkLink to launch a website:

 l HawkLink for Google Chrome – This option uses Google Chrome 
with a HawkLink extension enabled. HawkLink for Google Chrome 

adds an easy-to-use mapping tool as a pop-out extension inside of 

Chrome, and is compatible with more  website fields than other versions 

of HawkLink.

See HawkLink for Google Chrome  for more information.

 l HawkLink Browser (IE BETA) – This option enables the standalone 
HawkLink Browser, using the Internet Explorer engine.

The HawkLink Browser is a legacy version of 
HawkLink that is no longer in development. 
HawkSoft recommends using the newer HawkLink 
for Google Chrome.

 l HawkLink Browser (Chromium BETA) – This option is nearly 
identical to the HawkLink Browser (IE BETA) option, but it uses the 

Tour of the CMS Start Page 5.1.htm#The_Quick_Launch_Panel
../../../../../../CMSHelpTN/Content/HawkLink/HawkLink Overview.htm
../../../../../Content/Policy-Company Setup/Policy-Company Setup Screens/Company Website.htm
../../../../../Content/Policy-Company Setup/Policy-Company Setup Screens/Company Website.htm
../../../../../Content/HawkLink/Using HawkLink Chrome Extension.htm
Using HawkLink Chrome Extension.htm
Using HawkLink Chrome Extension.htm
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Chromium engine, the same engine that powers Google Chrome.  

It is a fully functioning browser, allowing you to navigate to any location 

on the web, set favorites, and easily update client file information on a 

carrier website. 

The HawkLink Browser is a legacy version of 
HawkLink that is no longer in development. 
HawkSoft recommends using the newer HawkLink 
for Google Chrome.

See HawkLink Browser (BETA) for more information.

 l Internet Explorer® w/HawkLink Toolbar – This is the HawkLink tool-
bar that has been available  in all versions prior to 3.10. The HawkLink 

toolbar is installed as an add-on to Internet Explorer. 

The HawkLink Toolbar is a legacy version of 
HawkLink that is no longer in development. 
HawkSoft recommends using the newer HawkLink 
for Google Chrome.

See HawkLink Toolbar for more information.

Once you have selected your HawkLink preference, you can click  the    

button on the main CMS toolbar to  open a web browser.

Web browser options:

You can choose to launch websites through HawkSoft using a default web 

browser of your choice, however, you will not be able to access HawkLink fea-

tures:

 l Google Chrome® – This option uses Google Chrome, if the browser is 
accessible on your computer or device. If this option is selected but 

Chrome cannot launch, a warning displays and the Windows Default 

Browser is used.

Using HawkLink Chrome Extension.htm
Using HawkLink Chrome Extension.htm
HawkLink Browser.htm#HawkLink_Browser_(BETA)
Using HawkLink Chrome Extension.htm
Using HawkLink Chrome Extension.htm
../../../../../../CMSHelpTN/Content/HawkLink/HawkLink Toolbar.htm
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 l Microsoft Edge® – This option uses Microsoft Edge, if the browser is 
accessible on your computer or device. If this option is selected but 

Edge cannot launch, a warning displays and the Windows Default 

Browser is used.

 l Windows Default Browser – This option uses the default web 
browser assigned in your Windows Settings.

Your selected browser is used when interfacing with 
carrier websites.  Company preferred website 
browsers can be configured  in Policy/Company 
Setup: Company Website. 

Reset All                 

Returns the user's preferences back to the default setting provided by 

HawkSoft CMS.

Related Topics
HawkLink Overview
Attachment Properties
Setting User Permissions
Tour of the Client File
Tour of the CMS Start Page
User Setup Overview

User Contact Information

The Information screen in the User Profile dialog is where a user’s address, contact phone numbers, 

work email address, and notes are stored in HawkSoft CMS.

Information entered here can also be used to merge into form letter, email, proposal, and text mes-

saging templates.

Entering or editing user contact information is a task typically performed by an Owner/Administrator.

Required Permissions:
In order to set up or modify Contact Information for a new or existing user, 

../../../../../../CMSHelpTN/Content/Policy-Company Setup/Policy-Company Setup Screens/Company Website.htm
../../../../../../CMSHelpTN/Content/Policy-Company Setup/Policy-Company Setup Screens/Company Website.htm
#HawkLink%20Overview_..116
#Attachment%20Properties
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
#Tour%20of%20the%20Client%20File
../../../../../Content/Getting Started/Tour of the CMS Start Page 5.1.htm
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permissions must include:

Setup > User List

No special user permissions are required to make changes to contact information in 
your own profile.

See Setting User Permissions for more information.

Entering or editing user contact information

 1.  Click the   Settings icon, and then select User List from the main CMS menu 

bar.

The HawkSoft User List dialog opens.

If you are editing your own profile, and do not have User List per-
missions, CMS immediately opens your user profile. Skip to step 
3.

 2.  Select a user, and then click Edit.

The User Profile dialog for that user opens.

 3.  Click the Information side-tab.

 4.  Enter or edit the address, phone number(s), email address, and notes for this user.

The email address cannot be left blank. When the user sends an 
email from within CMS, the program uses this email address for 
the return address. 

 5.  Continue to the next tab for this user profile, as needed.

OR

Click Finish to exit the User Profile dialog.

For users without User List permissions, this step closes the 
User Profile dialog.

 6.  Optional: Click Apply to save changes, and then add or edit additional user profiles.

 7.  Click OK to exit the HawkSoft User List dialog.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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User contact information is added to the user's profile. All information on this screen is 

available as merge field data for various forms of correspondence.

The contact information for this user is updated.

Some agencies choose to enter a user's job title in the Notes field so 
they can merge the job title into correspondence along with the user's 
name and other information.

For example:

Abraham Lincoln

Agency Principal

Related Topics
Setting User Permissions
User Setup Overview
User Templates 

User Signature Setup

The HawkSoft CMS Electronic Agent Signature enables you to “sign” form letters, proposals, memos, 

Change Request forms, and most ACORD forms with the click of your mouse.

This article provides instructions for scanning and importing your signature into CMS so that it will be  

available to add to your correspondence and ACORD forms.

The signature is saved in an encrypted file so it cannot be used or edited by other 
programs or users.   For this reason, each user requiring a signature must log into 
CMS individually and insert his or her own signature

Required Permissions:
No specific CMS user permissions are required to add your signature. In order to 
use your signature, or the signature of another user, you must first authorize it. See 
User Signature Setup, below.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
../../../../../Content/User Setup/Profile Templates.htm
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In this topic: 

Print and Scan Signature 

Instructions

Import a Signature Select and Authorize a Sig-

nature

Print the Signature Instruction Page and scan your sig-

nature 
The Signature Instruction Page provides spaces for you to sign your name, so you can 

scan your signature into your computer.

 1.  Click the   Settings icon, and then select  User List.

The HawkSoft User List dialog opens with your name selected.

 If you are editing your own profile, and do not have User List per-
missions, CMS immediately opens your user profile. Skip to step 
3.

 2.  Click Edit.

 3.  Click the Agent Signature side-tab, and then click Import New. 

The Select Signature  Wizard opens.

 4.  Click Next.

The Import Type dialog opens.

 Acquire Signature from Scanner and Print signature instructions are selected 
by default.

 5.  Click Next.

The Print Instructions dialog opens with your default printer selected.

 6.  Optional: Select a different Printer from the available drop-down. 

 7.  Click Next.

The Signature Instruction Page prints and the Scan Signature dialog opens. 

#Print_and_Scan_Signiture_Instructions_Local
#Print_and_Scan_Signiture_Instructions_Local
#Import_a_Signiture
#Selecting
#Selecting
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 8.  Leave the Scan Signaturedialog open while you prepare your signature. 

You will come back to this screen once you are ready to scan.

 9.  Sign your name in each of the eight boxes on the printed Signature Instruction 
Page. 

Use different types of pens to increase the probability of getting 
a legible signature after scanning.

Avoid touching the black lines with your signature. This will help 
when cropping the signature and setting the base line.

 10.  Place the Signature Instruction page in your scanner.

 11.  Make sure your scanner is selected in the available drop-down.

 12.  Click Next on the Scan Signature dialog.

 13.  Follow instructions for your specific scanner. 

 For best results, we recommend that you set your scanner to 
use  200 dpi in grayscale, and set the output of your scanner to 
TIF or JPG, not PDF.

See User Signature Setup below.

Import a signature from your computer 
If you have a signature saved on your computer, you can simply import the signature into 

CMS. 

If your signature is in a PDF format, do one of the fol-

lowing:

 l Change the scan output setting to TIF or JPG, and 

then re-scan

 l Use a snipping/capture tool, and then save the file 

as a JPEG or JPG file
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 1.  Click the   Settings icon, and then select  User List.

The HawkSoft User List dialog opens with your name selected.

 If you are editing your own profile, and do not have User List per-
missions, CMS immediately opens your user profile. Skip to step 
3.

 2.  The HawkSoft User List dialog opens with your name selected.

 3.  Click Edit.

 4.  Click the Signature side-tab, and then click Import New. 

The Select Signature  Wizard opens.

 5.  Click Next.

The Import Type dialog opens.

 6.  Select Import Signature, and then Browse to your signature file.

 7.  Optional: Select Delete file after import is complete.

 8.  Click Next to modify and select the signature.

See User Signature Setup below.

Select and authorize your signature
Once you have scanned or imported your signature into CMS, you should be on  the 

Select Signature dialog, review your signatures and choose the best signature to add to 
your profile.

 1.  On the Select Signature dialog, click the Zoom  button  , and   then click on the Sig-

nature page in the view window. 

The image view zooms in to 100%.

 2.  Use the scroll bars on the bottom and right side of the image to view all the sig-

natures.

 3.  Click the Crop button  .

 4.  Click and drag your mouse across the best signature to crop it.
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 l Get as close to the signature as you can .

 l If your first attempt leaves too much white 

space, keep cropping to get closer to your sig-

nature.

 l If you make a mistake, click Reset to start 
again.

 5.  Click Next.

The Base Line dialog opens.

 6.  Click and drag the slider on the left side of the dialog to set the base line.

The base line  determines how your signature sits on the signature line, so that let-

ters that drop below the line, like g's and y's, are placed properly. 

 7.  Click Finish.

A list of users appears in the Authorization section of the Signature screen.

 8.  Select your user name as well as any other users who needs  permission to select 

your signature when completing a form letter, proposal, or ACORD form.

When another user inserts your signature, that user's initials dis-
play next to your signature on ACORD forms, but will not display 
next to your signature on form letters or proposals. 

 9.  Click Finish to exit the User Profile dialog box.

For users without User List permissions, this step closes the 
User Profile dialog.

 10.  Optional: Click Apply to save changes, and then add or edit additional user profiles.

 11.  Click OK to exit the HawkSoft User List dialog.

Your signature is imported into CMS and is now available for you and other authorized 

users to add to  ACORD forms and correspondence.

See Creating and Modifying an ACORD Form and Modifying Correspondence Templates 

(Letters, Memos,  Proposals, and Policy Overview) for more information.

#Creating%20and%20Modifying%20an%20ACORD%20Form_..68
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Related Topics
Certificate of Liability Insurance Overview
Form Letter Templates
Proposal Templates
Setting User Permissions
User Setup Overview

Calendar Integration

Calendar integration with HawkSoft CMS makes it possible for you to sync with Outlook or selected 

online calendars to view, edit, and create events from   the Calendar side panel on the HawkSoft 

CMS Start Page.

 l Multiple calendars with the same provider can be configured with CMS. 

For example, if you have more than one calendar set up under your Google account, one for cus-

tomer birthdays and one for annual review appointments, they can be combined in the CMS cal-

endar view. 

Calendars from multiple providers cannot be combined. For example, you cannot configure both 

your Google and Outlook calendars together in CMS.

 l When integrating with a Microsoft Outlook® calendar, CMS will have access to    the calendars for 

the user logged onto Windows® only.

 l Calendar events are  displayed on the Calendar panel for all of your calendars configured with 

your provider. 

 l CMS automatically displays up to 25 calendar events  for two different days. Those two days 

must be within  five days of each other, starting with the current day.

In this topic:

Software Requirements To Set Up or Modify Cal-

endar Integration

To Use the Calendar on the 

CMS Start Page Calendar 

Panel 

#Certificate%20of%20Liability%20Insurance%20Overview_..78
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
#Software_requirements
#To
#To
#To2
#To2
#To2
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Required Permissions:
In order to configure Calendar Integration  for another user during User Setup, per-
missions must include:

Setup > User List

No special user permissions are required to complete calendar integration in your 
own profile or from the CMS Start Page.

See Setting User Permissions for more information.

Software requirements
Calendar integration can be configured with Google™, Microsoft® Office 365, Outlook.-

com, Hotmail, Live.com, and MSN.

HawkSoft CMS supports integration with Microsoft Office  2007, 2010, 
and 2013 “Professional” or “Home & Business”. 

Microsoft Office Home, Office Home Premium, Office Home and Stu-
dent, and Trial editions are NOT supported; Microsoft Office must be 
purchased separately. See System Requirements for more inform-
ation.

To set up or modify calendar integration
Your calendar(s) can be configured on the Calendar screen, accessed directly from the 

CMS Start Page or from the User Profile dialog. 

From the CMS Start Page 

Click Configure below the calendar in the right-hand panel.

OR 

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
https://hawksoftinc.com/agency-management-system/system-requirements
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From the  User Profile

 1.  Click the   Settings icon, and then select  User List.

The HawkSoft User List dialog opens.

 If you are editing your own profile, and do not have 
User List permissions, CMS immediately opens 
your user profile. Skip to step 3.

 2.  Select a user, and then click Edit.

The HawkSoft User Profile dialog for that user opens.

 3.  Click the Calendar side-tab.

 Calendar Integration

 1.  Select your  Calendar Type from the available drop-down list.

 2.  Click Connect.

For calendar types other than Outlook, the calendar provider Login 
screen opens  if you are not already logged in.

 3.  Enter your login information, if needed.

For calendar types other than Outlook, a screen will 

appear requiring you to give HawkSoft CMS permission to 

display your calendar events.

Click Allow or Yes to grant permission. 

All of your available calendars, for the selected Calendar Type, appear 

in the Calendar list.

 4.  Determine how often you want your calendar to refresh on the Start 

Page by selecting the number of minutes from the Refresh Interval 
drop-down. 
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 5.  If you have added a new calendar since your last configuration, click 

the Refresh Calendars button for the new calendar to be available 
from the list.

 6.  Use the available check boxes to select the calendar(s) you want to con-

figure with CMS.

You can select multiple calendars.

 7.  Save your configuration.

 l From the Start Page  

Click OK to save your configuration, if accessed from the Start 
Page.

 l From the User Profile 

 a.  Optional: Click Next to save and continue User Setup.

 b.  Click Finish to save and exit the User Profile dialog box.

 c.  Optional: Click Apply to save changes, and then add or 
edit additional user profiles.

 d.  Click OK to close the User List dialog box.

To use the calendar on the CMS Start Page Calendar 

panel
The HawkSoft CMS Start Page calendar panel displays a view of the current month, and 

the Calendar Events section displays scheduled appointments for two days (within a five 

day window,  starting with the current date).

 l To add an appointment from the Calendar Panel:                         

 a.  Click the date for the appointment on the calendar.

 b.  The calendar launches with the selected date open. Add or view appointment 

details.
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For Outlook, If you don't see your calendar viewer, click 
your Outlook icon in your taskbar to open the viewer.

 l To view or make changes to an existing event displayed on your   Calendar Panel, 

click on the event to launch your calendar and display the event details.

Related Topics
User Setup Overview

User Email Setup

The HawkSoft CMS email feature enables you to send an email from within a client file in CMS. Using 

CMS to send an email  creates log note documentation  and attaches a copy of the email to both the log 

note and the Attachments list of the client or policy.

See Email for more information about using the Email feature.

This article provides instructions for configuring CMS to send emails through your email provider.

This setup is typically completed by an Owner/Administrator.

Required Permissions:
In order to set up or modify Contact Information for a new or existing user, per-
missions must include:

Setup > Email/Text Messaging/E-Signature > User List

In order to complete this configuration in your own profile, the only permission 
required is Setup > Email/Text Messaging.

See Setting User Permissions for more information.

Configuring email settings in a user profile

 1.  Click the  Settings icon, and then select User List.

The HawkSoft User List dialog opens.

#Email
User Permissions.htm
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 If you are editing your own profile, and do not have User List per-
missions, CMS immediately opens your user profile. Skip to step 
3.

 2.  Select the user name, and then click Edit.

The User Profile for the selected user opens.

 3.  Click the Information side-tab.

 4.  Optional: Enter or modify the user's work email address in the Email field.

If an email address is not entered here, email sent by this user 
will use the agency email address found in Agency Information 
as the Return or From email address. 

 5.  Select the Email side-tab.

 6.  Select one of the following to set up Email Integration:

SMTP - CMS sends email directly to the outbound email SMTP server, and then the 
SMTP server sends the email to the recipient. Contact your email service provider to 

obtain the correct SMTP settings   or search the Internet for current settings.

 Conduct an Internet search for  "[your webmail provider] SMTP 
settings" to learn more about Server, Port, and SSL require-
ments for your provider.    Port 465 no longer works. If your pro-
vider suggests 465, try entering 587 for the  Port.  

SMTP Settings:

 a.  Enter the Server address.

 b.  Enter the Port number.

 c.  Check Use encrypted connection (TLS/SSL) if used by your email service 
provider.

 d.  Enter the email User Name and Password if the SMTP server requires 
authentication.

The User Name is usually the same as the email address.
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For Yahoo users,  be sure the email address entered on 

the Information tab in your User Profile matches the 
User Name.

For Gmail/G-Suite users, an app password with Two-

step Verification is required to send SMTP email through 

your Gmail account. See Google Account Help for instruc-

tions.

MAPI - CMS communicates with Windows MAPI and sends the email through a 

MAPI email client (Thunderbird, for example). The email program then sends the 

email to the recipient.

 Email sent through MAPI does not support HTML formatting. 
See Email Templates for more information.

Microsoft Outlook - CMS communicates with Microsoft Outlook, and then 
Microsoft Outlook sends the email to the recipient. 

HawkSoft CMS supports integration with Microsoft Office  

2010, 2013, and 2016 “Professional” or “Home & Busi-

ness”. 

Microsoft Office Home, Office Home Premium, Office 

Home and Student, Trial editions, and 64-bit Outlook are 

NOT supported. Microsoft Office must be purchased sep-

arately. See System Requirements for more information.

Microsoft Office 365 - CMS sends the email to your Microsoft Office 365 email 
account, and then Microsoft sends the email to the recipient. 

This requires an Office 365 email account, but does not require 
Outlook to be installed.

https://support.google.com/accounts/answer/185833?hl=en
https://hawksoftinc.com/agency-management-system/system-requirements
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 a.  Click Connect

A  Sign in to your account window appears.

 b.  Select your Microsoft Account from the available options.

OR

Click Use another account and enter your email address and password, as 
directed.

 c.  If Microsoft asks you to confirm your account, follow the steps provided in the  

dialog.

The next screen lists the permissions that HawkSoft requires to integrate 

with Office 365.

 d.  Click Accept to give HawkSoft the necessary permissions.

A confirmation message appears informing you that HawkSoft is now con-

nected to your Office 365 account.

 7.  Optional: Click Test Now to test the configuration. 

Follow on-screen prompts to send the test email. Assuming your setup is correct, 

you will receive a confirmation email from HawkSoft, Inc. If you do not, consult with 

your network administrator or call HawkSoft Support.

 8.  Continue to the next tab for this user profile, as needed

OR

Click Finish to exit the User Profile dialog box.

If an email address is not entered here, email sent by this user 
will use the agency email address found in Agency Information 
as the Return or From email address. 

For users without User List permissions, this step closes the 
User Profile dialog, and user email setup is complete.

 9.  Optional: Click Apply to save changes, and then add or edit additional user profiles.

 10.  Click OK to close the User List dialog box.

Completing email setup enables the user to send email from within a client file, and automatically doc-

ument the content of the email in the selected file.

https://hawksoftinc.com/insurance-agency-support/support
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Related Topics
Batch Emails
Email
Email Templates
User Setup Overview

Batch Email Setup [+Video]

Batch emailing can be set up for specific users. Once set up, HawkSoft CMS enables mass emailing  to 

customers and prospects in conjunction with  Report Generator.

See Batch Emails for more information on  how to use the  CMS Batch Email feature.

This article provides instructions on how to configure Batch Email  in your own profile and/or for other 

users.

Batch emailing is done at the agency’s own risk.

 l HawkSoft, Inc. is not liable for actions taken by an ISP, a mail host-

ing service, or other email filtering services.

 l It is the agency’s responsibility to know and understand their ISP or 

mail host provider's rules regarding email.

 l Certain state and federal laws may apply to your batch emails, 

depending on the type of emails being sent. Violating these laws 

may result in legal action being taken against the agency. It is the 

agency's responsibility to know and follow the laws of their jur-

isdiction regarding mass emails.

 l Violation of your mail provider's rules could result in black-listing, 

closing of your email account(s) or flagging your email account as a 

source of spam.

 l Configuring the HawkSoft CMS batch email service to comply with 

your ISP or mail host service rules, and creating email templates 

that are spam filter friendly, are the responsibility of the agency.

#Batch%20Emails
#Email
#Batch%20Emails
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Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Email/Text Messaging/E-Signature
Reports > Batch Email
(Note: You can complete Batch Email Setup in another user's profile with the Setup 
> User List permission.)

See Setting User Permissions for more information.

To set up Batch Emailing

If your agency administrator has granted you the Batch Email permission in CMS, you can 

follow these steps to set up Batch Email on your own user profile. Otherwise, an agency 

administrator can follow these steps to set up Batch Email for another user.

 1.  Contact your email service provider regarding the maximum number of emails that 

can be sent per minute without triggering a spam alert.

If your agency does not have a Microsoft Office 365 subscription, or does not want 

to send Batch Emails through an Office 365 email, you will need to integrate with 

your email account through SMTP. Ask your email service provider for the following 

information:

 l The outgoing SMTP server address

 l The port number

 l Determine if the email provider requires an encrypted connection (SSL or 

TLS)

 l Determine if the SMTP server requires authentication and, if so, the user 

name and password

 l  l Contact your Internet Service Provider and ask 

about the maximum number of allowable 

emails per minute. This threshold may differ 

from the email provider’s limits.

 l If you exceed the ISP or email provider's limit, 

User Permissions.htm
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you run the risk of having your email account 

black-listed and outgoing emails blocked.

 l For agencies that prefer to completely avoid 

potential issues, contact an email relay service 

that can provide an SMTP account used spe-

cifically for sending batch emails.

 2.  Click the  Settings icon, and then select User List.

If you are an agency administrator with full access to the User List, the User List 

opens. Select the user to set up Batch Email for, and then click Edit. 

Otherwise, your User Profile opens.

 3.  Select the Batch Email side-tab. 

The Batch Email side-tab does not appear in a user's profile 
unless Batch Email permissions have been granted. See User 
Permissions for more information.

 4.  Select the email Integration Type from the drop-down.

 l Select Use Email Settings from the drop-down if you are already using 
SMTP or Microsoft Office 365 for regular email integration (i.e. under the 

Email tab) and you want to use the same email address and settings for Batch 

Emailing.

 l If you selected SMTP, the Batch Email SMTP Settings section appears. 
Check with your agency technician and/or your email provider's support for 

the correct SMTP settings.

 a.  Enter the Email Address to be used for Batch Emailing.

 b.  Enter your outgoing SMTP Server address.

 c.  Enter the Port number.

 d.  Check Use encrypted connection (TLS/SSL), if required by your 
email provider.

 e.  Enter the User Name and Password for the email account used to 
send batch emails if the SMTP server requires authentication.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 l If you selected Microsoft Office 365, click the Connect button that appears 
next to the drop-down. Use the Microsoft Account dialog that appears to log 

into your Office 365 account and connect the account to HawkSoft.

 5.   Set the maximum number of emails to be sent per minute.

This is a required field. You will not be able to send batch emails 
without entering a number greater than zero.    Typically, this is set 
to the maximum number of emails per minute that can be sent 
without triggering a spam alert, as provided by your email pro-
vider and ISP.

 6.  Click Test Now to send a test email to your email account.

 a.  A confirmation  dialog box opens, click OK. 

 b.  Assuming no errors, a dialog box opens telling you to check your email inbox. 

You should see an email from HawkSoft Email Test in the inbox of the email 
address entered. If you see the email, the batch email test was successful. 

If an error occurs, confirm the information entered in the Batch Email setup 

with your email service provider and network manager. The most common 

causes of error are the email password or SMTP server information being 

incorrect.

 7.  Click Finish to save User Profile settings.

 8.  Click Apply.
If you are an agency administrator setting up Batch Emails for other users in your 

agency,  repeat steps 2a-8 for each user authorized to send Batch Emails.

 9.  Click OK to close the HawkSoft User List dialog.

Related Topics
Batch Emails
User Setup Overview

#Batch%20Emails
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Purchasing HawkSoft Text Messaging

HawkSoft Text Messaging enables you to send text messages to your clients  and manage their replies 

directly from HawkSoft CMS. This feature is available to your agency as an add-on service, and is pur-

chased through the Marketplace.

This guide walks you through the steps to purchase and set up Text Messaging for your agency. Since 

HawkSoft Text Messaging is a Data Sync feature, you must first enable HawkSoft Data Sync from the 

Marketplace.

As an alternative to using the built in HawkSoft Text Messaging feature, your 
agency can subscribe to an  email-to-text messaging service provider and send text 
messages directly from a client file. 

See Text Messaging Overview for more information.

In this topic:

Notes on HawkSoft Text 

Messaging

Before You Begin Register for HawkSoft Text 

Messaging

Purchasing HawkSoft 

Text Messaging

Purchasing HawkSoft 

Text Messaging

Purchasing HawkSoft 

Text Messaging

Notes on HawkSoft Text Messaging

 l Opt in required
Federal law requires your customers to opt-in to receive text messages from your agency. This is 

mandated by the FCC’s Telephone Consumer Protection Act. HawkSoft automates this opt-in 

process with the click of a button. Learn more.

 l Texting is not for marketing purposes
HawkSoft Text Messaging is only for informational texts. You may be in violation of federal 

and/or state regulations if you use texting for marketing purposes.

 l Your agency receives one text messaging phone number
Your agency is assigned one central text message phone number. Even if multiple staff mem-

bers are texting a client, that client will see text messages arriving from a single phone number.

HawkSoft Marketplace.htm
#Text%20Messaging%20Overview
#Notes_on_Hawksoft_Text_Messaging
#Notes_on_Hawksoft_Text_Messaging
#Before_You_Begin
#Register_For_Hawksoft_Text_Messaging
#Register_For_Hawksoft_Text_Messaging
#Text%20Messaging%20Opt-In%20Compliance_..132
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Before you begin

Before purchasing HawkSoft Text Messaging, you must first register for the HawkSoft Marketplace and 

enable HawkSoft Data Sync so the application can access your HawkSoft data.

Your email address must be listed on the HawkSoft License Agreement as a main contact.

Register for the HawkSoft Marketplace

The HawkSoft Marketplace offers  agency managers the option to enable HawkSoft Data Syncing,  pur-

chase and configure HawkSoft products, and  integrate with third-party applications. 

 1.  Click the   Settings icon on the  the  HawkSoft CMS toolbar, and then select  Marketplace.

 2.  Click Register Now.

 3.  Enter your Email Address, and then click Submit.

Your email address must be listed on the HawkSoft License Agreement as a main contact. If you 

receive an error indicating your email address is not listed as a main contact, or your current 

email address is different than the one used for the HawkSoft License Agreement, please have 

your agency owner contact billing@hawksoft.com to update your information, and then try again.

An Authentication Code is sent to your email address.

 4.   Copy the code from the email and paste it into the corresponding field on the Marketplace regis-

tration window.

 5.  Check the box below the Authentication Code field stating you agree to the Terms 
and Conditions for HawkSoft Marketplace.

 6.  Click Submit.

A confirmation message appears. 

 7.  Close the HawkSoft Marketplace Registration screen. 

You are ready to enable additional HawkSoft products and third-party applications. 

Enable HawkSoft Data Sync

You can enable  HawkSoft Data Sync to leverage the power of your HawkSoft data  and integrate with 

third-party services as they become available in HawkSoft Marketplace. 

mailto:billing@hawksoft.com
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Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > General Configuration Settings

See Setting User Permissions for more information.

 1.  Click the   Settings icon, and then select  Marketplace.

If you haven't registered for the Marketplace, see HawkSoft Marketplace for detailed instruc-

tions.

 2.  Click and read the HawkSoft Terms and Conditions in the HawkSoft Data Sync section, and 

then check the box to accept the Terms and Conditions.

 3.  Click Activate.

The HawkSoft Cloud Confirmation window opens.

 4.  Click Confirm.

A confirmation message appears.

 5.  Click the Return to Marketplace button.

Purchase HawkSoft Text Messaging

Once Data Sync is enabled, you can register for Text Messaging through the Marketplace.

 1.  Click the   Settings icon, and then select  Marketplace.

 2.  Under HawkSoft Text-Messaging, click Activate.

Important HawkSoft Text Messaging Information displays.

 3.  Review the opt-in requirements, rules regarding use for marketing purposes, information about 

your phone number, read the terms and conditions, and then click Next.

 4.  Determine if your agency will require users to opt-in before sending messages, allow users to 

skip the opt-in process, or if HawkSoft's opt-in process will be disabled for your agency. 

Federal regulations require that agencies receive opt-ins from clients before 
sending text messages. If you choose to disable opt-ins, or allow agents to 
skip opt-ins, you agree to receive opt-ins from clients through other means. 

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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HawkSoft is not responsible for any fines or penalties imposed by telecom 
carriers for non-compliance.

See Text Messaging Opt-In Compliance to learn more. 

 5.  Enter a phone number for clients with questions to call in the "Help" Response section.

When a client sends the phrase 'HELP' to your texting number, an automated message will dir-

ect the customer to call this number.

 6.   Enter an Area Code or Zip Code to generate a localized phone number to be used by your 
agency for text messaging, and then click Finish. 

 In some metropolitan areas, your desired area code may be unavailable. If 
you receive this error message, use a zip code to generate your phone num-
ber.

 7.  Check "I understand my agency will be charged $20.00 per month starting on my next 
HawkSoft invoice."

 8.  Read the Additional Required Information.

This section explains that additional information will be required on the next page in order to 

register your agency with The Campaign Registry (TCR). Telecom carriers require that all busi-

nesses sending text messages register their business with TCR.

 9.  Click Finish to complete your order.

A Congratulations page appears, which shows the status of your HawkSoft texting number and 
lists the next steps towards enabling HawkSoft Text Messaging.

Complete required information to start registration process

Additional information is required to register your agency with The Campaign Registry (TCR) before 

HawkSoft Text Messaging can be enabled. Telecom carriers require that all businesses sending text 

messages register their business, or "brand", with TCR.

If this information is not filled out by the agency, a HawkSoft representative will contact your agency to 

gather this information.

If you are interested in using your agency's main phone number as your HawkSoft 
Texting number, you can request to enroll in Main Number Texting through the 
Required Information Form. See Purchasing HawkSoft Text Messaging for more 
information.

#Text%20Messaging%20Opt-In%20Compliance_..132
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 1.  Open The Campaign Registry Required Information Form in your web browser.

 2.  Fill out the information requested in the form.

 3.  Click Submit Information to send this information to HawkSoft.

HawkSoft will use this information to register the agency in The Campaign Registry.

 4.  Close the Marketplace window and return to HawkSoft CMS.

HawkSoft submits this information to The Campaign Registry. After  registration is complete within 

TCR, HawkSoft will activate Text Messaging for your agency.

HawkSoft will send an email to your agency's main contacts once Text Messaging is activated. 

If your agency previously used a different text messaging integration (such as Bulk SMS or Message 

Media), HawkSoft Text Messaging will be automatically set as the default texting tool within all  User 

Settings after activation. If the additional text messaging service is no longer needed, you may cancel 

the service.

Once your agency receives notification that HawkSoft Text Messaging is activated, 
all users must restart CMS in order to begin using HawkSoft text messaging.

Your texting number

Once you complete your HawkSoft Text Messaging order, HawkSoft begins creating and registering a 

new texting number from your agency, using the area code provided on the previous page.

It can take up to five minutes for HawkSoft to register your new phone number. You can click the 

refresh   button after waiting, or view your number at a later time by re-opening the Marketplace 

and clicking Manage under HawkSoft Text Messaging.

Main Number Texting
Upon request, HawkSoft can set up your agency's main phone number as your HawkSoft 

Text Messaging number. There is a $99 one-time fee for enabling Main Number Texting.

Not all phone numbers are able to be used for Main Number Texting. 
Your agency will not be charged the one time fee  until  your requested 
phone number has been successfully enrolled in Main Number Tex-
ting.

https://www.hawksoft.com/10dlc
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HawkSoft Text Messaging setup must be completed before the pro-
cess for enrolling in Main Number Texting can begin. Your agency will 
use the separate texting number ordered through the Marketplace until 
the enrollment is complete.

 1.  Complete and submit  The Campaign Registry Required Information Form in your 

web browser.

If your agency already submitted the form  but selected not to 
enroll in Main Number Texting, and you would now like to switch 
to your agency's main number, contact Product Support for 
assistance.

 a.  Within the Required Information Form,  select Yes next to "Do you wish to 
enroll in Main Number Texting?"

 b.  Complete the additional fields that appear with your main number, your phone 

service provider, the business name you use with your phone service pro-

vider, and the service address you use with your phone service provider.

Once HawkSoft is notified of intent to enroll, the agency principal will receive an 

email from HawkSoft staff containing a Letter of Authorization and signing instruc-

tions. If your agency did not complete the additional Main Number Texting fields 

within the TCR Required Information Form, you will be asked to provide additional 

information.

 2.  Complete the Letter of Authorization.

 3.  Reply to the email from HawkSoft with the completed Letter of Authorization 

attached. Provide any additional information needed within your reply, if requested 

to do so by HawkSoft.

Upon receipt, HawkSoft informs all agency main contacts that HawkSoft will now 

attempt to get the requested phone number for Main Number Texting, and will notify 

the agency when the process is complete.

You will receive an email from HawkSoft confirming that your agency is now signed 

up for Main Number Texting, using the number you requested.

Once Main Number Texting is enabled, all old messages and 
opt-ins will remain, however your previous HawkSoft Text 

https://www.hawksoft.com/10dlc
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Messaging number will no longer be active, and any texts sent to 
the old texting number  will not be received going forward. Make 
sure to inform your clients of the changed texting number.

 If HawkSoft is unable to get the requested number, HawkSoft will inform the 

agency's main contacts, and you may request to try a different number.

Text messaging administration 

Once HawkSoft Text Messaging is enabled, all users can begin sending outgoing text messages to cli-

ent files they have access to. Administrators can disable text messaging for certain users within User 

Permissions. 

Available Texting Permissions:

 l Client File > Allow Sending Text Messages: Grants permission for CMS users to send out-
going texts to clients.

 l Setup > Texting Administration: Allows users to view all text messages, regardless of client 
file permissions, via the All Unprocessed Text Menu.

Permissions are not required to viewtext messages, so long as the user has permissions to access the 

client's file. 

See About HawkSoft Text Messaging for more information on HawkSoft Text Messaging workflows.

Related Topics 
Processing Text Messages
Text Message Notifications
Text Messaging Opt-In Compliance
Viewing & Sending Text Messages

E-Signature  Overview

HawkSoft enables you to easily send documents directly from CMS to your customers for an electronic 

signature. You can create templates to send with your client/policy attachments, ACORD forms, 

Change Request forms, as well as additional documents saved to your computer.  Your customers can 

then "sign" the document(s) electronically and return them via the electronic signature application you 

have configured in CMS. 

#All
#About%20HawkSoft%20Text%20Messaging_..128
#Processing%20Text%20Messages
#Text%20Message%20Notifications
#Text%20Messaging%20Opt-In%20Compliance_..132
#Viewing%20&%20Sending%20Text%20Messages
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Providing your customers with the ability to electronically sign documents can help improve the quality 

of their service experience and speed up the time necessary to get documents signed.

You can purchase HawkSoft E-Signature (Powered by Formstack Sign) as an add on product, or you 

can use one of the  e-Signature providers that HawkSoft integrates with. 

HawkSoft E-Signature (Powered by Formstack Sign)

Formstack Status: PSRs can check for issues/outages with Formstack Sign at 
https://formstacksign.statuspage.io/

To purchase HawkSoft E-Signature (Powered by Form-

stack Sign)
HawkSoft E-Signature (Powered by Formstack Sign)  is available to your agency as an add 

on service through Marketplace. Once purchased, you can begin sending documents for 

an electronic signature without any setup. 

To purchase HawkSoft E-Signature  and assign licensing to specific users, your email 

address must be listed on the HawkSoft License Agreement as a main contact. If your 

agency contact information needs to be updated, please have your agency owner contact 

billing@hawksoft.com to request a change.

No additional configuration is needed with HawkSoft E-Signature.

See Purchasing HawkSoft E-Signature (Powered by Formstack Sign) for instructions.

HawkSoft E-Signature (Powered by Formstack Sign) 

Account Settings
Once you have purchased HawkSoft E-Signature (powered by Formstack Sign), you can 

configure Account settings for yourself and for your agency. 

HawkSoft E-Signature Account Settings

https://formstacksign.statuspage.io/
#Purchasing%20HawkSoft%20E-Signature%20(Powered%20by%20Formstack%20Sign)
#HawkSoft%20E-Signature%20Account%20Settings
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Using HawkSoft E-Signature (Powered by Formstack 

Sign)
HawkSoft E-Signature enables you to quickly prepare and send documents for signature 

directly from a client's file in HawkSoft CMS. This topic describes many of the E-Signature 

options and features available.

Using HawkSoft E-Signature (Powered by Formstack Sign)

Additional HawkSoft E-Signature providers

In addition to HawkSoft E-Signature (Powered by Formstack Sign), HawkSoft has direct integration 

available with the following e-Signature providers: 

DocuSign™

Contact: 800-379-9973

Original RightSignature® v3

RightSignature enables integration only with Original RightSignature v3. If you have New RightSig-

nature v4, you can contact your RightSignature representative and request to roll back to v3.

Contact: 855-884-2257

If HawkSoft doesn't have direct integration with your e-Signature provider, you can 
easily drag and drop documents from a client/policy into your e-Signature program.

Configuring Docusign or RightSignature
Before the e-Signature feature can be used with another provider, integration  must be con-

figured in your User profile. 

E-Signature Configuration: DocuSign or RightSignature 

Using Docusign or RightSignature
HawkSoft enables you to easily send documents directly from CMS to your customers for 

an electronic signature. You can create templates to send with your client/policy attach-

#Using%20HawkSoft%20E-Signature%20(Powered%20by%20Formstack%20Sign)
#E-Signature%20Configuration:%20DocuSign%20or%20RightSignature_..124
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ments, ACORD forms, and Change Request forms, as well as additional documents 

saved to your computer.

Using DocuSign or RightSignature

HawkSoft E-Signature Templates

HawkSoft CMS enables you to create templates for composing standardized e-Signature messages to 

send to clients with documents to be signed. These templates can be used with any e-Signature pro-

vider. You can also attach documents to templates, such as agency, company, or state disclosures or 

acknowledgments. These documents will be included in your e-Signature package when the template 

is selected. Templates can be selected, and modified, if needed, when sending documents for elec-

tronic signature.

 E-Signature Templates  

Phone System Integration

 HawkSoft enables you to configure your phone system to integrate with CMS. This integration enables 

you to place outbound calls from within a client file with the click of a mouse, and to open an inbound 

caller's client file as soon as you receive a call.

Depending on your provider, different configuration options are available. Most providers enable you to 

configure both outbound dialing and inbound call screen pops with CMS. 

 If your provider has configured  inbound calls,  CMS either opens the client file automatically, or dis-

plays a dialog with the option to open the client file.

This article  explains how to configure CMS to integrate with your phone system. 

In this topic:

Before you begin Incoming Call Integration 

(ScreenPops)

Outbound Call Integration

Phone integration is only supported on Windows workstations and cannot be con-
figured on Mac devices. Inbound call integration is not supported on Windows 7.

#Using%20DocuSign%20or%20RightSignature
#Before
#Incoming
#Incoming
#Outbound
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Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > General Configuration 

See Setting User Permissions for more information.

Before you begin
Before integrating the agency's phone system with HawkSoft, verify that the phone system supports 

integration.

 l For inbound call integration, the phone software must include the ability to launch third-party 

applications upon receiving a call.

 l For outbound call integration, the phone software must support placing calls using the CallTo 
and/or Tel protocols within Windows.

Phone Integration Glossary

VoIP
Voice Over Internet Protocol - This term describes any voice or phone service that operates 

through the Internet instead of through telephone lines. Most VoIP services run through a com-

puter.

Protocol
A language that computers use to communicate with each other. On workstations running Win-

dows, the main protocols for communicating with VoIP software are CallTo and Tel.
Argument

Information that one program shares with another. For the purposes of this article, arguments 

include the CMS Username, CMS Password, and caller's phone number.

Program Call
An action one program takes to launch a separate program. For outbound phone calls, CMS 

makes a program call to the phone system, and for inbound calls the phone system makes a call 

to CMS.

Path
Also known as 'file path' or 'program path'. This is the location of a program, file, or folder on a 

computer.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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%LocalAppData%
This is a variable pre-built into Windows that points to the user's local appdata folder. (C:\Users\

[User Name]\AppData\Local).

Incoming Call Integration (ScreenPops)

Incoming call integration is not supported on Windows 7.

Incoming call integration uses a feature called "ScreenPops" to match client files to a caller's phone 

number. Upon receiving a call, CMS searches all client files for the caller's  number. If at least one client 

contains the caller's number, a ScreenPop opens showing all client files containing that number.

To configure incoming calls, your agency's VoIP software must be configured to launch the ScreenPop 

application, with arguments for the CMS user's initials, password, and the caller's phone number. The 

steps to do so vary between VoIP providers, and as such it is recommended to have an agency tech-

nician assist with incoming call integration setup.

Local agencies

For locally hosted agencies, the VoIP software should be configured to launch %localap-
pdata%\hawksoft\cms\program\CmsScreenPop.exe. 

If you have a non-standard HawkSoft installation, such as a terminal server, this path may differ for 

you. If the above path does not work, have your agency technician point the VoIP software to the 

CMSScreenPop.exe application within the HawkSoft folder in your local AppData or the agency's 
HawkSoft database.

Incoming Call Arguments
Arguments highlighted in bold are required for ScreenPops to function.

/PHONE:"%P"

Passes the phone number to CMS. 

%P stands for the variable used by the phone system 
for the caller's phone number. This variable may vary 

between phone vendors; for example, %P should be 

replaced with %E on RingCentral phones.
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/LOGIN:[user initials]
Passes the user's CMS initials to the ScreenPop 

application. For example, /LOGIN:CMS

/PASSWORD:[password]
Passes the user's CMS password to the ScreenPop 

application. For example, /PASSWORD:Secret123!

/LAUNCH (Optional)

If this argument is included, HawkSoft will auto-

matically launch the matching client file. 

If this argument is not included, or if there is more than 

one matching client file, a ScreenPop appears show-

ing which client files match the caller's number, and 

gives an option to launch the selected client.

/CFG:[config file path] (Optional)

For local agencies in multiple database environments, 

use this argument to point to the correct configuration 

path.

/DURATION:[seconds] (Optional)
If this argument is included, ScreenPops will only 

appear for the amount of time set once launched.

List of common phone providers and parameters required

HawkSoft does not maintain documentation for any of the following phone systems. 
Please direct phone system questions to the agency technician or phone provider.

Toshiba Call Manager

/PHONE:"%P" /LOGIN:[initials] /PASSWORD:[password] /LAUNCH

Xarios Phone Manager

Set objShell = CreateObject ("Wscript.Shell")

ObjShell.Run ("C:\HAW\HawkSoft.Connect.exe" /cfg:C:\haw\hawk.ini /PHONE: " + 

PhoneControl.CLI + " /LOGIN:"[initials]" /PASSWORD:"[password]")

ISymphony

/PHONE:"%CID NUMBER%" /LOGIN:[initials] /PASSWORD:[password] /LAUNCH

SAMSUNG XCHANGE
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/PHONE:"%CALL" \CONTACT\TEL% /LOGIN:[initials] PASSWORD:[password] 

/LAUNCH

XChange Integration needs to be set up as a Custom   Button.

RINGCENTRAL

/PHONE:"%E" /LOGIN:[initials] /PASSWORD:[password] /LAUNCH

AllWorx

/PHONE:"%CALLNUM%" /LOGIN:[initials] /PASSWORD:[password] /LAUNCH

IdentaPop Pro

Supports many Tel Protocol compliant business telephone systems including 3CX, Alcal-

tel, Allworx, Asterisk, Avaya, Cisco, Ericsson, ESI, Freeswitch, NEC, Nitsuko, NBX, Nor-

tel, Panasonic, Phillips, Siemens, Splicecom and Zultys.  

This software can pass Caller ID information from these phone systems to an external pro-

gram such as HawkSoftConnect.exe.

/PHONE:[CID] /LOGIN:[initials] /PASSWORD:[password] /LAUNCH

Outbound call integration

HawkSoft enables users to call clients' phone numbers directly from CMS by placing a program call 

containing the number to call to the user's phone system.

To enable outbound integration within CMS, a default phone provider or protocol needs to be set inside 

of General Configuration. However, individual users can override the default setting from the User List.

To set the default phone provider or protocol in CMS

 1.  Open the  Setup menu.

 2.  Open General Configuration, and then select Phone Dial-Out Integration.

 3.  Select the agency's phone provider or protocol from the Phone Provider drop-down.
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 4.  Optional: Enter a phone number and click Call Now to test the integration.

 5.  Click OK to save changes.

To override a user's phone provider or protocol in CMS

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > User List (Required to edit a user profile other than your own) 

See Setting User Permissions for more information.

 1.  Open the   Setup menu.

 2.  Open the User List.

 3.  Select the user to edit, and then click Edit.

 4.  Select the Phone Dial-out Integration tab.

 5.  Check Override Setup > General Configuration Setting.

 6.  Select the new provider/protocol from the drop-down.

 7.  Optional: Enter a phone number and click Call Now to test the integration.

 8.  Click Finish to save changes.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm


3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 341

To pair your phone to CallTo or Tel in Windows

For agencies/users with either CallTo or Tel selected as the phone provider/protocol, the CallTo or Tel 
protocol must be set to open the phone system within Windows.

 1.  Open the Start Menu on the user's workstation.

 2.  Search for "Default apps".

 3.  Click "Choose default apps by protocol".

 4.  Locate the CALLTO or TEL protocol.

The list of protocols is sorted alphabetically.

 5.  Click on "Choose a default" next to the CALLTO or TEL protocol.

 a.  If an app is already selected as the default, click the app icon instead.

 6.  Click the user's phone application.
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Customize HawkSoft CMS

HawkSoft CMS offers a variety of ways to customize your management system to suit your agency's 

workflows, as well as options for customizing the look of the application.

This article gives an overview of all the options available for customizing HawkSoft CMS.

Agency level

Agency Announcements

HawkSoft CMS enables you to create customized announcements on your 

Agency's Start Page. You might want to use the Announcement section to dis-

play agency news, company goals, and events for your staff. 

In addition to text, you can embed images and tables in the Announcement 

section.

CMS provides a template to help you get started  customizing your announce-

ments. 

This article provides instructions on activating, customizing, and deactivating 

Agency Announcements.

Agency Announcements

Agency Logo

HawkSoft CMS enables you to import your agency logo to be included on 

invoices generated by CMS, ACORD ID cards (other than state specific), cor-

respondence, and on your agency's CMS Start Page.

This article describes how to import your agency logo into CMS, configure the 

logo to display in CMS, and add to documents.

Agency Logo

Customizing the CMS Toolbar

The main toolbar in HawkSoft CMS contains several buttons which provide 

shortcuts to perform common transactions in CMS. You can customize the 

toolbar by adding  buttons to provide additional shortcuts for common tasks 

performed by your agency and you can remove buttons that your agency 

doesn't use. 
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This article explains how to customize the toolbar by adding and removing but-

tons for Action menu related tasks. 

See Shortcuts to  External Tools [+ Video] to configure  button shortcuts  to web-

sites or programs (applications), such as a calculator tool or a real estate map-

ping website, etc.

 

Customizing the CMS Toolbar

Client Miscellaneous Information

The HawkSoft CMS Client Miscellaneous Information (Client Misc Info) 

screen displays customized fields you can use to enter data not included in 

any of the standard fields found in the Edit Client/Policy dialog.

The information in most of these fields can be included in custom reports 

using Advanced Customized Reports.

The Client Misc Info screen appears blank until the fields are configured. See 

Setting Up Client Miscellaneous Information Fields for instructions on con-

figuring these fields.

The following article explains how to complete the Client Misc Info dialog after 

the fields have been set up.

Client Miscellaneous Information

User level

Font Customization

HawkSoft CMS allows you to edit the font type, style, size, and color of certain 

text categories, such as log text and data text.

This article provides instructions for changing HawkSoft CMS fonts.

NOTE: Font changes are applied only to your com-
puter and will not impact other workstations.

#Advanced%20Customized%20Reports
#Client%20Miscellaneous%20Information
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Font Customization

Application Theme

HawkSoft CMS includes themes to customize the look of the CMS applic-

ation.

This article provides instructions for changing your Application Theme, as well 

as examples of how each theme appears in CMS.

NOTE: Themes are applied only to your computer 
and will not impact other workstations.

Application Theme

Shortcuts to External Tools

Setting up an External Tool enables you to configure a shortcut that links to a 

website or program (application) of your choice. You can set these links to 

appear on the Tools menu, the Quick Launch panel, and/or the main CMS 

toolbar.

Shortcuts to  External Tools [+ Video]

Related Topics
User Setup Overview

Font Customization

HawkSoft CMS allows you to edit the font type, style, size, and color of certain text categories, such as 

log text and data text.

This article provides instructions for changing HawkSoft CMS fonts.

Font changes are applied only to your computer and will not impact other work-
stations.
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To customize fonts

 1.  Click View from the main CMS menu bar, and then select Fonts.

The Setup Fonts dialog opens.

 2.  Select a  Category:

Data Text

Changes the font for the client and policy data on the view screens.

Example:

The Data Text has been changed to a red Times New Roman font in the image below.
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Prompt Text

Changes the font for the Data labels for the client and policy view screens.

Example:

The Prompt Text has been changed to a red Times New Roman font in the picture below.
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Log Text

Changes the font for the list of log notes in the client/policy. 

Changing the color of this font does not affect the color of the text inside a log 
note, suspended log notes, or log notes on policies other than the one cur-
rently selected.

Example:

The Font Text has been changed to a green Times New Roman font in the picture below.
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 3.  Click Modify. 

The Font dialog opens for you to customize the font for the selected Category. 

 4.  Click OK to save your changes.

 5.  Optional: Select another category to modify. 

 6.  Click OK to close the Setup Fonts dialog.

Your fonts are customized and saved to your profile.
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To reset fonts to default settings

 1.  Click View from the main CMS menu bar, and then select Fonts.

The Setup Fonts dialog opens.

 2.  Click Reset All.

 3.  Click OK.

All fonts have been reset to the default settings.

Related Topics
User Preferences
User Setup Overview

Application Theme

HawkSoft CMS includes themes to customize the look of the CMS application.

This article provides instructions for changing your Application Theme, as well as examples of how 

each theme appears in CMS.
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In this topic:

Change Your Application Theme Examples of Themes

Themes are applied only to your computer and will not impact other users.

Required Permissions:
To perform this task, no specific CMS user permissions are required. 

To change your Application Theme

 1.  Click View from the main CMS menu bar, and then select Application Theme.

The list of available themes appears.

 2.  Select the Light Blue, Dark Blue, or Dark theme.

The selected theme applies to all CMS windows on your workstation.

Examples of themes

Light Blue (Default)

#Change_Yuour_Application_Theme
#Examples_of_Themes
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Dark Blue
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Dark
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Related Topics
User Preferences
User Setup Overview



3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 354

Shortcuts to  External Tools [+ Video]

Setting up an External Tool enables you to configure a shortcut that links to a website or program 

(application) of your choice. You can set these links to appear on the Tools menu, the Quick Launch 

panel, and/or the main CMS toolbar.

External tools can launch applications only if the application is installed on the 
same computer CMS is running on.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Computer Specific Settings

See Setting User Permissions for more information.

In this topic:

Set up a website or program Additional button options 

To set up a website or program

 1.  Click the   Settings icon, and then select Computer Specific Settings from the 

main CMS menu bar.

The Computer Specific Settings dialog opens.

 2.  Click the External Tools tab.

 3.  Click New to set up a new external tool, and complete the following:

 l Tool Name – Name the external tool.

 l Tool Type – Select Program (application) or Website from the drop-down 
list.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
#To
#Addition
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 l Tooltip – Enter the tool name as you want it to appear when you hover your 
mouse over the toolbar icon.

 l Help Text – Enter a description of the tool. This can include the keyboard 
shortcut associated with the toolbar button.

This description appears as part of the Tooltip when you hover your mouse 

over the toolbar icon.

 l Command – Enter or browse to the program (application) path or website 
URL:

 o For a website, enter the URL

 o For a program, enter the path to the .exe file

See the following table for a list of common programs and commands:
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 l Arguments – Use to send command line arguments to the EXE. (Optional: 
Used only when the tool type is Program.)

 l Initial Directory – This field automatically defaults to the same path as the 
Command field. (Optional: Used only when the tool type is Program.)

 l Select Show on Tools Menu, Show on Quick Launch Panel, and/or Show 
on  Toolbar to designate where links to the tool appear.

 4.  Click Test to verify your setup.

Your program or website launches.

 5.  Click OK to save changes and return to the External Tools screen.

 6.  Click OK to close the Computer Specific Settings dialog.

A link to the new tool displays in CMS at the designated location.
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Additional button options on the External Tools screen

 l Edit – Highlight an item from the list, and then click Edit to modify.

 l Delete – Highlight an item from the list, and then click Delete to remove the link.

 l Arrows – Highlight an item from the list, and then click the Up or Down arrow to 
move the items up or down on the list.

 l Separator – Click to insert a dividing line that  displays between external tools you 
have designated to show on the main CMS toolbar. If selected, CMS adds a sep-

arator to the bottom of the external tools list, and then you can use the navigation 

arrows to place the separator.

Related Topics
Customizing the CMS Toolbar

HawkSoft  CMS Installation and Network Options 
In order to successfully install and use HawkSoft CMS at your agency, you  must have a network con-

figured to meet your agency needs prior to the installation. This article describes three common net-

working options to help your agency IT Admin determine the best networking option for your agency.  

HawkSoft, Inc. is not responsible for your agency network setup. See your agency 
IT Admin to determine the best networking option for your agency. 

HawkSoft CMS also provides the HawkSoft Online option. See  for more information.

HawkSoft CMS has been developed and tested in the operating system and net-
work environments specified on our System Requirements page. HawkSoft, Inc. 
cannot guarantee performance of CMS and is limited in the scope and type of 
troubleshooting available for networks that do not meet these requirements. For 
operating system, hardware, and network requirements, please see HawkSoft Sys-
tem Requirements.

https://hawksoftinc.com/agency-management-system/system-requirements
https://hawksoftinc.com/agency-management-system/system-requirements
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In this topic:

Installing Hawksoft CMS on 

a Local Network

Installing Hawksoft CMS on 

a Terminal Server

Installing Hawksoft CMS to 

Terminal Server for both 

Remote Desktop Users and 

Local Network Users

Installing HawkSoft CMS on a Local Network 
A local network is typically used when all  agency employees work in the office and access 

CMS from their office workstations (no remote access). This type of network has one com-

puter  configured to act as the file server that shares the HawkSoft CMS program and data 

with the other computers at the agency. 

Program files are copied from  the server to the local workstation directory. This con-

figuration enables the program to run on each workstation, rather than across a network. 

Technical NOTE: CMS is installed to 
%LOCALAPPDATA%\HawkSoft\CMS\Program.  

%LOCALAPPDATA%  

 Windows 2000

C:\Documents and Settings\ 

<user name>\Local Set-

tings\Application Data

Windows 10, Windows 8.1, 

Windows 7, andWindows 

Vista

C:\Users\ <user name>\Ap-

pData\Local

The data and other relevant files will remain on the server.  The local CMS.exe will check 

for updates on the server and copy and install components to the local User Appdata 

folder as necessary. 

#Installing_Hawksoft_CMS_on_a_Local_Network
#Installing_Hawksoft_CMS_on_a_Local_Network
#Installing_Hawksoft_CMS_on_a_Terminal_Server
#Installing_Hawksoft_CMS_on_a_Terminal_Server
#Installing_HawkSoft_CMS_to_Terminal_Server_for_both_Remote_Desktop_users_and_Local_Network_users
#Installing_HawkSoft_CMS_to_Terminal_Server_for_both_Remote_Desktop_users_and_Local_Network_users
#Installing_HawkSoft_CMS_to_Terminal_Server_for_both_Remote_Desktop_users_and_Local_Network_users
#Installing_HawkSoft_CMS_to_Terminal_Server_for_both_Remote_Desktop_users_and_Local_Network_users
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Local network setup must include: 

 l A domain-based (recommended) or peer-to-peer network

 l A computer configured to act as file server, running a supported operating system

 l A network shared folder where HawkSoft CMS will be installed 

This must be configured to allow all CMS users full control of the share.

 l All workstations must have a network drive mapped to the network share in order to 

access CMS

The following diagram illustrates a network configuration for local network users:
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Installing HawkSoft CMS on a Terminal Server

Agencies running HawkSoft CMS on a terminal server that is running 
Windows Server 2019 may experience a notable slowness. If your 
agency experiences this issue, your agency technician can follow the 
steps in the Windows Server 2019 Slowness with Terminal Server 
Users article for possible solutions.

A Terminal Server is typically used when an agency needs to enable staff to remotely 

access a server at your agency to run CMS.

For agencies using  Terminal Services, HawkSoft CMS can be  configured to run on a Ter-

minal Server during the installation process. 

For agencies switching to a Terminal Server after installation, see General Settings  for 

detailed instructions.

The following diagram illustrates a network configured for Remote Desktop users:

Windows Server 2019 Slowness.htm
Windows Server 2019 Slowness.htm


3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 361

Installing HawkSoft CMS to Terminal Server for both 

Remote Desktop users and Local Network users
HawkSoft CMS can be configured for agencies  with both remote users  and users who log 

into a local network from inside the office. This configuration enables agency staff to:

 l  Optimize HawkSoft CMS to install and run on computers in the office from a local 

network

Workstations that will run CMS locally need to be configured   during 

Workstation Setup. 

See  and Computer Specific Settings [+Video] for instructions.

 l Access CMS remotely from a Terminal Server when working from outside the office
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The following diagram illustrates a network configured for both Remote Desktop users and 

local network users:

Related Topics

Computer Specific Settings [+Video]
Installing HawkSoft  CMS Using Microsoft Windows
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